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Abstrakt

Diplomová práce se zabývá modulem rozšířených analýz v programu OrCAD PSpice.

Mezi rozšířené analýzy patří citlivostní analýza, optimalizace obvodových funkcí, analýza

namáhání součástek, analýza výtěžnosti výroby (Monte Carlo) a analýza s rozmítáním

obvodových prvků a vlastností. Tyto rozšířené analýzy jsou v první části popsány a je

ukázána práce s nimi na jednoduchých příkladech. V další části jsou jednotlivé typy roz-

šířených analýz použity při analýze nízkofrekvenčních obvodů. Jako další modul, který

je při práci využit, je modul SLPS, který umožňuje kosimulaci mezi programem OrCAD

PSpice a programem Matlab, konkrétně rozhraním Simulink. V práci je také popsána

práce s modely součástek, jejich vytváření, modifikace a import.

Klíčová slova

orcad pspice, rozšířené analýzy, citlivostní analýza, optimalizace obvodových funkcí, ana-

lýza namáhání prvků obvodu, monte carlo – analýza výtěžnosti výroby, analýza s rozmí-

táním obvodových prvků a vlastností, spice model součástky, kosimulace, simulink
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Abstract

Mraček, Lukáš. Advanced analysis in PSpice simulator [Rozšířené možnosti analýz v pro-

středí PSpice]. Pilsen, 2012. Master thesis (in Czech). University of West Bohemia. Faculty

of Electrical Engineering. Department of Applied Electronics and Telecommunications.

Supervisor: Jiří Stifter

This master thesis deals with the advanced analysis module in the program OrCAD

PSpice. The advanced analysis include sensitivity analysis, optimizer, smoke analysis,

Monte Carlo and parametric plotter. These advanced analysis are described and it is

shown how to work with them on the simple examples in the first chapter. Individual

analyzes are used to analyze low-frequency circuits in the fourth chapter. The next module

which is used in this thesis is SLPS. This module enables cosimulation between OrCAD

PSpice and Matlab/Simulink. There will be described work with models of components,

their creating, modification and import.

Keywords
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Úvod

Práce se zabývá popisem a použitím modulu rozšířených analýz při simulaci elektrických

obvodů. Modul rozšířených analýz je rozšíření programu OrCAD PSpice o několik typů

analýz. Mezi rozšířené analýzy obsažené v tomto modulu patří citlivostní analýza, op-

timalizace chování obvodu v závislosti na hodnotách prvků obvodu, analýza namáhání

součástek, statistická analýza Monte Carlo a nástroj k rozmítání obvodových veličin. Dal-

ším rozšířením, kterým se tato práce zabývá je SLPS, je to další rozšiřující modul, který

umožňuje spolupráci mezi programy OrCAD PSpice a Matlab/Simulink, tzv. kosimulace.

Cílem této práce je vytvořit návod na používání modulu rozšířených analýz v programu

OrCAD PSpice a modulu SLPS při tzv. kosimulaci a jejich použití v nízkofrekvenční

technice. Všechny typy rozšířených analýz budou použity při vytvoření demonstračních

úloh zaměřených do oblasti pokročilé syntézy a analýzy.

Druhá kapitola slouží k seznámení se se všemi typy analýz patřícími mezi rozšířené

analýzy. Je podrobně popsána práce s každým typem analýzy a je názorně demonstrována

na vzorovém příkladě. Všechny vzorové příklady jsou čerpány z manuálu k rozšířeným

analýzám [18].

Další kapitola se ve stručnosti zabývá prací s modely součástek. Modely součástek je

možné vytvářet, modifikovat a importovat. Pro práci s modely součástek, výjimkou je

import, je nutná znalost jazyka SPICE, ve kterém jsou modely součástek napsány. Pro

práci s modely součástek byly použity dva knižní zdroje [4] a [6].

Ve čtvrté kapitole je popsána spolupráce programů OrCAD PSpice s programem

Matlab Simulink. Popis spolupráce obou programu je převzat z manuálu, neboť se ne-

podařilo oba programy mezi sebou propojit.

Pátá kapitola je věnována použití rozšířených analýz k analýzám nízkofrekvenčních

obvodů. Tato kapitola by měla být použitelná jako výukový materiál. V kapitole budou

kromě rozšířených analýz použity i jiné analýzy, ze základního obsahu programu OrCAD

PSpice. S jejich pomocí bude určována například stabilita obvodu, nebo se bude měřit

činitel souhlasného rušení CMRR.
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1.1 Informační zdroje k programu PSpice

Knižních zdrojů je dostupných mnoho, většina jich je napsána v anglickém jazyce, ale

většinou se zabývají všeobecným popisem programu, nikoliv hlubším popisem pokročilých

typů analýz, kterými se tato práce zabývá.

Z anglicky psané literatury bych především uvedl: Analog Design and Simulation using

OrCAD Capture and PSpice [1]. V této knize je popsáno použití OrCAD PSpice od

základních typů analýz po rozšířené typy analýz. Každý typ analýzy je demonstrován na

vhodném zapojení s popisem nastavení a jednotlivých kroků analýzy.

Z česky psané literatury je uvedena: Řešíme elektronické obvody, aneb kniha o je-

jich analýze [3]. Tato kniha se nezabývá konkrétně programem PSpice, ale řeší se v ní

simulace obvodů především pomocí programů SNAP a Microcap, další česky psaná kniha

Modelování a simulace pomocí PSpice [4]. Jsou v ní řešeny základní typy analýz, základní

práce s modely součástek a některé typy rozšířených analýz, jako například analýza Monte

Carlo, analýza Worst Case a jiné.

Simulace v OrCAD PSpice na úrovni grafického editoru [7] a Modelování a simulace

v mikroelektronice [8]. V prvně jmenovaném studijním textu je ve stručnosti popsána

práce v Capture editoru ve verzi 10. Je zde vysvětleno základní nastavení a použití běžných

typů analýz jako jsou AC, DC a transientní analýza. Druhý studijní text je již rozsáhlejší,

a kromě hlubšího vysvětlení základní práce v Capture editoru, je zde popsána i práce se

součástkami a několik řešených příkladů.

Analýza elektronických obvodů programem OrCAD PSpice [9]. V textu je krátké se-

známení s některými rozšiřujícími typy analýz jako jsou: Monte Carlo, Worst Case, tep-

lotní analýzu a krokování parametrů.

Všechny tři výše zmíněné texty jsou vhodné spíše pro základní seznámení s progra-

mem a pro získání základní orientace v ovládání programu, k seznámení se s pokročilými

možnostmi programu nejsou tyto texty zcela vhodné a budou použity jiné informační

zdroje.

Uživatelská příručka [16] k verzi programu PSpice 16.5 obsahuje kompletní popis celého

programu včetně všech typů analýz zahrnující i pokročilé typy analýz a v dalších částech

na ní bude často odkazováno.

Nápověda k pokročilým analýzám v programu OrCAD PSpice [18] se zabývá jen po-

kročilými typy analýz a je tedy hlavním zdrojem informací.

Uživatelská příručka k editoru magnetických prvků [20], je příručka pro vytváření a

editaci magnetických prvků v programu PSpice.

V uživatelské příručce k prostředí SPLS [21] je návod, jak propojit obvody, navržené

v programu OrCAD PSpice s programem Matlab/Simulinku.

Jako zdroj zápisů a článků byly použity servery AES E-Library [10] a IEEE XplorerDi-
gital Library [11]. Na těchto stránkách je k dispozici velké množství článků, ve kterých

jsou použity některé nástroje z programu OrCAD PSpice při řešení konkrétních problémů.

Na internetu je mnoho diskusních portálů, ať se jedná o portály zřizované výrobci
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simulačních programů, jako je například diskusní fórum společnosti Cadence [12], nebo

jiné nezávislé portály jako je například EETimes [13], Eduboard [14] nebo Designer’s

Guide Comminuty [15].
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2

Rozšířené analýzy v programu
PSpice

Rozšířené typy analýz jsou rozšiřující moduly v programu OrCAD PSpice A/D a AMS

simulátoru. Rozšířené analyzační nástroje se používají jako nadstavba základních typů

analýz. Pomocí rozšířených analýz je možné upravovat parametry obvodu tak, aby bylo

dosaženo jeho požadovaných vlastností a chování. Pokud bude navrhován například filtr

typu dolní propust, je možné s využitím rozšířených analýz dosáhnout požadované šířky

propustného pásma, zlomový kmitočet filtru, útlumu v zádržném pásmu a mnoho jiných

parametrů. Možnosti jednotlivých typů analýz jsou popsány vždy na vhodném vzorovém

příkladu v další části této kapitoly u konkrétních typů analýz. Příklady použité v této

kapitole pro popis analýz jsou součástí dokumentace OrCAD PSpice.

Do rozšířených analýz patří několik typů analýz. Sensitivity analysis (citlivostní ana-

lýza) slouží k určení součástky, která má největší vliv na definovanou měřicí funkci či

sledovaný obvodový parametr, například na šířku propustného pásma filtru typu pásmová

propust. Optimizer (optimalizace) slouží k nastavení hodnot obvodových prvků, aby celý

obvod vykazoval požadované vlastnosti. Je možné optimalizaci provádět podle zadaných

kritérií nebo pomocí referenčního průběhu obvodové funkce, ke kterému se průběhem

optimalizovaného obvodu snažíme s povolenou tolerancí přiblížit. Například jako refe-

renční průběh je možné uvažovat vypočtenou frekvenční charakteristiku filtru a na tuto

charakteristiku je optimalizovat navrhovaný filtr. Smoke analysis (analýza namáhání sou-

částek) je nástroj, pro nalezení prvků v simulovaném obvodu, které pracují v maximálních

pracovních podmínkách a z výsledků této analýzy je možné zvolit vhodně dimenzované

součástky vzhledem k jejich pracovním podmínkám. Monte carlo analysis (toleranční

analýza/analýza výtěžnosti výroby) je statistická analýza, která při svém výpočtu uvažuje

výrobní tolerance součástek a vyhodnocuje chování simulovaného obvodu při velkoséri-

ové výrobě. Parametric plotter (rozmítání parametrů obvodu) je nástroj, pro rozmítání

libovolného počtu parametrů simulovaného obvodu. Účelem rozmítání je stanovit chování

obvodu pro různé hodnoty rozmítaných součástek. Z výsledků je možné určit nejvhod-

nější kombinaci hodnot obvodových prvků, která nejvíce odpovídá požadovanému chování
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obvodu.

Pro nejefektivnější využití všech typů rozšířených analýz je výhodné postupovat dle

obr. 2.1. V postupu použití všech typů rozšířených analýz chybí nasazení Parametric

Plotteru, ten je nejvýhodnější použít před analýzou Monte Carlo a dále pokračovat dle

popisu.

Nakreslit nebo opravit obvod Simulace obvodu Import měřicích funkcíSpustit citlivostní analýzu

Změna prvků nebo úprava hodnot parametrů Splňuje návrh požadavky?

Kontrola průběhů a výsledků měřicích funkcí
Definice měřicích funkcí

Volba dalšího výpočetního algoritmuSpustit analýzu Monte Carlo k ověření výtěžnosti výroby

Export parametrů k optimalizaci
Spuštění optimalizace

Schématický editor Pspice Rozšířené analýzy

NE ANOANO
Je výtěžnost výroby dostatečná?Spustit analýzu namáhání součástek

Spustit analýzu Monte Carlo k ověření výtěžnosti výroby

Uložení výsledků
Doplnit obvod o nové hodnoty

Změna zatěžovacího faktoruJsou některé prvky obvodu přetěžované?ANO
ANO

ANO
NE

NE
Obr. 2.1: Postup práce s moduly rozšířených analýz |Převzato z [19]|
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Při popisu analýz a řešených příkladů byla použita dokumentace k rozšířeným analý-

zám [18].

2.1 Parametry analyzovaného obvodu vstupujícího do

rozšířených analýz

Obvod, který má být simulován pomocí některého z nástrojů rozšířených analýz, musí

obsahovat prvky s parametry, jako jsou tolerance parametrů, distribuční funkce, optima-

lizovatelné parametry a parametry výkonového namáhání prvků. Jednotlivé typy rozšíře-

ných analýz využívají různé parametry prvků. U každého typu rozšířené analýzy bude

řečeno, který parametr je pro provedení konkrétní analýzy potřebný. Prvky, které je

možné použít, jsou ve zvláštní knihovně. Knihovna je v instalačním adresáři ve složce

\Tools\Capture\Library\PSpice\
\AdvAnls\. Knihovna v programu OrCAD PSpice představuje databázi matematických
modelů součástek použitelných při simulaci obvodů.

Parametry prvků, které jsou nutné, pro rozšířené analýzy:

• Tolerance hodnot součástek – např. pro rezistory kladná tolerance odporu
POSTOL = 10%. U součástek typu RLC je možné nastavit jak kladnou hodnotu

tolerance POSTOL, tak zápornou hodnotu tolerance NEGTOL. Pokud není záporná

tolerance definována, uvažuje se stejná, jako kladná tolerance.

• Distribuční funkce hodnot součástek – např. typ rozložení distribuční funkce hod-
noty odporu u rezistoru používané při analýze Monte Carlo může být DIST = FLAT.

• Optimalizovatelné parametry – parametr, který může být pro součástku optimali-
zován, např. šířka pásma u operačního zesilovače GBW = 10MHz.

• Parametry namáhání součástek – např. pro rezistor je tímto parametrem maximální
ztrátový výkon POWER = 0.25W.

Každý typ rozšířené analýzy pracuje s jiným parametrem, pokud bude prováděn pouze

některý typ rozšířené analýzy, není potřeba, aby součástka měla definované parametry pro

všechny typy rozšířených analýz.

Přehled parametrů, které jsou použity při jednotlivých typech rozšířených analýz:

• Sensitivity analysis : tolerance parametrů.

• Optimizer : optimalizovatelné parametry.

• Smoke analysis : parametry namáhání součástek.

• Monte Carlo analysis : tolerance hodnot součástek, distribuční funkce (standardní
rozložení je FLAT - ploché / UNIFORM - konstantní).
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Při rozšířených analýzách je možné samozřejmě používat i součástky ze standardní

PSpice knihovny, ale z důvodu chybějících parametrů, potřebných pro rozšířené analýzy,

nejsou do těchto analýz zahrnuty. To znamená, že rozšířené analýzy nemohou upravovat

hodnoty chybějících parametrů součástek, či pro součástky určit namáhání.

Obvod složený z prvků, které jsou v knihovně rozšířených analýz, je třeba ještě do-

plnit o vhodné hodnoty parametrů. Tyto hodnoty je možné každému prvku přiřadit sa-

mostatně. Po dvojkliku na součástku vyskočí okno, ve kterém je možné upravit veškeré

hodnoty parametrů prvku viz příloha A.2, nebo pomocí tabulky globálních parametrů dle

přílohy A.1. Tabulka globálních parametrů se do schématu vkládá jako součástka VARIA-

BLES z knihovny \tools\capture\library\pspice\special.olb. Tabulka VARIABLES slouží
k usnadnění práce s úpravou hodnot parametrů prvků obvodu, neboť se hodnoty para-

metrů pomocí této tabulky přiřadí všem prvkům obvodu současně.

Před spuštěním rozšířených typů analýz je vždy nutné, aby proběhla některá ze zá-

kladních typů analýz, pomocí kterých odsimulujeme jejich chování v oblasti použití:

• Analýza v časové oblasti (transient).

• Stejnosměrná analýza s rozmítáním (DC Sweep).

• Střídavá analýza s rozmítáním/šumová analýza (AC Sweep/Noise analyses).

Jako příklad použití analýzy v časové oblasti, by mohl být simulován libovolný stabili-

zátor napětí, kde pro správnou funkci je velice důležitý průběh výstupního napětí v časové

oblasti. Z výsledků simulace je možné určit zvlnění na výstupu stabilizátoru amplitudu

výstupního napětí a další potřebné parametry. Stejnosměrnou analýzou je možné určit

například pracovní body tranzistorů a jiných obvodových prvků. Příkladem použití AC

analýzy by mohl být filtr libovolného typu. U filtrů jsou nejdůležitější vlastnosti ve frek-

venční oblasti, tedy amplitudové a fázové frekvenční charakteristiky pro ověření požado-

vaných vlastností simulovaného filtru, jako jsou zlomové kmitočty, útlum v nepropustném

pásmu a další.

2.2 Citlivostní analýza

Při citlivostní analýze se určuje, který prvek nebo prvky ze simulovaného návrhu obvodu

mají největší vliv na sledované vlastnosti analyzovaného obvodu. Jako vzorový obvod pro

citlivostní analýzu je použit tranzistorový RF zesilovač. Mezi jeho vlastnosti, které budou

sledovány, patří například šířka pásma. Pomocí citlivostní analýzy je možné určit, které

prvky mají největší vliv právě na šířku pásma a následně tyto prvky předat k optimalizaci

pro dosažení požadované šířky pásma. Z výsledků analýzy je možné upravit tolerance

prvků zapojení v závislosti na požadované funkci obvodu a jeho výsledné ceně. Při analýze

se počítá i nejhorší možný případ (Worst Case), tedy nejhorší možná kombinace hodnot

obvodových prvků, která může nastat v reálném zapojení v rámci výrobních tolerancí.
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Nakreslit nebo opravit obvod Simulace obvodu Import měřicích funkcíSpuštění citlivostní analýzy
Změna prvků nebo editace hodnot tolerancí parametrů Splňuje návrh požadavky?

Kontrola průběhů a výsledků měřicích funkcí
Definice měřicích funkcí

Odeslání citlivých prvků k optimalizaci
Tisk výsledků

Uložení výsledků
ANO ANONE

Schématický editor PSpice Rozšířené analýzy

Obr. 2.2: Postup práce s citlivostní analýzou |Převzato z [19]|

Při citlivostní analýze je výhodné postupovat dle obr. 2.2
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Při simulaci se rozlišují dvě citlivosti:

• Absolutní citlivost - je poměr změny měřené veličiny k pozitivní změně parametru
o 1. Je určená podle rovnice 2.1.

(2.1)SA =
Ms −Mn

Pn · Sv · Tol

Kde:

Ms . . . výsledek definované měřicí funkce z běhu citlivostní analýzy pro daný para-

metr.

Mn . . . výsledek definované měřicí funkce z běhu základní analýzy pro daný para-

metr.

Pn . . . jmenovitá hodnota parametru.

Sv . . . odchylka citlivosti (standardně 40%). Udává procentuální využití tolerance

daného parametru. Pokud má mít rezistor s hodnotou odporu 100 kΩ definovanou

toleranci 10% a odchylka citlivosti bude standardních 40%, pak při citlivostní ana-

lýze je interval použitých hodnot tohoto rezistoru od 96 do 104 kΩ.

Tol . . . relativní tolerance parametru.

Například změna hodnoty rezistoru o 1Ω má za následek změnu napětí o 0,1V.

• Relativní citlivost - je procentuální změna v definované měřicí funkci, založená na
pozitivní procentuální změně hodnoty parametru prvku v obvodu. Je určená podle

rovnice 2.2.

(2.2)SR =
Ms −Mn

Sv · Tol

Kde:

Ms . . . výsledek definované měřicí funkce z běhu citlivostní analýzy pro daný para-

metr.

Mn . . . výsledek definované měřicí funkce z běhu základní analýzy pro daný para-

metr.

Sv . . . odchylka citlivost (standardně 40%).

Tol . . . relativní tolerance parametru.

Například změna hodnoty rezistoru o 1% má za následek změnu napětí o 2%.

Při analýze kapacitorů a induktorů je tato citlivost mnohem vhodnější, neboť jme-

novité hodnoty kondenzátorů a cívek v obvodu jsou velice malé a změna parametru

o 1 by neměla příliš velký vliv, vzhledem k řádům, v jakých jsou hodnoty kapacitorů

a induktorů.
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Použití obou citlivostí bude popsána dále v textu.

Před samotnou citlivostní analýzou je nutné připravit schéma ze součástek obsahují-

cích parametry, potřebné pro provedení citlivostní analýzy viz příloha A.2. Pro citlivostní

analýzu musí prvky obsahovat toleranci parametru (POSTOL). Poté je třeba obvod analy-

zovat pomocí některého ze základních typů analýz. Citlivostní analýza podporuje všechny

typy základních analýz, tedy analýzu v časové oblasti, stejnosměrnou analýzu s rozmítá-

ním a střídavou analýzu s rozmítáním/šumovou analýzu.

Pro popis citlivostní analýzy je použit vzorový obvod z instalace programu, který je

v instalačním adresáři \tools\pspice\tutorial\capture\pspiceaa\rfamp\rf amp.opj. Jedná
se o tranzistorový RF zesilovač viz obr. 2.3.

Load

D1

1N4148

Q2E

.47u
C7

0

0

In

+VCCRF Amplifier

V1

15VDC

0 0

In+VCC

50

R5

V2

AC = 1
TRAN = Sin(0 5m 1Meg)

DC = 0

.47u

C6

0.01u
C1

.47u

C3

50
R9

470
R6

3.3
R8

3k
R2

470
R4

270
R7

6.8k
R3

24k
R1

10u
C4

Q1

2N5179

Q2

2N3905

Q1E

Tempcos (ppm)

Tolerances

Smoke Limits

User Variables DSMAX = 300

RMAX = 0.25RTMPL = 0

LTOL = 0

LMAX = 5

RTMPQ = 0

ITOL = 0 CIMAX = 1

IMAX = 1

RTMAX = 200

CTOL = 10

RSMAX = 0.005

CTMAX = 125

RTOL = 10
CMAX = 50
CBMAX = 125
CSMAX = 0.005

VTOL = 0

RVMAX = 12

Obr. 2.3: Zapojení analyzovaného obvodu tranzistorového RF zesilovače
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Aby mohla být spuštěna jedna ze základních analýz, je třeba vytvořit simulační profil,

ve kterém se nastaví parametry simulace. V případě simulace vzorového obvodu tranzis-

torového RF zesilovače jsou již vytvořené dva simulační profily. AC simulační profil pro

citlivostní analýzu a profil pro analýzu v časové oblasti. Je nutné po otevření projektu

rfam.opj z instalačního adresáře zvolit před spuštěním simulace vhodný profil. Volba pro-

filu se provede aktivováním profilu kliknutím pravého tlačítka myši na požadovaný profil

a zvolením položky Make Active viz obr. 2.4. Dvojklikem na simulační profil se provede

jeho nastavení dle obr. 2.4.

(a) Volba simulačního profilu

(b) Nastavení simulačního profilu

Obr. 2.4: Nastavení AC analýzy tranzistorového RF zesilovače
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           Frequency

1.0KHz 10KHz 100KHz 1.0MHz 10MHz 100MHz 1.0GHz
Noise_Figure
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SEL>>
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Obr. 2.5: Výsledky AC analýzy tranzistorového RF zesilovače(závislost spektrální hustoty efek-

tivní hodnoty šumového napětí na výstupu na kmitočtu; závislost šumového čísla na

kmitočtu

Po nastavení simulace je možné simulaci spustit. Výsledek AC analýzy tranzistorového

RF zesilovače je na obr. 2.5.

Po provedení AC analýzy se přejde na citlivostní analýzu. Ve schématickém editoru se

zvolí v menu PSpice → Advanced Analysis → Sensitivity. Otevře se nové okno viz obr.

2.6. V tomto okně jsou v části Paremeters součástky, které budou zahrnuty do citlivostní

analýzy a v části Specifications se nacházejí měření, pro která bude provedena citlivostní

analýza. Měření, pro která má být provedena analýza je možné importovat z menu Analy-

sis → Sensitivity → Import Measurements. . . či kliknutím na řádek Click here. . . v části
Specifications, nebo je možné je vytvořit z menu Analysis → Sensitivity → Create New

Measurements.

V tomto příkladu je zvolen import měření z AC analýzy. Importují se čtyři měření:

• max(db(v(load))) – maximální úroveň napětí na zátěži tranzistorového RF zesilo-
vače v dB.

• bandwidth(v(load),3) – šířka frekvenčního pásma tranzistorového RF zesilovače
při poklesu o 3 dB.

• min(10log10(v(inoise)∗ v(inoise)/8.28e-19)) – minimální hodnota šumového
čísla tranzistorového RF zesilovače.

• max(v(onoise)) – maximální hodnota spektrální hustoty efektivní hodnoty šumo-
vého napětí na výstupu tranzistorového RF zesilovače.
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Obr. 2.6: Okno citlivostní analýzy (přehled analyzovaných prvků; seznam měření)
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Šumové číslo udává, kolik šumu dvojbran přidá signálu, který tímto dvojbranem pro-

chází. Při výpočtu šumového čísla u tranzistorového RF zesilovače byla použita rovnice

2.3:

(2.3)F = 10 log
v(inoise)2

8, 28 · 10−19

kde v(inoise) výpočet spektrální hustoty napětí ekvivalentního zdroje šumu, který

by po připojení na vstup vygeneroval stejné poměry na výstupu bezšumového obvodu,

jehož vnitřní šum je nulový. Konstanta 8,28e-19 je získána z normovaného tepelného

šumu rezistoru (zdroje signálu) za teploty 27 ◦C, tedy 300K. Normovaný tepelný šum při

pokojové teplotě se vypočte dle rovnice 2.4

(2.4)
ū2Rn

R
= 4kT∆f = 1, 657 · 10−20 [W ]

Kde:

u2Rn . . . je spektrální hustota šumu rezistoru
[
V 2

Hz

]
R . . . odpor zdroje signálu, v tomto případě 50Ω

k . . . Boltzmannova konstanta 1, 38 · 10−23 J
K

T . . . teplota rezistoru v [K]

∆f . . . šířka pásma, pro kterou byl výpočet proveden, zde 1Hz

Po úpravě rovnice se získá konstanta konstanta 8, 28 · 10−19.
Výsledek citlivostní analýzy tranzistorového RF zesilovače je na obr. 2.7.

Obr. 2.7: Výstup citlivostní analýzy tranzistorového RF zesilovače
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Z výsledků citlivostní analýzy je možné získat mnoho důležitých informací. Sloupce

@MIN a @MAX udávají minimální a maximální hodnotu parametru použitou při ana-

lýze Worst Case. Rozptyl hodnot je závislý na toleranci parametru. Pokud je v dalším

sloupci napsáno Rel Sensititivity, používá se relativní citlivost. Je možné přepnout i na

absolutní citlivost, v menu Analysis → Sensitivity → Display, a zde si vybereme mezi

Absolute Sensitivity nebo Relative Sensitivity. Je také možno kliknout pravým tlačítkem

myši libovolně do sloupce s relativní, popřípadě absolutní citlivostí a pod položkou Display

vybrat požadovanou citlivost. Ve sloupci Linear je zobrazeno, na který prvek obvodu je

konkrétní měření, vybrané v části okna citlivostní analýzy Specifications, nejvíce citlivé.

Z obr. 2.7 je dobře patrné, že maximální úroveň výstupního napětí v dB je nejvíce citlivá

na rezistor R9. Sloupec Rel Sensitivity v okně Parameters udává procentní změnu měřené

veličiny, konkrétně maximální úroveň výstupního napětí, při změně hodnoty parametru

obvodového prvku o 1%. V části Specifications je vidět ve sloupcích MIN a MAX v ja-

kých mezích se úroveň napětí na zátěži může pohybovat při nejhorší kombinaci hodnot

obvodových prvků.

Pokud bude některý z prvků mít opravdu velký vliv na vybrané měření, přepne se do

schématického editoru a upraví se hodnota parametru, například tolerance rezistoru, která

omezí interval použitelných hodnot při analýze. Poté se opět spustí citlivostní analýza a

zkontroluje se výsledek, zda bylo dosaženo snížení citlivosti na daný obvodový prvek.

V případě, že bychom chtěli analyzovaný obvod upravit, aby se choval dle požadavků,

je možné kritické prvky vybrat a odeslat k optimalizaci. V našem případě se k optimali-

zaci nabízejí prvky R2, R3, R4, R5, R6, R8 a R9. Ovšem prvky R5 a R8 se optimalizovat

nebudou, neboť ovlivňují vstupní a výstupní impedance. Prvky R2 a R3 se také optima-

lizovat nebudou, mají vliv na chování tranzistoru. Zbývají tedy rezistory R4, R6 a R8.

Rezistory se vyberou kliknutím na první rezistor plus držením klávesy Ctrl a postupným

klikáním na další rezistory, dále kliknutím pravého tlačítka myši se zobrazí nabídka viz

obr. 2.8, kde klikneme na políčko Send To Optimizer, neboli odeslat k optimalizaci. Další

postup bude popsán v kapitole popisující optimalizaci.

Obr. 2.8: Odeslání kritických prvků analyzovaného obvodu k optimalizaci
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2.3 Optimalizace obvodových vlastností

Optimalizační nástroj, který je součástí rozšířených analýz, slouží k optimalizaci analo-

gových obvodů a jejich chování.

Při optimalizaci je výhodné postupovat dle obr. 2.9

Nakreslit nebo opravit obvod Simulace obvodu Spustit citlivostní analýzu k určení nejcitlivějších prvkůNastavení parametrů, které se budou měnit

Změna prvků nebo úprava hodnot parametrů Splňuje návrh požadavky?

Kontrola průběhů a výsledků měřicích funkcí
Definice měřicích funkcí

Zjemnit optimalizaci
Doplnit obvod o nové hodnotyTisk výsledků

Import měřicích funkcíSpecifikace cílů měřicích funkcíNastavení váhy (důležitosti) cílů nebo omezeníVolba jednoho ze tří výpočetních algoritmů
Spuštění optimalizace

Uložení výsledků

Schématický editor Pspice Rozšířené analýzy

NE ANOANO

Obr. 2.9: Postup práce při optimalizaci |Převzato z [19]|
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Obvod, který bude optimalizován, musí projít napřed některou ze základních analýz

v OrCAD PSpice. Optimalizace, stejně jako citlivostní analýza, funguje nad všemi základ-

ními typy analýz. Obvod musí být sestaven ze součástek z knihovny \tools\capture\library
\pspice\\advanls\obsahujících optimalizovatelný parametr.
Optimalizaci není možné použít k vytvoření funkčního návrhu, optimalizaci digitálního

návrhu či k optimalizaci obvodu, kde malá změna hodnoty proměnného parametru způsobí

změnu stavu, např. klopný obvod.

K provedení optimalizace je možné použít některý ze tří typů algoritmů engine:

• MLSQ engine (Modified Least Squares Quadratic engine) - modifikovaná metoda
nejmenších čtverců. MLSQ engine využívá omezené i neomezené minimalizační al-

goritmy, které umožňují optimalizovat cíle, které jsou předmětem nelineárních ome-

zení. Omezené minimalizační algoritmy hledají vektor x který je lokálním minimem

skalární funkce f(x), přičemž neomezený znamená, že není žádné omezení v rozsahu

vektorů x narozdíl od omezených minimalzačních algoritmů, které jsou omezené po-

volenými vektory x.MLSQ engine dosahuje cíle rychleji než LSQ engine díky snížení

počtu mezikroků vedoucích k nalezení cíle. Je možné nastavit tento engine dle poža-

davků na výsledek. Nastavení se provádí v okně optimalizace v menu Edit→ Profile
Settings a otevře se okno dle obr. 2.10

Obr. 2.10: Okno pro nastavení MLSQ engine

17



Rozšířené možnosti analýz v prostředí PSpice Lukáš Mraček 2012

V tomto okně je možné nastavit typ algoritmu, dále nástroj pro výpočet chyby

při optimalizaci zachycením na křivku (Curve Fit Error), bude vysvětleno později.

Nastavení Delta, což je relativní změna, o kterou se mění optimalizovaný parametr

při výpočtu. Max# of Optimizations je maximální počet pokusů, než je výpočet

zastaven (i při přibližování se k cíli). Cutback je minimální hodnota, o kterou může

být snížen vnitřní krok výpočtu při hledání cíle. Threshold je minimální velikost

kroku pro nastavení optimalizace parametrů. Standardně je Threshold nastaven na

nulu, tím se předpokládá, že se hodnoty měření mění plynule se změnou parametrů,

ale pokud by se v průběhu vyskytl nějaký lokální extrém viz. obr 2.11, způsobený

například rychlým přechodovým dějem, mohla by se optimalizace zaseknout. Po-

kud by nastala taková situace, je třeba Threshold nastavit například na 0,01, což

znamená 1% změnu parametru. Jiná velikost kroku bude schopná zamezit uvíznutí

algoritmu v lokálním extrému. Poslední možností nastavení je položka One Goal.

Volba Least Squares je vhodná při optimalizaci s mnoha cíly. Při této volbě se sčítají

druhé mocniny všech odchylek od požadovaného cíle a MLSQ engine se snaží tuto

sumu zmenšit na nulu. Volba Minimize je vhodná při optimalizaci jediného cíle.

Obr. 2.11: Ukázka výskytu možné chyby v průběhu, se kterou by mohl mít optimalizační al-

goritmus problém |Převzato z [18]|
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• Random engine se používá pro určení počátečního bodu optimalizace, který je v ně-
kterých případech obtížné pomocí MLSQ engine určit. Random engine vytvoří po-

myslnou mřížku v prostoru návrhu, kde body mřížky představují prvky v obvodu

a náhodně spustí analýzu na bodech mřížky. Pomocí mřížky se zamezí opakování

nastavení hodnot parametrů. Na konci analýzy se Random engine vrátí k nejlep-

šímu bodu mřížky a vytvoří z něj počáteční bod, který může být použit pro MLSQ

engine. Nastavení se provádí v okně optimalizace v menu Edit → Profile Settings a
otevře se okno dle obr. 2.12

Obr. 2.12: Okno pro nastavení Random engine
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V tomto okně je možné nastavit kromě typu engine a Curve Fit Error další parame-

try. Steps per Range určuje na kolik kroků bude rozdělen rozsah hodnot parametru.

Max Number of Runs určuje maximální počet běhů. Maximální počet běhů je velice

ovlivněn počtem parametrů (NumStepsparams). NumSteps udává počet kroků, ve

kterých se bude parametr měnit a params udává počet parametrů, které se budou

měnit. Replay Best N Runs at End zopakuje N posledních běhů po skončení optima-

lizace a zobrazí výsledek pouze posledních N opakovaných běhů. Random Number

Generator Seed specifikuje soubor čísel pro generátor náhodných čísel. Soubor čísel

se, narozdíl od nástroje Monte Carlo, mezi běhy nemění, a tak každé spuštění dává

stejné výsledky.

• Discrete engine hledá nejbližší komerčně dostupnou hodnotu pro součástku. Oproti
předchozím engine, které počítají hodnoty, které nemusejí být komerčně dostupné.

Algoritmus provádí výpočet s hodnotami součástek, které jsou komerčně dostupné.

Dostupné hodnoty součástek jsou součástí instalace programu OrCAD PSpice. Ne-

jedná se o výrobní řady jako takové, ale o dostupné hodnoty s odpovídající tolerancí.

Tabulky s dostupnými hodnotami součástek pro rezistory, kondenzátory a cívky jsou

uloženy v souboru s příponou .TABLE v instalačním adresáři \tools\pspice\library
\discretetables\. U discrete engine není příliš možností k nastavení viz obr. 2.14.
U discrete engine je však možné použít vlastní hodnoty komerčně dostupných sou-

částek pokud nebudeme spokojeni s databází hodnot rezistorů, kondenzátorů a cí-

vek, která je v programu. Soubor je možné vytvořit v libovolném textovém editoru.

Soubor by měl mít strukturu dle obr. 2.13. První řádek souboru je vždy komentář,

výpis dostupných hodnot začíná příkazem START a končí příkazem END. Při ukládání

souboru je vhodné volit zkratku součástky, pro kterou je soubor vytvořen (rezistor –

res, kondenzátor – cap, cívka – ind) a před zkratku součástky ještě doplnit hodnotu

tolerance. Jak bylo řečeno, soubory neobsahují výrobní řady, ale je možné vytvořit

soubory obsahující hodnoty odpovídající dostupným výrobním řadám.
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Obr. 2.13: Ukázka souboru s hodnotami rezistorů pro Discrete engine

Obr. 2.14: Okno pro nastavení Discrete engine
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Při použití optimalizačního nástroje je výhodné použít více výpočetních algoritmů

v průběhu optimalizace obvodu. Je vhodné začít optimalizaci Random engine, díky kte-

rému je možné najít nejlepší výchozí bod proMLSQ engine a jako poslední použít Discrete

engine, který hodnoty prvků v optimalizovaném obvodu nahradí hodnotami komerčně

dostupnými. Toto je nejvhodnější postup použití různých výpočetních algoritmů při op-

timalizaci.

Před začátkem optimalizace je velice důležité vybrat vhodné součástky, které budou

při optimalizaci uvažovány. Je tedy velice žádoucí před optimalizací vždy spustit citli-

vostní analýzu, která ukáže, na které prvky obvodu uvažované při citlivostní analýze je

měřený parametr nejvíce citlivý, a poté se tyto prvky mohou předat k optimalizaci. Není

vhodné také do optimalizace uvažovat součástky, které ovlivňují vlastnost, kterou je třeba

u obvodu zachovat, například prvky ovlivňující vstupní a výstupní impedance obvodu. Po-

kud dva prvky ovlivňují stejnou vlastnost, není třeba optimalizovat oba. Optimalizaci je

výhodné začít s malým počtem prvků a případně je v průběhu optimalizace přidávat.

Pro optimalizační nástroj může být obtížnější, pokud do optimalizace zařadíme prvky,

které se hodnotou svého parametru blíží výsledné hodnotě, neboť při změně této hodnoty

dostane optimalizační nástroj horší výsledek než před optimalizací.

Jsou k dispozici dva způsoby optimalizace obvodu. První z nich je optimalizovat ob-

vod podle zadaných cílů a omezení některých zadaných měření. Jako příklad je uvedena

šířka pásma operačního zesilovače. Druhá možnost je optimalizace obvodu podle zadané

křivky. Optimalizační nástroj se snaží přiblížit vybranou charakteristiku obvodu vzoro-

vému průběhu. Obě tyto metody jsou popsány dále na vzorových příkladech.

2.3.1 Optimalizace obvodu pomocí cílů a omezení – Standard

K tomuto typu optimalizace použijeme opět vzorový obvod jako pro citlivostní analýzu,

tedy tranzistorový RF zesilovač dle obr. 2.3. Soubor s optimalizovaným obvodem je v in-

stalačním adresáři \tools\pspice\tutorial\capture\pspiceaa\rfamp\rf amp.opj. Před spuš-
těním optimalizačního nástroje z rozšířených analýz je třeba obvod simulovat pomocí

některé ze základních analýz. Je zvolen připravený AC simulační profil s nastavením dle

obr. 2.4. Výsledek AC analýzy je na obr. 2.5.

Cílem optimalizace je navýšení šířky pásma tranzistorového RF zesilovače na 200MHz

při dodržení omezení v podobě hodnoty zisku alespoň 5 dB, maximálního šumového číslo

5 a maximálního výstupního šumového napětí 3 nV√
Hz
. Původní hodnoty jsou na obr. 2.15.

Jsou k dispozici celkem tři možnosti, jak spustit optimalizaci. Jako první je možné po

proběhnutí základní analýzy označit prvky, které mají být optimalizovány v menu PSpice

→ Advanced analysis → Export Parameters to Optimizer. Druhá možnost je přímé spuš-
tění optimalizace ze záložky PSpice → Advanced Analysis → Optimizer. Tato možnost

bude popsána dále. Je také možné spustit citlivostní analýzu a poté výsledky citlivostní

analýzy exportovat do optimalizačního nástroje. Tato možnost byla zmíněna u citlivostní

analýzy.
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Dle druhé z možných variant otevření optimalizace se zobrazí okno optimalizace viz

obr. 2.16(a), v tomto okně se přidávají prvky, které budou optimalizovány a je zde možné

také volit typ výpočetního algoritmu. Do okna Parameters se přidávají parametry, které

budou optimalizovány kliknutím na řádek Import Parameter se zobrazí okno viz obr.

2.16(b) a označením prvního prvku a držením klávesy Ctrl a současným označováním

dalších prvků se prvky přidávají. V případě, že již proběhla citlivostní analýza a byl

použit export hodnot k optimalizaci, prvky budou již v okně vyplněny. Jako další je třeba

zvolit měření, která chceme pomocí optimalizace zvolených prvků upravit. Volba měření

se provádí v okně Specifications a kliknutím na řádek Import Measurement vyskočí okno

viz obr. 2.16(c) a stejně jako prvky k optimalizaci se vloží definovaná měření. Pokud

bychom chtěli definovat nový typ měření, je třeba kliknout pravým tlačítkem myši někam

do volného prostoru v okně Specifications a vybrat položku Create New Measurement.

Obr. 2.15: Výsledky měření AC analýza tranzistorového RF zesilovače
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(a) Okno optimalizace

(b) Okno s importem prvků k optimalizaci (c) Okno s importem měření pro optimalizaci

Obr. 2.16: Základní okno optimalizace a vkládání prvků a měření k optimalizaci
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Před spuštěním optimalizace je třeba nastavit hodnoty tolerancí, sloupce Min a Max

v okně Parameters a další vlastnosti optimalizace v okně Specifications dle manuálu

k rozšířeným analýzám [18]. Optimalizace je nastavena viz obr. 2.17. Sloupec Type určuje,

zda se jedná o cíl optimalizace či o její omezení. Cílem je myšleno konkrétní hodnota měřicí

funkce, které má optimalizační nástroj dosáhnout. Omezením je myšlena hranice (mez),

kterou nesmí optimalizovaná měřicí funkce překročit nebo pod ní nesmí klesnout. Sloupec

Weight určuje, jakému parametru je při optimalizaci přikládána největší váha a můžeme

tím tedy určit priority při optimalizaci. Největší váha je označena 1, každému vyššímu

číslu je přikládána nižší důležitost. Sloupce Min a Max určují v jaký mezích se může

pohybovat optimalizovaná hodnota.

Pokud jsou vyplněna všechna nezbytná data viz obr. 2.17, může být spuštěna opti-

malizace. Výsledkem optimalizace jsou cíleně upravené hodnoty optimalizovaných prvků,

konkrétně rezistorů R4, R6 a R8, pro dosažení optimalizačních cílů, které byly před spuš-

těním optimalizace nastaveny viz obr. 2.17.

Výsledek optimalizace je na obr. 2.18. V okně Error Graph lze vidět, s jakou chybou

(výpočet chyby je uveden dále v textu) od požadovaného výsledku se jednotlivé typy

měřicích funkcí přibližovaly k cíli. V pátém běhu optimalizace se podařilo nastavit hod-

noty prvků tak, že byly dosaženy požadavky na obvod s téměř nulovou chybou. Z okna

optimalizace je možné vidět, jakou hodnotu by měl pro dosažení požadavků každý z re-

zistorů mít, konkrétně je to v okně Parameters sloupec Current. Dále v okně Specifications

si můžeme prohlédnout dosažené výsledky ve sloupci Current a hodnoty, ze kterých se

vycházelo ve sloupci Original. Sloupec Error nám udává, s jak velkou chybou se nám

podařilo požadavek dosáhnout.

(a) Nastavení rozsahu použitelných hodnot rezistorů R4, R6 a R8

(b) Nastavení cílů a omezení pro jednotlivá měření

Obr. 2.17: Nastavení optimalizace tranzistorového RF zesilovače
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Obr. 2.18: Okno s výsledky optimalizace tranzistorového RF zesilovače pomocí MLSQ engine

Nyní je možno typ MLSQ engine na typ Discrete engine v okně optimalizace, aby

se optimalizace provedla pro reálné součástky a spustí se optimalizace. Výsledkem je

zaokrouhlení hodnot rezistorů na hodnoty odpovídající skutečným hodnotám viz obr.

2.19. Dostupné hodnoty součástek s odpovídající tolerancí se volí ve sloupci Discrete

Table. Je možné porovnat vypočtené hodnoty rezistoru při použití dvou typů výpočetních

algoritmů na obr. 2.18 a 2.19 ve sloupci Current. Při obou typech algoritmů bylo dosaženo

požadovaných cílů stanovených na začátku optimalizace. Šířka pásma tranzistorového RF

zesilovače je po optimalizaci 212MHz pro MSQL engine a 211MHz pro Discrete engine.

Je možné hodnoty po optimalizaci přepsat do schématického editoru a spustit simulaci.

Výsledek simulace je ukázán na výsledcích definovaných měřicích funkcích. Na obr. 2.20

je dobře patrné, jak se rozšířila šířka pásma v řádce bandwidth(v(load),3) ze 150MHz

před optimalizací na 211MHz po optimalizaci.
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Obr. 2.19: Okno s výsledky optimalizace tranzistorového RF zesilovače pomocí Discrete engine

(a) Před optimalizací

(b) Po optimalizaci pomocí (Discrete engine)

Obr. 2.20: Výsledky definovaných měřicích funkcí pro tranzistorový RF zesilovač
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2.3.2 Optimalizace obvodu pomocí zachycení na křivku – Curve

fit

Optimalizace metodou Curve fit je možné použít v následujících případech.

• Při optimalizaci analyzovaného obvodu s jedním nebo více soubory datových bodů.
Je možné optimalizovat několik parametrů současně pro dosažení požadovaných cílů,

jako mohou být výstupní průběhy napětí, fáze či frekvenční charakteristiky.

• Pokud je měření vyjádřeno jako hodnoty v příslušných bodech (Y na X).

• Pokud je požadován přesný průběh obvodového parametru, například impulsní ode-
zva. Jako příklad je uveden tvarovací obvod, kde musí tvar průběhu odpovídat

referenčnímu průběhu.

Pro optimalizaci zachycením na křivku je potřeba importovat referenční data, na které

se bude optimalizace snažit zachytit, nebo je možné referenční data vytvořit. Dále je nutné,

aby obvod obsahoval prvky s optimalizovatelnými parametry.

Referenční data mají textovou podobu. Je možné je vytvořit ručně, optimalizační

nástroj podporuje textové soubory ve formátu .mdp, .csv a .txt. Textový soubor obsahuje

minimálně dva sloupce, které jsou odděleny větší mezerou a jako oddělovač desetinných

míst se používá desetinná tečka. V prvním sloupci by měl být čas nebo frekvence pro

AC analýzu, a ve druhém sloupci je definován referenční průběh. Referenčních průběhů

může textový soubor obsahovat několik. Další možností jak vytvořit referenční data je

exportovat data z programu PSpice jako soubor .txt.

Pro zachycení křivky k referenčnímu průběhu je možné v optimalizačním nástroji pou-

žít jeden ze 4 typů nástrojů (gear) pro výpočet chyby při zachycení na křivku. Jednotlivý

typ nástroje pro výpočet chyby je možné volit v nastavení optimalizace, například viz

obr. 2.14 v položce Curve Fit Error.

• Legacy gear – každý datový bod referenčního průběhu je samostatným cílem opti-
malizace a každý datový bod je optimalizován. Chyba v každém bodě referenčního

průběhu by měla být nulová. Optimalizační nástroj počítá chybu každého referenč-

ního bodu zvlášť a poté spočítá efektivní hodnotu chyby všech datových bodů re-

ferenčního průběhu. Tento typ nástroje je možné použít pouze na omezený počet

datových bodů referenčního průběhu, konkrétně na 250 bodů.

• Weighted reference gear – optimalizační nástroj předpokládá, že datové body refe-
renčního průběhu a simulovaného průběhu mají stejný časový či frekvenční interval

hodnot. Váhovacím faktorem je násobená chyba v každém bodě Xi určeném pro

výpočet chyby. Xi obsahuje v tomto případě body referenčního i simulovaného prů-

běhu. Chyba je počítána násobením chyby váhovacím faktorem v každém bodě

průběhu. Chyba je počítána dle 2.5.
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(2.5)Erms = 100

√∑n
i=1Wi · (Ri − Si)2√∑n

i=1Wi · (Ri)2

Kde:

Ri = YatX(R,Xi) . . .Ri představuje hodnotu datového bodu referenčního průběhu

na pozici i.

Si = YatX(S,Xi) . . .Si představuje hodnotu datového bodu simulovaného průběhu

na pozici i.

Wi . . . představuje váhu, která se vypočte podle rov. 2.6 a 2.7.

n . . . jsou body referenční křivky.

Xi . . . je množina hodnot, ze které se počítá chyba.

– Pro simulovaná data:
(2.6)Wi = 1

– Pro referenční data:

(2.7)Wi =

(
b

a

)2
Kde:

b = sizeof{Xref+sim} . . . velikost součtu vektorů referenčního a simulovaného
průběhu.

a = sizeof{Xref} . . . velikost vektoru referenčního průběhu.
Sizeof vrací velikost vektoru datových bodů.

• Reference only gear – optimalizační nástroj se snaží přiblížit optimalizovaný průběh
k referenčnímu průběhu s cílem minimalizovat poměr efektivní hodnoty vypočtené

chyby a efektivní hodnoty referenčního průběhu (RMSerror/RMSref ) pod úroveň

tolerance definované uživatelem. Chyba je počítána pouze v referenčních datových

bodech a Xi obsahuje pouze body referenčního průběhu. Rovnice pro výpočet chyby

je stejná jako pro weighted reference gear s tím rozdílem, že Wi = 0 pro všechny

datové body, které nejsou na referenčním průběhu.

• Simulation only gear – optimalizační nástroj předpokládá, že datové body refe-
renčního průběhu a simulovaného průběhu mají stejný časový či frekvenční interval

hodnot. Chyba se počítá dle rovnice 2.8.

(2.8)Erms = 100

√∑n
i=1 (Ri − Si)2√∑n

i=1 (Ri)2
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Jako ukázkový příklad pro optimalizaci pomocí zachycení na křivku je použit obvod

dle obr. 2.21. Obvod se načte z instalačního adresáře \tools\pspice\tutorial\capture
\pspiceaa\bandpass\bandpass.opj. Jde o filtr typu pásmová propust využívající dvou ope-
račních zesilovačů OP-07. Pro provedení základního typy analýzy je již vytvořený simu-

lační profil, jeho nastavení je na obr. 2.22, je třeba tedy jen spustit analýzu. Výsledek

analýzy filtru je na obr. 2.25.

U1

OP-07

+
3

-
2

V
+

7
V

-
4

OUT
6

OS1
1

OS2
8

R3

400

R1

50k

C3

0.1u

R5
60k

0

0

V1

AC = 1
TRAN =

DC =

-15

15

C1

0.1u

U2

OP-07

+
3

-
2

V
+

7
V

-
4

OUT
6

OS1
1

OS2
8

R4

1.2k

R2

49k

C4

0.25u

-15

out

R6
49k

15

C2

0.1u
V2

15

V3
-15

0

0

-15

15

0

Obr. 2.21: Schéma optimalizovaného filtru typu pásmová propust

Obr. 2.22: Simulační profil AC analýzy pro optimalizovaný filtr typu pásmová proput
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Po provedení základní analýzy se spustí optimalizace z menu PSpice→ Advanced Anly-
sis → Optimizer. Nastaví se optimalizace podobně jako v předchozím případě, jen se zvolí
záložka Curve Fit. Nastavení optimalizace viz obr. 2.23. Cílem této optimalizace je příblí-

žení se průběhem úrovně výstupního napětí a fáze filtru typu pásmová propust k referenč-

nímu průběhu. Referenční průběh je v instalačním adresáři \tools\pspice\tutorial\capture
\pspiceaa\bandpass\bandpass-PSpiceFiles\SCHEMATIC1\reference.txt. V souboru s re-
ferenční průběhem je referenční křivka jak pro průběh úroveně výstupního napětí, tak fázi

filtru typu dolní propust.

Obr. 2.23: Nastavení optimalizace filtru typu pásmová propust pro zachycení na křivku
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Po spuštění optimalizace se program snaží původní průběhy úrovně výstupního napětí

a fáze filtru typu dolní propust viz obr. 2.25(a) zachytit na referenční průběhy, které

byly do optimalizačního nástroje importovány ve formě textového souboru reference.txt.

Program se má zachytit na průběh úrovně výstupního napětí filtru v dB s 3% tolerancí a

na fázi výstupního napětí s 5% tolerancí při změně optimalizovatelných prvků v obvodu.

Z optimalizace byl vyřazen rezistor R3 a uzamčeny rezistory R5 a R6, jejichž hodnotu

optimalizační nástroj nebude měnit. Optimalizačnímu nástroji se to povedlo v desátém

běhu algoritmu viz obr. 2.24 zachytit na referenční průběhy s definovanými tolerancemi.

Tolerance, jinak řečeno maximální chyba, s jakou se optimalizační nástroj musí zachytit

na křivku, je při použití Reference only gear počítána dle rovnice 2.8. A je to tedy efektivní

hodnota chyby ve všech bodech křivky, nejedná se tedy o toleranční pásma, ale o jedinou

hodnotu. Pro zlepšení požadovaného průběhu by se mohl použít Legacy gear, který počítá

chybu v každém bodu průběhu zvlášť. Tento typ výpočtu je však časově nejnáročnější a

je omezen pouze na optimalizaci křivky o maximálním počtu 250 bodů. Ostatní typy

nástrojů pro výpočet chyby pracují velice podobně a počítají chybu přes celý průběh,

nikoliv v jednotlivých bodech a tím je omezena přesnost zachycení na křivku.

Na obr. 2.25 je dobře vidět srovnání výsledků před optimalizací obr. 2.25(a) a po

optimalizaci2.25(b) a (c). Ve výsledcích po optimalizaci jsou červené průběhy referenční

a zelené průběhy jsou dosažené optimalizací.

Obr. 2.24: Výsledky optimalizace filtru typu pásmová propust v okně optimalizace
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(a) Výsledek AC analýzy před optimalizací
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Obr. 2.25: Výsledky optimalizace pásmové propusti s operačními zesilovači

33



Rozšířené možnosti analýz v prostředí PSpice Lukáš Mraček 2012

2.4 Analýza namáhání součástek (Smoke analysis)

Analýza slouží k nalezení součástek, které jsou nejvíce namáhány ztrátovým výkonem,

navýšením teploty přechodu, sekundárními průrazy nebo porušením napěťových či prou-

dových limitů. Analýza pro nalezení bezpečných pracovních podmínek prvků v obvodu

používá maximální pracovní podmínky, poskytované výrobci součástek a zatěžovací fak-

tor definovaný při návrhu obvodu. Analýza porovnává výsledky simulace s bezpečnými

pracovními podmínkami prvků v obvodu a při jejich překročení jsou kritické prvky v ob-

vodu označeny. Výsledky analýzy namáhání součástek je možné zobrazit v průměrných,

efektivních a špičkových hodnotách.

Při analýze namáhání součástek je výhodné postupovat dle obr. 2.26

Nakreslit nebo opravit obvod Simulace obvodu Import měřicích funkcíSpuštění citlivostní analýzy
Změna prvků nebo editace hodnot tolerancí parametrů Splňuje návrh požadavky?

Kontrola průběhů a výsledků měřicích funkcí
Definice měřicích funkcí

Odeslání citlivých prvků k optimalizaci
Tisk výsledků

Uložení výsledků
ANO ANONE

Schématický editor PSpice Rozšířené analýzy

Obr. 2.26: Postup práce s analýzou namáhání součástek |Převzato z [19]|

34



Rozšířené možnosti analýz v prostředí PSpice Lukáš Mraček 2012

Při analýze namáhání součástek je možné určit následující pracovní limity:

• průrazné napětí na svorkách prvku v obvodu

• maximální proudové limity

• ztrátový výkon pro každý prvek

• sekundární průrazné limity

• teploty přechodů.

Pro spuštění analýze namáhání součástek je třeba, aby obvod byl složen z prvků,

které obsahují parametry potřebné pro analýzu namáhání součástek. Dále je nezbytné,

aby proběhla jedna ze základních analýz. Analýza namáhání součástek funguje pouze při

analýze v časové oblasti.

K použití kouřové analýzy byl opět zvolen obvod tranzistorový RF zesilovače se zapo-

jením dle obr. 2.3, který se nachází v instalačním adresáři \tools\pspice\tutorial\capture
\pspiceaa\rfamp\rf amp.opj. K základní analýze je použit připravený simulační profil pro
časovou analýzu viz obr. 2.27. Výběr simulačního profilu byl popsán u citlivostní analýzy.

Nyní se spustí samotná analýza.

Obr. 2.27: Nastavení simulačního profilu pro časovou analýzu

35



Rozšířené možnosti analýz v prostředí PSpice Lukáš Mraček 2012

Po provedení základní analýzy vybereme z menu PSpice → Advanced Analysis →
Smoke. Zobrazí se nám okno analýzy namáhání součástek a automaticky se analýza pro-

vede viz obr. 2.28.

Obr. 2.28: Okno analýzy namáhání součástek pro tranzistorový RF zesilovač

36



Rozšířené možnosti analýz v prostředí PSpice Lukáš Mraček 2012

Sloupec Parameter na obr. 2.28 udává, jaký parametr byl u součástky sledován. Vý-

znam těchto parametrů je popsán v příloze A.2. Sloupec %Derating udává, na kolik pro-

cent je možné využít zatěžovací faktor parametrů, aby součástka ještě pracovala v bezpeč-

ných pracovních podmínkách. Sloupec Max Derating udává číselnou hodnotu sledovaného

parametru, která odpovídá procentuální hodnotě ve sloupci %Derating.

Zelené řádky značí, že nebyly překročeny bezpečné pracovní limity. Žluté řádky značí

dosažení 90% bezpečných pracovních limitů a červené řádky značí překročení bezpečných

pracovních podmínek pro konkrétní součástku. Pokud by řádek byl šedý, není pro tento

typ parametr výrobcem součástky určen.

V okně analýzy namáhání součástek jsou zobrazeny výsledky pro všechny prvky ob-

vodu, které mají parametr pro analýzu namáhání součástek, navíc je pro každý parametr

zobrazena průměrná, efektivní i špičková hodnota namáhání součástky. K nastavení se

při analýze namáhání součástek nabízí velké množství parametrů, ale jako nejzásadnější

parametr je derating factor, tzv. zatěžovací faktor, který nám určuje bezpečné pracovní

limity pro jednotlivé součástky. Například pro 5W rezistor, který má zatěžovací faktor 0,9

to znamená, že limit pro bezpečné používání je 4,5W. Jako standardní zatěžovací faktor je

ve smoke analýze nastaven zatěžovací faktor 1, to znamená, že bezpečné limity odpovídají

100% hodnoty parametru pro analýzu namáhání součástek. Dále je možné zvolit stan-

dardní zatěžovací faktor, který je v programu předefinován viz obr. 2.29. Další možností

volby zatěžovacího faktoru je import souboru s příponou .drt, který obsahuje definovaný

zatěžovací faktor a poslední možností je vlastní definice zatěžovacího faktoru pro vybrané

součástky přímo v programu. Existuje i možnost úpravy již definovaného zatěžovacího

faktoru. Veškerá práce se zatěžovacím faktorem se provádí v menu smoke analýzy Analy-

sis → Smoke → Derating. Více o možnostech nastavení a tvorby zatěžovacích faktorů je
v manuálu k rozšířeným analýzám [18].

Obr. 2.29: Cesta v menu k nastavení a volbě zatěžovacího faktoru
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2.5 Analýza výtěžnosti výroby (Monte Carlo)

AnalýzaMonte Carlo patří také mezi rozšířené typy analýz. Jedná se statistickou analýzu,

která je schopná určit výtěžnost výroby. Při analýze se mění hodnoty součástek pomocí in-

tegrovaného generátoru náhodných čísel v rozmezí stanovených tolerancí a tím se program

snaží simulovat výrobní odchylky součástek při výrobě obvodu. Analýza Monte Carlo se

používá pro:

• výpočet výtěžnosti na základě uživatelem stanovených požadavků

• integrace měřicích funkcí s grafickým výstupem

• zobrazení výsledků pravděpodobnosti distribuční funkce PDF

• zobrazení výsledků kumulativní distribuční funkce CDF

• výpočet statistických dat pro definovanou měřicí funkci

• zobrazení měřených hodnot pro každý běh simulace.

Při analýze Monte Carlo je výhodné postupovat dle obr. 2.30

Nakreslit nebo opravit obvod Simulace obvodu Import měřicích funkcíSpuštění citlivostní analýzy
Změna prvků nebo editace hodnot tolerancí parametrů Splňuje návrh požadavky?

Kontrola průběhů a výsledků měřicích funkcí
Definice měřicích funkcí

Odeslání citlivých prvků k optimalizaci
Tisk výsledků

Uložení výsledků
ANO ANONE

Schématický editor PSpice Rozšířené analýzy

Obr. 2.30: Postup práce s analýzou Monte Carlo |Převzato z [19]|
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Obvod, který má být analyzován analýzou Monte Carlo musí být složen z prvků, které

jsou z knihovny pokročilých analýz ve složce \Tools\Capture\Library\PSpice\
\AdvAnls\. Konkrétně musí jako parametr obsahovat toleranci. Pokud je obvod složen
z vhodných prvků, je nutné obvod analyzovat jednou ze základních typů analýz. Analýza

Monte Carlo funguje na všech typech základních analýz, tedy na DC, AC a časové analýze.

A jako poslední předpoklad pro spuštění analýzy Monte Carlo musí být definována měřicí

funkce, podobně jako pro ostatní typy rozšířených analýz.

K analýzeMonte Carlo bude použit opět tranzistorvý RF zesilovač viz obr. 2.3, který je

v instalačním adresáři ve složce \tools\pspice\tutorial\capture\pspiceaa\rfamp\rf amp.opj
a předdefinovaný AC simulační profil viz obr. 2.4. Volba simulačního profilu byla již po-

psána v části citlivostní analýzy. Po proběhnutí AC analýzy se otevře ze schématického

editoru okno s analýzou Monte Carlo z menu PSpice → Advanced Analysis → Monte

Carlo. Zobrazí se okno analýzy viz obr. 2.31

Obr. 2.31: Základní okno analýzy Monte Carlo
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V horní polovině okna je vyhrazena část pro graf PDF nebo pro graf CDF. Volba

typu grafu se provádí kliknutím pravého tlačítka myši libovolně v oblasti grafu a výběrem

položky CDF či PDF Graph. V dolní polovině okna je část Specifications, která má navíc

dvě záložky, podobně jako okno optimalizace. Záložka Statistics zobrazuje statistická data

a záložka Raw Meas zobrazuje neupravené číselné výsledky měřicích funkcí. Pokud je

aktivní záložka Statistics je možné kliknutím na řádek Import Measurement importovat

některé z definovaných měření viz obr. 2.16(c). Je zde také možnost měření vytvořit.

Měření je možné vytvořit z menu Analysis → Monte Carlo → Create New Measurement
viz obr. 2.32, ve kterém je možné definovat měřicí funkci.

Obr. 2.32: Okno pro vytvoření nového měření
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Analýza Monte Carlo obsahuje celkem 4 nastavitelné parametry. Nastavení analýzy

se provádí v okně analýzy v menu Edit → Profile Settings (záložka Monte Carlo) viz obr.
2.33.

Obr. 2.33: Nastavení analýzy Monte Carlo
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• Number of Runs udává počet běhů analýzy. V prvním běhu jsou použity nomi-
nální hodnoty parametrů a v každém následujícím běhu se hodnoty parametrů mění

v rámci definovaných tolerancích pomocí generátoru náhodných čísel. Maximální

počet běhů je omezen pouze dostupnou pamětí počítače.

• Starting Run Number udává pořadí startovního běhu. Běh číslo 1 používá nominální
hodnoty a je standardně nastaven. Vyšší startovní číslo běhu je možné použít, pokud

jsou počáteční běhy nevýznamné pro analýzu a je možné ušetřit tak výpočetní čas.

• Random Seed Value používá generátor náhodných čísel ke generování sekvence ná-
hodných čísel. Pokud je cílem opakování výsledků, není třeba tuto hodnotu měnit.

Ale pokud se údaj bude měnit, je možné získat různé výsledky pro každou simulaci.

• Number of Bins určuje počet intervalů, na které má být výsledný histogram roz-
dělen. Typická hodnota je 0,1 počtu běhů analýzy. Minimální počet je jedna a

maximální je omezen dostupnou pamětí počítače.

Výsledky analýzy Monte Carlo tranzistorového RF zesilovače jsou na obr. 2.34

Na obr. 2.34(a) je histogram rozložení hustoty pravděpodobnosti. Tento histogram je

pro měřicí funkci bandwidth(v(load),3), měření udává šířku pásma tranzistorového RF

zesilovače při poklesu o 3 dB. Na svislé ose je vynesen počet běhů. Na vodorovné ose jsou

výsledky zvoleného měření, tedy dosažené šířky pásma pro jednotlivé běhy. Na obr. 2.34(b)

je kumulativní distribuční graf pro měřicí funkci bandwidth(v(load),3). Na svislé ose je

opět počet běhů a na vodorovné ose jsou výsledky zvoleného měření. Hranice Min a Max

v obou grafech určují oblast, ze které jsou počítána statistická data. Hranice je možné

libovolně přesouvat. Aktivní hranice, pohybuje se s ní, je červená, neaktivní je černá.

Kliknutím levým tlačítkem myši na jednu z hranic se aktivuje a kliknutím na požadovanou

pozici v PDF či CDF grafu se umístí a automaticky se provede přepočet statistických dat.

Pozici hranic je možné samozřejmě volit i číselně v okně optimalizace v záložce Statistics ve

sloupcích Cursor Min a Cursor Max v obr. 2.34(c), kde jsou zobrazeny výsledky statistické

analýzy Monte Carlo. Další sloupec Yield udává, kolik procent běhů programu se vešlo do

mezí určených kurzory. Jinak řečeno, kolik procent vyrobených obvodů by splnilo předem

definované požadavky na vyrobený obvod, například požadovanou šířku pásma zesilovače.

Sloupec Mean udává průměrnou hodnotu získanou ze všech běhů. Hodnoty pro jednotlivé

běhy je možné získat v záložce Raw Meas. Sloupec Std Dev je směrodatná odchylka a značí

se σ. Udává, jak se od sebe navzájem liší typické hodnoty v konkrétním souboru měření.

Sloupec 3 Sigma udává počet běhů měření v procentech, které se vejdou do intervalu ±3 σ.
Sloupec 8 Sigma udává počet běhů měření v procentech, která se vejdou do intervalu ±6 σ.
Sloupec Median určuje pomyslný střed mezi výsledky měření. Nejméně 50% hodnot je

menších nebo rovných a nejméně 50% hodnot je větších nebo rovných mediánu. Na obr.

2.34(d) je možné vidět záložku Raw Meas, kde jsou výsledky všech importovaných měření

pro jednotlivé běhy analýzy. Tyto výsledky jsou poté statisticky zpracovávány a výsledky

jsou na záložce Statistics jak bylo již uvedeno.
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(a) PDF graf měřicí funkce bandwidth(v(load),3)

(b) CDF graf měřicí funkce bandwidth(v(load),3)

(c) Statisticky zpracované výsledky měřicích funkcí

(d) Neupravené číselné výsledky měřicích funkcí

Obr. 2.34: Výsledky analýzy Monte Carlo tranzistorového RF zesilovače

43



Rozšířené možnosti analýz v prostředí PSpice Lukáš Mraček 2012

2.6 Rozmítání obvodových parametrů

Parametric plotter je posledním nástrojem, patřícím mezi rozšířené analýzy programu

OrCAD PSpice. Parametric plotter umožňuje rozmítání mnoha obvodových parametrů a

také umožňuje účinně analyzovat výsledky rozmítání. Je možné současně rozmítat nejen

parametry prvků, ale také parametry celého obvodu, jako příklad je možné uvést provozní

teplotu celého zapojení. Parametric plotter je možné použít pro:

• rozmítání mnoha parametrů obvodu současně, například pracovní teplota, napájecí
napětí a jiné, což jinak není možné

• rozmítání parametrů prvků obvodu/modelů obvodových prvků

• zobrazení výsledků rozmítání v podobě tabulky, kde se zobrazí výsledky měřicích
funkcí pro jednotlivé kombinace hodnot obvodových prvků

• vykreslení výsledků měření v PROBE UI (User Interface)

• vyhodnocení výsledků měření z provedených analýz.

Parametric plotter může využít jeden ze čtyř typů rozmítání hodnot parametrů během

analýzy:

• Discrete Sweep – při simulaci se používají jen hodnoty parametrů, které se předem
specifikují. Hodnoty jsou voleny libovolně, dle potřeby.

• Linear Sweep – hodnoty parametrů, používané při simulaci jsou z intervalu, který
začíná Start Value, poslední hodnota musí být větší nebo rovna End value a interval

je rozdělen pomocí Step Value.

• Logarithmic Octave Sweep – hodnoty parametrů se mění s funkcí ln(2). Je třeba
definovat Start Value, End Value a Number of points per Octave. Number of points

per Octave udává počet bodů na oktávu, přičemž poslední bod oktávy je dvojnáso-

bek Start Value. Například Start Value je 10, Number of points per Octave je 5, tak

Parametric Plotter vloží do intervalu 10 až 20 pět hodnot, s tím, že pátá hodnota

z intervalu je 20. Hodnoty z intervalu se zvyšují s faktorem dle rov. 2.9

(2.9)factor = exp[(ln(2))/N ]

Kde:

N . . .Number of points per Octave.
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• Logarithmic Decade Sweep – hodnoty parametrů se mění s funkcí ln(10). Je třeba
definovat Start Value, End Value a Number of points per Decade. Number of points

per Decade udává počet bodů na dekádu, přičemž poslední bod dekády je deseti-

násobek Start Value. Například Start Value je 10, Number of points per Decade je

5, tak Parametric Plotter vloží do intervalu 10 až 100 pět hodnot, s tím, že pátá

hodnota z intervalu je 100. Hodnoty z intervalu se zvyšují s faktorem dle rov. 2.10

(2.10)factor = exp[(ln(10))/N ]

Kde:

N . . .Number of points per Decade.

Jako ukázkový příklad je použit jednoduchý obvod pro induktivní spínání, schéma ob-

vodu je na obr. 2.35. Obvod se nachází v instalačním adresáři \tools\pspice\tutorial\capture
\pspiceaa\Snubber\SNUBBER.opj. K obvodu jsou již připraveny dva simulační profily. Je
zvolen transientní simulační profil, nastavení profilu je na obr. 2.36. Volba aktivního si-

mulačního profilu byla již popsána výše. Následuje spuštění simulace, jejíž výsledky jsou

na obr. 2.37.

R3

10

Q1

IRF640
CGSO = 1410p

V

V

PARAMETERS:

tfall = 10n
trise = 10n

V1

100Vdc

V2

TD = 0

TF = {tfall}
PW = 4u
PER = 10u

V1 = -10

TR = {trise}

V2 = 15

C1
.5n

R2

10

L1

.5u

1 2

R1

25

Obr. 2.35: Schéma zapojení obvodu pro induktivní spínání
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Obr. 2.36: Nastavení simulačního profilu pro transientní analýzu

           Time

0s 2us 4us 6us 8us 10us 12us 14us 16us 18us 20us
V1(L1)

0V

40V

80V

120V
V(R3:2)

-10V

0V

10V

20V

SEL>>

Obr. 2.37: Výsledky transientní analýzy obvodu pro induktivní spínání (vstupní napětí na R2;

výstupní napětí na L1)
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Cílem tohoto řešeného příkladu je minimalizovat napěťové překmity, které jsou velmi

dobře patrné z obr. 2.37 na průběhu napětí na cívce L1. Překmity je možné omezit zvět-

šením hodnoty odporu rezistoru R2 a zvýšením kapacity kondenzátoru C1. Tím se ale

zvýší ztrátový výkon na odporu R2. K nalezení řešení bude použito rozmítání hodnot

parametrů R2 a C1 a doby náběžné hrany pulsů ze zdroje V2.

Po proběhnutí základní analýzy se spustí Parametric plotter z menu PSpice→ Advan-
ced Analysis → Parametric Plotter a zobrazí se okno viz obr. 2.38. V horní části okna,

označené Sweep Parameters, se zadávají rozmítané parametry. V tomto příkladu to jsou

jmenovité hodnoty rezistoru R2, kondenzátoru C1, hodnota CGSO (Gate-Source Overlap

Capacitance – kapacita mezi G a S) tranzistoru Q1 a doba náběžné hrany průběhu napětí

ze zdroje V2. Kliknutím levého tlačítka myši v okně Sweep Parameters na řádek Click

here to import a parameter. . . se zobrazí okno pro výběr rozmítaných parametrů viz obr.

2.39(a). A nyní je třeba doplnit hodnoty a typy rozmítání jednotlivých rozmítaných pa-

rametrů kliknutí na odpovídající řádek ve sloupci Sweep Values dle obr. 2.39(b), (c), (d)

a (e).

Obr. 2.38: Základní okno Parametric Plotter
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(a) Okno se seznamem dostupných parametrů k rozmítání (b) Nastavení rozmítání pro

rezistor R2

(c) Nastavení rozmítání pro

tranzistor Q1

(d) Nastavení rozmítání ná-

běžné hrany trise zdroje V2

(e) Nastavení rozmítání pro

kondenzátor C1

Obr. 2.39: Nastavení rozmítání parametrů pro obvod k induktivnímu spínání
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Dále je nutné importovat měření. To se provádí v záložce Measurements, stejně jako

u ostatních typů analýz. Kliknutím na řádek Click here to import a measurement. . . se

zobrazí okno pro import již vytvořených měření viz obr. 2.40 a zde se vyberou měření

overshot(v(l1:2)), neboli překmit napětí na cívce L1 a yatlastx(avg(w(r2))), což

je výkonová ztráta na rezistoru R2. A jako poslední se přidá průběh napětí na DRAIN

tranzistoru Q1. Toto měření se přidá kliknutím pravým tlačítkem myši libovolně do vol-

ného prostoru v záložce Measurements a výběrem volby Create New Trace se zobrazí

okno pro vytvoření nového průběhu. Zde je nutné vybrat transient.sim u volby Profile a

poté do pole Measurement napsat nebo vložit požadovaný průběh. V tomto případě se

do tohoto pole napíše v(q1:d). Na obr. 2.41 je znázorněné kompletní nastavení. Nyní je

možné spustit Parametric Plotter.

Obr. 2.40: Okno pro vytvoření uživatelsky definovaného průběhu

Obr. 2.41: Vyplněné okno Parametric Plotter
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Výsledky z Parametric Plotter jsou zobrazeny v záložce Measurements na obr. 2.41.

Ve sloupcích Min Value a Max Value jsou zobrazeny minimální a maximální dosažené

hodnoty pro jednotlivá měření této analýze obvodu pro induktivní spínání. Na další záložce

Results jsou výsledky pro všechny kombinace rozmítaných obvodových parametrů pro

jednotlivá měření a vykreslovaný průběh napětí viz obr. 2.42. V této záložce je možné

výsledná data řadit dle potřeby, případně celý sloupec uzamknout, aby se při řazení

dalších sloupců data také neřadila. Pro řazení stačí dvakrát kliknout na název sloupce,

pro uzamčení sloupce slouží ikona zámku v řádku pod názvem sloupce. V další záložce

Plot Information je možné pomocí průvodce ověřit výsledky měření v grafické podobě

pomocí grafu.

Obr. 2.42: Výsledky Parametric Plotter pro všechny kombinace rozmítaných obvodových pa-

rametrů

Průvodce vytvoření nového grafu se spustí kliknutím na řádek Click here to add plot.

Zobrazí se okno viz obr. 2.43(a), kde se volí simulační profil, pokud jich bylo při Pa-

rametric Plotter použito několik. V tomto případě se zvolí jediný nabízený profil tran-

sient.sim a klikneme na tlačítko Další (Next). Zobrazí se okno viz obr. 2.43(b). Zde

se volí parametr, který bude rozmítaný na ose X, zvolí se hodnota rezistoru R2, tedy

r2::value a klikne se opět na tlačítko Další (Next). Zobrazí se okno viz obr. 2.43(c),

kde se volí, pro jaký typ definovaného měření se budou parametry rozmítat. Zvolí se

transient.sim::overshot(v(l1:2)), tedy velikost překmitu napětí na cívce L1 a klikne

se na tlačítko Další (Next). Následuje volba druhého rozmítané parametru, zde se zvolí

hodnota kondenzátoru C1, tedy c1::value viz obr. 2.43(d) a klikne se na tlačítko Další

(Next). Nyní následuje volba konstantních hodnot pro zbylé dva parametry, tedy pro trise

a pro CGSO tranzistoru Q1. Bude zvolena doba trise 10n a hodnota CGSO 141p. Kliknu-

tím pravým tlačítkem myši na hodnotu 141p se zobrazí nabídka Lock a potvrzením této

nabídky se uzamknou a zčervenají obě hodnoty viz obr. 2.43(e). Touto volbou se nastaví

tyto hodnoty jako konstantní pro vykreslení požadovaného grafu. Nyní se klikne na tla-

čítko Dokončit (Finish) a v záložce Plot Information přibude nová řádka s definovaným

vyhodnocovacím grafem viz obr. 2.43(f). Pro zobrazení výsledků je třeba pravým tlačít-

kem myši kliknout kamkoliv do nově vytvořeného řádku a vybrat položku Display Plot a

zobrazí se výsledné okno grafu viz obr. 2.44. Z tohoto grafu je možné určit, pro jaké kom-

binace hodnot parametrů je překmit napětí na cívce L1 nejmenší při konstantní náběžné

době průběhu napětí zdroje V2 a při konstantní hodnotě parametru CGSO tranzistoru
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Q1. Je možné vidět, že přibližně od hodnoty 20Ω rezistoru R2 nemá zvyšování odporu

příliš velký význam. Nejmenší překmit pro všechny hodnoty odporu rezistoru R2 vyšel

pro hodnotu kapacity kondenzátoru C1 980 pF . Nyní je možné ověřit výsledky změnou

hodnot prvků ve schématu a výsledek je zobrazen na obr. 2.45.

(a) Volba simulačního profilu (b) Volba proměnného parametru na ose X

(c) Volba definovaného měření (d) Volba druhého proměnného parametru

(e) Volba konstantních parametrů

(f) Výsledná podoba nastavení v záložce Plot Information

Obr. 2.43: Průvodce vytvoření nového vyhodnocovacího grafu
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           "r2::value"

8 12 16 20 24 28 32
... "transient.sim::overshoot(v(l1:2))"

0

20

40

60

80

Obr. 2.44: Velikost překmitu napětí v závislosti na velikosti rozmítání C1 (osa Y) a R2 (osa

X)

           Time

0s 2us 4us 6us 8us 10us 12us 14us 16us 18us 20us
V1(L1)

-40V

0V

40V

80V

120V

Obr. 2.45: Výsledek transientní analýzy obvodu pro induktivní spínání s upravenými hodno-

tami součástek
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Práce s modely součástek

Tato kapitola je věnována práci s modely součástek. Některé součástky svůj vlastní model

nemají, ale je možné si takové součástky vytvořit a poté je používat dle potřeby. Značné

množství součástek svůj model v programu má, ale jejich vlastnosti neodpovídají potře-

bám uživatele. Takové součástky je možné upravit dle potřeby. Poslední možností je, kdy

potřebná součástka svůj model v programu nemá, a jeho vytvoření by bylo velice náročné,

že výrobce potřebné součástky dává k dispozici model součástky, který je možné do pro-

gramu importovat. Všechny zde zmíněné možnosti budou v následujícím textu ukázány

na konkrétních příkladech.

Předpokladem pro práci s modely součástek je znalost jazyka Spice, ve kterém jsou

všechny modely součástek vytvořeny.

3.1 Vytvoření nového modelu součástky

Program OrCad PSpice umožňuje vytvářet vlastní modely součástek. Možnosti vytvořit

model prakticky libovolné součástky jsou velice rozsáhlé, a tak bude v rámci této práce

popsán popis vytvoření jednoduchého modelu reálného kondenzátoru. Více informací tý-

kajících se vytváření nových modelů součástek je v manuálu k programu OrCAD PSPice

viz [16].

Program OrCAD PSpice obsahuje ve svých knihovnách pouze ideální modely součás-

tek. Například u kondenzátorů není uvažována indukčnost a odpor přívodů, které mají na

vlastnosti reálného kondenzátoru vliv. Proto bude ukázáno vytvoření reálného kondenzá-

toru ze změřených velikostí indukčnosti a odporu přívodů.

Náhradní schéma reálného kondenzátoru je na obr. 3.5(a), kde kromě vlastní kapacity

C je ještě sériová indukčnost přívodů Ls a sériový odpor přívodů Rs. Při vytváření vlast-

ního modelu součástky se nejprve vytvoří v libovolném textovém editoru vlastní model

součástky viz obr. 3.5(b), který se uloží s příponou .lib. Velikost kapacity bude možné

volit jako parametr, velikost indukčnosti odpovídá přibližně 5mm dlouhým kontaktům,

stejně jako velikost odporu přívodů. Všechny parametry je možné editovat při potřebě

jiných hodnot. Následuje spuštění programu Model Editor, který je součástí instalace
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programu OrCAD PSpice, a zde otevřeme File → Model Import Wizard [Capture]. . . .

Tím se spustí průvodce, kde se vytvořené součástce přiřadí schématická značka a po

dokončení průvodce se vytvoří soubor s příponou .olb, který se používá při kreslení sché-

matu. Po spuštění průvodce se otevře okno viz. 3.2(a). V tomto okně se vybere adresář,

ve kterém se nachází vytvořený model součástky s příponou .lib a zvolí se cílový ad-

resář, kam bude uložen výstupní soubor s příponou .olb. Je velice vhodné, aby se oba

soubory nacházely v jedné složce. Po vybrání obou adresářů se klikne na tlačítko Další

(Next). Otevřením dalšího okna viz obr. 3.2(b) je možné vytvořený model součástky aso-

ciovat s již existující schématickou značkou, kliknutím na tlačítko Associate Symbol se

otevře okno viz obr. 3.2(c), kde se vytvořenému modelu součástky přiřadí existující sché-

matická značka. Jelikož se jedná o kondenzátor, zvolí se schématická značka z knihovny

\tools\capture\library\pspice\analog.olb a klikne se na tlačítko Další (Next). Dále se při-
řadí porty vytvořeného modelu součástky existující schématické značce viz obr. 3.2(d).

Označení portů se definuje již při vytváření nového modelu součástky. Po přiřazení portů

se klikne na tlačítko Další (Next). Následuje poslední okno průvodce viz obr. 3.2(e), kde

se již jen potvrdí dokončení průvodce vytvoření nového modelu součástky kliknutím na

tlačítko Dokončit (Finish).

C Ls Rs

(a) Náhradní schéma reálného kondenzá-

toru

(b) Model reálného kondenzátoru

Obr. 3.1: Schéma a model reálného kondenzátoru
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(a) Úvodní okno průvodce vytvoření nového mo-

delu reálného kondenzátoru

(b) Okno průvodce pro přiřazení schématické

značky

(c) Okno průvodce s volbou vhodné schématické

značky

(d) Okno průvodce pro přiřazení portů modelu

k portům schématické značky

(e) Okno průvodce s dokončením vytvoření modelu

reálného kondenzátoru

Obr. 3.2: Průvodce vytvoření nového modelu součástky
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Po dokončení průvodce je třeba vyzkoušet funkčnost nově vytvořeného modelu. Pro

ověření funkčnosti jsou vytvořena dvě shodná zapojení, kde jednou je použit nově vytvo-

řený reálný kondenzátor a jednou kondenzátor z knihovny v programu OrCAD PSpice

viz obr. 3.3. Aby bylo možné použít reálný kondenzátor, je třeba přidat knihovnu, která

jej obsahuje, do seznamu používaných knihoven. Když je zapojení připravené, je nutné

ještě přidat parametr pro rozmítání do modelu součástky. To se provede tak, že se na

značku reálného kondenzátoru klikne pravým tlačítkem myši a zvolí se Edit Part, zobrazí

se značka reálného kondenzátoru a dvojklikem na značku se otevře okno viz obr. 3.4, kde

se vybere řádek CN a jmenovitá hodnota kapacity se nahradí {Cn} a zvolí se tlačítko
Display a volba Name and Value. Tím se tato hodnota zviditelní i u schématické značky

ve schématickém editoru pro její pozdější úpravy.

C1

{Cn}

U1

CREAL
CN = {Cn} R1

0.001
R2
0.001

V1
1Vac
0Vdc

V2
1Vac
0Vdc

0 0

out1 out2

PARAMETERS:
Cn = 2.1u

Obr. 3.3: Schéma s použitým reálným i ideálním modelem kondenzátoru

Obr. 3.4: Okno pro doplnění parametru k reálnému kondenzátoru
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K simulaci a ověření vlastností modelu reálného kondenzátoru se vytvoří AC simu-

lační profil viz obr. 3.5(a) a nastaví se globální parametr pro rozmítání hodnoty kapacity

reálného kondenzátoru viz obr. 3.5(b). Aby vytvořený model reálného kondenzátoru ve

schématu fungoval, je třeba přidat v nastavení simulačního profilu v záložce Configuration

Files knihovnu s modelem. To se provede tak, že v okně Category se zvolí položka Library

a pomocí tlačítka Browse se najde vytvořený soubor s příponou .lib a poté se klikne na

tlačítko Add to Design viz obr. 3.5(c).
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(a) Nastavení AC simulačního profilu

(b) Nastavení rozmítání velikosti kapacity relného konden-

zátoru

(c) Přidání souboru s příponou .lib do simulace

Obr. 3.5: Schéma a model reálného kondenzátoru
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Nyní stačí již jen spustit simulaci a vykreslit úroveň výstupního napětí v dB obou

obvodů. Výsledek simulace je na obr. 3.6

V grafu je velmi dobře patrné, že sériová indukčnost přívodů má vliv na chování

reálného kondenzátoru. Při vysokofrekvenčních aplikacích není možné tuto indukčnost

ignorovat a je třeba jí brát v úvahu.

           Frequency

10KHz 100KHz 1.0MHz 10MHz 100MHz 1.0GHz 10GHz
DB(V(out1)) DB(V(out2))

-120

-100

-80

-60

-40

-20

-0

Obr. 3.6: Výsledek AC analýzy modelu reálného kondenzátoru v porovnání s ideálním konden-

zátorem (úroveň výstupního napětí reálného modelu kondenzátoru (dB(V(out1)));

úroveň výstupního napětí ideálního modelu kondenzátoru (dB(V(out2))))
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3.2 Editace stávajícího modelu součástky

Možnost editace stávajících modelů součástek nabízí široké možnosti použití. Lze upra-

vovat prakticky jakýkoliv parametr součástky, která bude použita při simulacích. Sou-

částkám je možné přidávat například parametry, které jsou potřebné při rozšířených ana-

lýzách, upravovat jejich teplotní závislosti a jiné.

Editace stávající součástky bude demonstrována na jednoduchém příkladu, kdy bude

rezistoru přidán parametr s teplotní závislostí, výsledkem bude rezistor s proměnnou

závislostí odporu na teplotě. V prázdném projektu je nutné vytvořit schéma viz obr. 3.7.

Jedná se o velmi jednoduché zapojení s jedním zdrojem proudu 1A a rezistorem rbreak

z knihovny \tools\capture\library\pspice\breakout.olb. Součástky z knihovny breakout.olb
jsou určeny pro uživatelem prováděné úpravy, ale pokud se neprovedou žádné změny, mají

stejnou funkci jako součástky z knihovny analog.olb. Pokud je obvod připraven, je nutné

editovat součástku Rbreak. Editace se provede tak, že se součástka označí levým tlačítkem

myši a poté kliknutím pravým tlačítkem myši na označenou součátku se otevře nabídka

s možnostmi různých úprav součástky, zvolí se položka Edit PSpice Model. Tím se otevře

program Model Editor viz obr. 3.8(a), dopíše se parametr s teplotní závislostí TCE = 3

viz obr. 3.8(b). V okně je kromě dopsaného parametru TCE ještě .model, což značí, že se

jedná o model součástky. Text Rbreak je název součástky v knihovně, text RES udává,

že modifikovaná součástka je rezistor, R=1 je číslování součástky ve schématu, číslování

začíná od 1.

R1

Rbreak
1k

I1 1A

0

Obr. 3.7: Schéma pro určení závislosti odporu rezistoru Rbreak na teplotě

Je nutné podotknout, že pro editaci součástek je nezbytné znát parametry, které mohou

být součástkám přiřazeny a je také velice vhodné ovládat základy jazyka SPICE, kterým

jsou veškeré modely součástek zapisovány.

Teplotní závislost modelu rezistoru se řídí podle rov. 3.1.

(3.1)odpor = ⟨value⟩ ·R · 1, 01TCE·(T−Tnom)

Kde:

TCE . . . je hodnota teplotního koeficientu.

T . . . je hodnota aktuální teploty.

Tnom . . . je nominální hodnota teploty, tedy 27 ◦C.
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(a) Okno Model Editoru s neupravenou součástkou Rberak

(b) Okno Model Editoru s upravenou součástkou Rberak

Obr. 3.8: Úprava součástky Rbreak v Model Editoru

Pokud je součástka upravena, je možné ji uložit a ihned používat. Součástky se již při

prvním použití ve schématickém editoru kopírují z knihoven programu do projektu, aby

byl projekt přenositelný a upravené součástky se rovněž ukládají do projektu, v důsledku

toho nedochází k přepisování hodnot v knihovnách programu. Upravený model je platný

pouze pro aktuální projekt, to znamená, že pokud by se otevřel nový projekt a vložila

se součástka Rbreak, nebude mít žádné nestandardní vlastnosti, jako závislost odporu na

teplotě. V případě, že budou přidány ještě další stejné součástky Rbreak, přebírají všechny

další součástky upravený model. Pokud by byla vyžadována různá teplotní závislost, či

jiné vlastnosti, je nezbytné součástku uložit pod jiným názvem, tím se zabrání kopírování

vlastností mezi stejnými součástkami. Součástka se pod jiným názvem uloží tak, že v pro-

gramu Model Editor se název součástky Rbreak buď doplní o nějaký popis (bez mezery)

nebo se úplně přepíše, aby nepřejímal vlastnosti součástky se stejným názvem.

Nyní se vytvoří simulační profil pro ověření vlastností upravené součástky. Nastavení

profilu je na obr. 3.9. Zde se zvolí rozmítání teploty, jako obvodového parametru. Je

třeba ještě zkontrolovat, jestli se přidal soubor .lib v záložce Configuration Files v okně

pro vytvoření simulačního profilu viz obr. 3.10, který obsahuje právě upravený model

součástky. Soubor se přidává při úpravě součástky automaticky. Pokud by se automaticky

nepřidal, je třeba jej vyhledat ve složce s aktuálně používaným projektem, kam se soubor

s příponou .lib ukládá.
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Obr. 3.9: Nastavení simulační profilu

Obr. 3.10: Okno pro vložení knihovních souborů
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Jako poslední krok je ověření správné funkce upraveného modelu rezistoru, a proto se

spustí simulace, jejíž výsledek je na obr. 3.11. Napětí na svislé ose představuje velikost

odporu, v ohmech, rezistoru Rbreak v závislosti na teplotě.

           TEMP

0 5 10 15 20 25 30 35 40 45 50
V2(R1)

0.5KV

1.0KV

1.5KV

2.0KV

Obr. 3.11: Výsledná závislost odporu rezistoru Rbreak na teplotě
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Příklad byl převzat z [4].

3.3 Import nového modelu součástky

Modely součástek, které jsou dostupné na stránkách výrobců je možné do programu Or-

CAD PSpice importovat pomocí průvodce, který se spouští z programu Model Editor. Po-

stup importu modelu součástky bude vysvětlen na tranzistoru 2N2222AHR od společnosti

STMicroelectronics. Jedná se NPN tranzistor, napětí kolektor-emitor 40V a maximální

proud kolektoru 0.8A. Výrobce dává na svých stránkách k dispozici soubor s příponou

.lib, což je knihovní soubor. Pro použití v programu OrCAD PSpice je nutné soubor

upravit aby měl koncovku .olb a je nutné mu přidělit schématickou značku. Právě k to-

muto účelu je použit program Model Editor, který je součástí instalace OrCAD PSpice.

Spouští se v instalačním adresáři programu OrCAD PSpice. Po spuštění programu Model

Editor se zobrazí okno viz obr. 3.12. Je nutné knihovní soubor s příponou .lib před spuš-

tění průvodce ještě upravit. Otevře se dodávaný soubor v libovolném textovém editoru.

V prvním řádku se upravý název tranzistoru z 2N2222AHR na Q2N2222AHR a soubor

se uloží. Tato úprava je nutná, aby mohl být tranzistor použit při analýzách a program

nevypisoval žádné chyby.

Obr. 3.12: Základní okno programu Model Editor

Následuje přiřazení vhodné schématické značky importovanému tranzistoru a vytvo-

ření souboru s příponou .olb, která se používá při kreslení schématu. Postup přiřazení

značky a vytvoření souboru .olb je totožný jako při vytváření nového modelu součástky.

Když je vytvořený model součástky, je možné ověřit jeho funkčnost. Importovaný

tranzistor 2N2222AHR bude tedy použit v zapojení dle obr. 3.13, kde je cílem změřit

výstupní charakteristiky tohoto tranzistoru. K měření se vytvoří DC simulační profil viz

obr. 3.14(a), kde bude nastaveno rozmítání zdroje napětí kolektor-emitor. Na obr. 3.14(b)

bude jako parametr rozmítán proud báze pro vynesení několika výstupních charakteristik

tranzistoru 2N2222AHR.
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V1
3V

I1

20uA

0

Q1
Q2N2222AHR

Obr. 3.13: Schéma zapojení s importovaným tranzistorem 2N2222AHR
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(a) Nastavení DC simulačního profilu

(b) Nastavení parametru pro rozmítání proudu báze

Obr. 3.14: Měřeni výstupních charakteristik tranzistoru 2N2222AHR – DC simulační profil
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Výsledkem simulace jsou výstupní charakteristiky tranzistoru 2N2222AHR, které zná-

zorňují závislost proudu kolektoru na napětí kolektor-emitor při změně proudu báze viz

obr. 3.15.

           V_V1

0V 0.5V 1.0V 1.5V 2.0V 2.5V 3.0V 3.5V 4.0V 4.5V 5.0V
I(Q1:C)

0A

1.0mA

2.0mA

3.0mA

4.0mA

5.0mA

6.0mA

Obr. 3.15: Výstupní charakteristiky tranzistoru 2N2222AHR
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Kosimulace – spolupráce OrCAD
PSpice a Matlab Simulink

Tato kapitola je věnována dalšímu rozšiřujícímu modulu do programu OrCAD PSpice.

Tento modul se jmenuje SLPS a umožňuje propojení OrCAD PSpice s programemMatlab,

konkrétně s rozhraním Simulink. Pomocí spolupráce těchto dvou programů je možné si-

mulovat nejen elektrické obvody, ale i mechanické systémy.

Je nezbytné na začátku této kapitoly uvést, že se při zpracování této diplomové práce

nepodařilo zprovoznit spolupráci mezi programy a tak tato kapitola bude popisovat spo-

lupráci obou programů na základě manuálu a výsledky analýz provedené v prostředí

Simulink jsou převzaty rovněž z manuálu [17].

4.1 Vytvoření a simulace obvodu v OrCAD PSpice

Obvod, který je používán při kosimulaci je třeba nakreslit a odsimulovat v programu Or-

CAD PSpice. Pro účely popisu spolupráce programů OrCAD PSpice a rozhraní Simulink

je použit jednoduchý obvod složený z MOSFET tranzistoru, dvou rezistorů a dvou zdrojů

viz obr. 4.1. Po připravení obvodu je nezbytné obvod odsimulovat v programu OrCAD

PSpice. K tomuto účelu se vytvoří transientní simulační profil viz obr. 4.2. Pro simulaci

si není možné vybrat libovolný typ analýzy, ale pouze transientní analýzu, neboť Matlab

pracuje s časovými údaji.

Nyní je možné spustit analýzu připraveného obvodu. Výsledek transientní analýzy

je na obr. 4.3. Z výsledku je vidět, že v obvodu je přechodový děj, který je způsobený

parazitními kapacitami mezi přechody uvnitř MOSFET tranzistoru a cílem spolupráce

mezi OrCAD PSpice a prostředím Simulink je zobrazení právě tohoto přechodového děje.

V grafu je znázorněn i průběh napětí zdroje V1 (červený průběh), který je definován

ve schématu textem pwl(0 0 0.5u 0 0.50001u 5 1u 5 1.0001u 0). Pokud se obvod

chová dle předpokladů, je možné spustit program Matlab a konkrétně Simulink.
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RG

10

R2

500

M1

M2N6800V1

TRAN = pwl(0 0 0.5u 0 0.50001u 5 1u 5 1.0001u 0)

V2
DC = 5

0 00

OUT

Obr. 4.1: Schéma obvodu použitého při kosimulaci

Obr. 4.2: Simulační profil pro připravený obvod ke kosimulaci

           Time

0s 0.5us 1.0us 1.5us 2.0us 2.5us 3.0us
V(OUT) V(V1:+)

0V

2.0V

4.0V

6.0V

-0.5V

Obr. 4.3: Výsledek transientní analýzy připraveného obvodu
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4.2 Použití modulu SLPS v programu Matlab

Spustí se program Matlab, pro zaručení spolupráce mezi programy se doporučuje verze

programu Matlab R2007b nebo starší. Před vytvořením nového modelu je nezbytné, po-

kud tak již nebylo učiněno dříve, přidat do programu Matlab cestu do složky, kde je

nainstalovaný modul SLPS. V menu File → Set Path. . .→ Add Folder. . . se vyhledá

složka \tools\pspice\slps\ a stiskne se tlačítko Save. Tím má program Matlab a tedy i
Simulink přístup k modulu SLPS.

Pro vyvolání nabídky prvků, které je možné z knihovny SLPS vložit do Simulinku,

je potřeba do okna Command Window v programu Matlab napsat text slpslib a dojde

k otevření dvou oken, viz obr. 4.4. Nyní se otevře nový model z menu File → New. . .→
Model. Do nově otevřeného modelu se vloží prvek SLPS viz obr. 4.4(a) tak, že se na něj

klikne levým tlačítkem myši a držením se prvek přetáhne do nově otevřeného modelu.

Příkazem slpslib v Command Window se otevře ještě okno se vzorovými příklady viz

obr. 4.4(b). Dále je nutné přidat zdroj signálu a zobrazovač výsledků. Proto se z nabídky

Start v programu Matlab viz obr. 4.5(a) otevře prohlížeč knihoven rozhraní Simulink.

Z knihovny Sources se do otevřeného modelu vloží prvek Repeating Sequence viz obr.

4.5(b) a z knihovny Sinks se vloží prvek Scope viz obr. 4.5(c). Když jsou všechny tři prvky

vloženy do otevřeného modelu, stačí je jednoduše pospojovat a to tak, že se najede myší

na šipku vycházející z jednoho prvku aby se objevil křížek a kliknutím a podržením levého

tlačítka myši se přetáhne až k šipce směřující do následujícího prvku, kde se tlačítko myši

uvolní a dojde k propojení prvků v modelu. Vložením a propojením prvků v otevřeném

modelu vznikne zapojení viz obr. 4.6.

(a) Otevřené okno s prvkem SLPS

(b) Otevřené okno se vzorovými příklady použití modulu SLPS

Obr. 4.4: Otevřená okna po provedení příkazu slpslib v Command Window
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(a) Otevření knihovny prvků v Simulinku (b) Knihovna se zdroji signálu

(c) Knihovna se zobrazovači výsledků a ukončením obvodů

Obr. 4.5: Otevřená okna po provedení příkazu slpslib v Command Window
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Obr. 4.6: Hotový model ukázkového příkladu

Následuje nastavení všech potřebných údajů pro provedení simulace. Poklepáním na

prvek Repeating Sequence se otevře okno, kde se nastaví hodnoty zdroje signálu podobně

jako v OrCAD PSpice. Nastaví se hodnoty viz obr. 4.7. Dále poklepáním levým tlačítkem

myši na prvek SLPS dojde k otevření nastavení tohoto prvku, který se nastaví viz obr.

4.8. Zde se vloží Project File s příponou .opj z adresáře, kde je projekt uložen. Je výhodné

používat stejný adresář, ve kterém je uložený projekt i jako pracovní složku v programu

Matlab. Dále se otevře soubor se simulačními daty PSpice Circuit File s příponou .cir.

Musí se jednat o transientní analýzu, jinak program vypíše chybu. Jako poslední se vkládá

zdroj signálu (musí souhlasit s programem OrCAD PSpice) a výstup, kde se bude zkoumat

průběh (musí souhlasit s programem OrCAD PSpice). Vše se potvrdí tlačítkem Apply a

poté se klikne na tlačítko Ok. Je nutné nastavit ještě parametry simulace v menu Simu-

lation → Configuration Parameters. . . . Nastavení simulace se provede viz obr. 4.9. Když
je vše nastaveno, spustí se simulace z menu Simulation → Start. Výsledek simulace po-

mocí rozhraní Simulink byl převzat z manuálu k programu OrCAD PSpice a je na obr.

4.10. Při porovnání výsledku z progamu Matlab s výsledky z programu OrCAD PSpice

viz obr. 4.3 je patrné, že průběhy jsou totožné.

Obr. 4.7: Nastavení zdroje signálu
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Obr. 4.8: Nastavení prvku SLPS
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Obr. 4.9: Nastavení simulace v rozhraní Simulink

Obr. 4.10: Výsledek simulace provedené v rozhraní Simulink
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Využití rozšířených analýz programu
OrCAD PSpice

V této části práce jsou použity rozšířené typy analýz v programu OrCAD PSpice, popsané

v kapitole Rozšířené analýzy v programu OrCAD PSpice, na konkrétních zapojeních a

budou na nich demonstrovány jejich možnosti. Jako simulované obvody budou použity

gramofonové předzesilovače s kmitočtovou korekcí záznamové charakteristiky, výkonový

zesilovač pro sluchátka a jiné. Tato kapitola se nezabývá však jen rozšířenými typy analýz,

ale například i ukázkou výpočtu harmonického zkreslení nebo určením stability zesilovače

pomocí programu OrCAD PSpice. Je nutné na úvod této kapitoly zmínit, že všechny

obvody, které budou analyzovány pomocí rozšířených analýz musí být sestaveny z prvků,

které umožňují jejich použití při rozšířených analýzách, jak bylo již uvedeno v kapitole

zabývající se popisem rozšířených analýz.

5.1 Analýza gramofonového předzesilovače s kmitočto-

vou korekcí záznamové charakteristiky

Při této analýze budou analyzovány celkem čtyři gramofonové předzesilovače. Dva se zpět-

novazební kmitočtovou korekcí záznamové charakteristiky a dva s pasivní kmitočtovou

korekcí záznamové charakteristiky. Oba dva typy kmitočtové korekce budou navíc simu-

lovány s časovými konstantami pro historické (standard) a stereo gramofonové desky. Na

zesilovačích bude ukázáno použití citlivostní analýzy, optimalizace a analýzy výtěžnosti

výroby. Kromě rozšířených analýz budou určeny i vstupní a výstupní impedance a bude

provedena šumová analýza.
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5.1.1 Gramofonový předzesilovač se zpětnovazební kmitočtovou

korekcí záznamové charakteristiky pro historické gramo-

fonové desky

Tento typ gramofonového předzesilovače využívá zpětnovazební kmitočtovou korekci zá-

znamové charakteristiky. Předzesilovač je osazen kvalitními operačními zesilovači OP-27,

které se velmi často používají v audio technice. Schéma zapojení simulovaného obvodu

je na obr. 5.1. Ve schématu je v sérii se zdrojem V3 rezistor R8, který respektuje im-

pedanci přenosky, ale chybí zde ještě sériová indukčnost přenosky 450mH. Indukčnost

se negativně projevovala při výpočtu šumů. Indukčnost je ve skutečnosti součástí zdroje

signálu, ale při simulaci je indukčnost v sérii se zdrojem signálu a rezistorem a použitý al-

goritmus jí uvažuje při výpočtu jako součást předzesilovače, nikoliv zdroje. Korekční člen

složený z prvků obvodu R1, R2, C1 a C2 je nastaven tak, aby časové konstanty článku

odpovídaly časovým konstantám historických gramofonových desek. Záznamová charak-

teristika historických gramofonových desek je dána rov. 5.1 a korekční charakteristika je

určena korekčním článkem je inverzní k záznamové charakteristice a je popsána rov. 5.2.

Ve schématu je ještě tzv. rumble filtr pro potlačení podakustického pásma. Tento filtr je

připojen za druhý stupeň předzesilovače a je určen časovou konstantou 7950µs. Ve sché-

matu je tento filtr představován prvky C4 a R5, ale tento filtr není při simulacích uvažován

z důvodu snažší optimalizace přenosové funkce a použije se až při určování impedancí.

Ve schématu jsou i dva bloky modelující přenosovou funkci, které představují referenční

korekční křivku určenou jejich přenosem a na tyto bloky navazují obvody s definovaným

ziskem.

(5.1)L = 10log(1 + 4π2τ 21 f
2)− 10log

(
1 +

1
4π2τ 22 f 2

)
+ 10log

(
1 +

1
4π2τ 23 f 2

)
Kde:

L . . . je relativní úroveň hladiny záznamu [dB]

f . . . je frekvence [Hz]

τ1 . . . je časová konstanta 50µs (3183Hz)

τ2 . . . je časová konstanta 450µs (354Hz)

τ3 . . . je časová konstanta 3180µs (50Hz)

(5.2)L = 10log

(
1 +

1
4π2τ 22 f 2

)
− 10log(1 + 4π2τ 21 f 2)− 10log

(
1 +

1
4π2τ 23 f 2

)
Kde:

L . . . je relativní hodnota záznamové rychlosti [dB]

Tento gramofonový předzesilovač je navržen pro gramofonovou přenosku Ortofon OM

78. Gramofonová přenoska má výstupní napětí při 1 kHz (rychlost 5 cm/s) 4mV. Poža-

davek na předzesilovač je takový, aby na jeho výstupu při 1 kHz bylo napětí 1,25V při

rychlosti záznamu rychlost 5 cm/s. Z toho vyplývá požadavek na celkový zisk zapojení,
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Obr. 5.1: Schéma zapojení gramofonového předzesilovače se zpětnovazební kmitočtovou korekcí

záznamové charakteristiky pro historické gramofonové desky

který je dán rov. 5.3. Tento zisk je rozdělen do dvou stupňů předzesilovač s ohledem na

výpočet hodnot součástek korekčního článku. Pro výpočet zisku prvního článku se zvolí

hodnota rezistoru R3 = 100Ω a hodnota druhého rezistoru R1, který má vliv na zesílení

prvního stupně se také zvolí s ohledem na výpočet hodnot korekčního článku, R1 = 75 kΩ.

Zesílení prvního stupně je dáno rov. 5.4. Potřebného zisku celého zapojení je dosaženo

ve druhém stupni zesilovače, kde je nastaveno potřebné zesílení dle rov. 5.5. Z rov. 5.5

se dopočítá hodnota rezistoru R7 při volbě R6 = 2 kΩ dle rov. 5.6. Vypočítaná hodnota

rezistoru R7 bude později při optimalizaci nahrazena existující hodnotou.

(5.3)G =
UOUT

UIN

=
1, 25
4
= 321, 5 [−]

Kde:

UOUT . . . je napětí na výstupu zesilovače [V]

UIN . . . je napětí z přenosky [mV]

(5.4)G1 = 0, 1416

(
1 +

R1
R3

)
= 0, 1416

(
1 +
75000
100

)
= 106, 3416 [−]

Kde:

0.1416 . . . představuje zesílení korekčního článku na 1 kHz

(5.5)G2 =
G

G1
=

(
1 +

R7
R6

)
⇒ R7

R6
= G2 − 1 = 2, 938− 1 = 1, 938 [−]

(5.6)R2 = G2 ·R6 = 1, 938 · 2000 = 3, 876 kΩ
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Po vypočítání hodnot potřebných pro dosažení požadovaného zisku celého zapojení je

třeba vypočítat hodnoty korekčního článku. Výpočet se provádí pro historické gramofo-

nové desky a tedy s odpovídajícími časovými konstantami záznamové charakteristiky. Při

výpočtu kondenzátoru C2 se vychází z rov. 5.7 a zvolí se hodnota rezistoru R1 = 75 kΩ.

Dále se určí velikost rezistoru R2. Vychází se z rov. 5.8, kam se dosadí vypočtená hodnota

kondenzátoru C2 z rov. 5.7. Jako poslední se určí velikost kondenzátoru C1. Vychází se

z rov. 5.9, kam se dosadí vypočítaná hodnota rezistoru R2 z rov. 5.8

(5.7)C2R1 =
τ1τ3
τ2

⇒ C2 =
τ1τ3
τ2R1

= 4, 711 · 10−9 F

(5.8)C2R2 =
τ1τ2τ3

(τ1 − τ2)(τ2 − τ3)
⇒ R2 =

τ1τ2τ3
(τ1 − τ2)(τ2 − τ3)C2

= 13908, 295Ω

(5.9)C1R2 = τ2 ⇒ C1 =
τ2
R2
= 32, 3 · 109 F

Kde:

τ1 . . . je časová konstanta 50µs (3183Hz)

τ2 . . . je časová konstanta 450µs (354Hz)

τ3 . . . je časová konstanta 3180µs (50Hz)

Pro obvod předzesilovače je nutné ještě navrhnout tzv. rumble filtr, který omezuje

podakustické pásmo, kdy se nepříznivě projevuje hlukové pozadí pohonného mechanismu

gramofonu s kmitočty do 20Hz. Toto hlukové pozadí může dosahovat úrovně 15 - 20 dB

nad šumovým pozadím. Jedná se o RC filtr typu horní propust s fd = 18−25Hz. Hodnoty

součástek filtru se vypočítají podle rov. 5.10, kdy se opět jeden z prvků filtru volí a druhý

se dopočítá. V tomto případě byl zvolen kondenzátor C4 = 470 nF. Při použití tohoto filtru

je nezbytné použít na výstupu předzesilovače impedanční konvertor v podobě napěťového

sledovače z důvodu velkého ovlivnění výstupní impedance rumble filtrem.

(5.10)τ4 = C4R5 ⇒ R5 =
τ4
C4
= 16914, 89Ω

Kde:

τ4 . . . je časová konstanta rumble filtru 7950µs (20Hz)

Když je obvod připravený, je možné začít gramofonový předzesilovač analyzovat. Je

třeba vytvořit simulační profil viz obr. 5.2, kde se rovnou nastaví i hodnoty pro šumovou

analýzu. Nastavení pro šumovou analýzu se provede zaškrtnutím políčka Enable v části

okna pro nastavení simulačního profilu Noise Analysis a vyplněním dle obr. 5.2. Nyní se

spustí analýza a výsledek této analýzy je na obr. 5.3(a). Z výsledku je patrné, že se poda-

řilo dosáhnou téměř požadovaného průběhu. Pro lepší představu, jak přesně je dosaženo

požadovaného průběhu modulu přenosové funkce, se vykreslí rozdíl obou charakteristik

viz obr. 5.3(b). Z tohoto grafu je vidět velikost odchylky modulu přenosové funkce od
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referenčního průběhu. Na svislé ose jsou hodnoty odchylky v [mdB]. Na obr. 5.3(c) je vý-

sledek odchylky modulu přenosové funkce gramofonového předzesilovače od referenčního

průběhu po optimalizaci, která bude popsána dále.

Obr. 5.2: AC simulační profil pro gramofonový předzesilovač se zpětnovazební kmitočtovou

korekcí (historické gramofonové desky)
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           Frequency
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(a) Modul přenosové funkce gramofonového předzesilovače

           Frequency

30Hz 100Hz 300Hz 1.0KHz 3.0KHz 10KHz20Hz 20KHz
db(v(out))-db(v(ref))

-300m
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(b) Odchylka modulu přenosové funkce gramofonového předzesilovače od referenč-

ního průběhu před optimalizací

           Frequency

30Hz 100Hz 300Hz 1.0KHz 3.0KHz 10KHz20Hz 20KHz
db(v(out))-db(v(ref))

-200m

-100m

0

100m

200m

(c) Odchylka modulu přenosové funkce gramofonového předzesilovače od referenč-

ního průběhu po optimalizací

Obr. 5.3: Modul přenosové funkce gramofonového předzesilovače se zpětnovazební kmitočtovou

korekcí s odchylkou před a po optimalizaci (historické gramofonové desky)
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Odsimulovaný obvod gramofonového předzesilovače pomocí základního typu analýzy

se nyní začne simulovat pomocí rozšířených analýz. Jako první bude použita citlivostní

analýza, kde se určí, které z prvků mají největší vliv na odchylku modulu přenosové funkce

a tyto prvky budou dále předány optimalizačnímu nástroji. Spustí se tedy citlivostí ana-

lýza z menu PSpice → Advanced Analysis → Sensitivity. Je třeba definovat měřicí funkci,
na kterou se bude zjišťovat citlivost prvků v obvodě. Funkce se definuje tak, že libo-

volně v okně Specification se klikne pravým tlačítkem myši a zvolí se položka Create

New Measurement. Zobrazí se okno viz obr. 5.4 a zde se do políčka Measurement vepíše

měřicí funkce max(abs(db(v(out))-db(v(ref)))). Tato měřicí funkce hledá maximální

hodnotu odchylky modulu přenosové funkce gramofonového předzesilovače od referenční

křivky. Absolutní hodnota zajistí, že se maximální hodnota hledá i pro zápornou hodnotu

odchylky. Výsledek citlivostní analýzy je na obr. 5.5. Ve sloupcích MIN a MAX jsou hod-

noty pro tzv. nejhorší případ kombinací hodnot prvků v rámci jejich tolerancí, které jsou

nastaveny ve schématu pomocí tabulky VARIABLES, pro rezistory je RTOL% 5% a pro

kondenzátory je CTOL% 10%. Těmito tolerancemi se udává rozsah povolených hodnot

pro citlivostní analýzu. Hodnoty v těchto sloupcích jsou vzhledem k výsledku ve sloupci

Original, který udává výsledek měřicí funkce pro jmenovité hodnoty bez uvažování tole-

rancí, velice zavádějící a je nejlepší je v tomto případě brát s velkou rezervou. Z výsledků

je ihned patrné, na které prvky je definovaná měřicí funkce nejvíce citlivá. K optima-

lizaci budou tedy předány prvky R1, R2, R3, R6, R7, C1 a C2. Jedná se tedy pouze

o prvky, které jsou buď součástí korekčního článku nebo se podílejí na zesílení signálu.

Tyto prvky se vyberou Držením klávesy ctrl a postupným klikáním levým tlačítkem myši

na vybrané prvky. Poté se klikne libovolně v okně Parameters pravým tlačítkem myši a

zvolí se položka Send to Optimizer, čímž se zároveň otevře optimalizační nástroj.

Obr. 5.4: Okno pro definování požadované měřicí funkce

Při optimalizaci gramofonového prředzesilovače bude použita metoda optimalizace

pomocí cílů a omezení, neboť se podařilo velice přesně spočítat prvky korekčního článku
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Obr. 5.5: Výsledek citlivostní analýzy gramofonového předzesilovače

a není potřeba používat metodu optimalizace pomocí zachycení na křivku. Ale pokud by

tomu taky nebylo, byla by metoda optimalizace zachycením na křivku velice výhodná.

Jako první bude provedena optimalizace pomocí náhodného algoritmu (Random En-

gine), který určí počáteční nastavení hodnot pro další použitý algoritmus. Náhodný al-

goritmus se volí v horní části okna optimalizace. Před spuštěním optimalizace se definuje

měřicí funkce max(abs(db(v(out))-db(v(ref)))) stejně jako u citlivostní analýzy a do

sloupce Max se napíše hodnota maximální povolené odchylky modulu přenosové funkce

gramofonového předzesilovače od referenčního průběhu. Při citlivostní analýze byla ma-

ximální hodnota odchylky 202,0215mdB v absolutní hodnotě a při optimalizaci bude

snahou tuto odchylku ještě snížit alespoň na 150mdB v absolutní hodnotě. Tato hodnota

se napíše do sloupce Max. Nyní je možné spustit optimalizaci. Výsledek optimalizace je

na obr. 5.6(a). Nyní se zvolí MLSQ algoritmus a opět se spustí optimalizace, jejíž vý-

sledek je na obr. 5.6(b). Je vidět, že se pomocí totoho algoritmu podařilo najít takové

hodnoty součástek, že odchylka modulu přenosové funkce gramofonového předzesilovače

vyšla v absolutní hodnotě 115,3357mdB. Jako poslední bude použit diskrétní algoritmus

pro přiřazení reálně dostupných hodnot optimalizovaným prvkům obvodu. Zvolí se tedy

diskrétní algoritmus a ve sloupci Discrete Table v okně Parameters se přidělí součástkám

tabulky, ze kterých budou voleny dostupné hodnoty součástek. Pro rezistory bude použita

tabulka s 1% rezistory a pro kondenzátory jediná dostupná tabulka. Poté je možné spustit

optimaliazci pomocí diskrétního algoritmu a její výsledek je na obr. 5.6(c). Z výsledku je

patrné, že použitím dostupných hodnot se nepodařilo dosáhnout požadované hodnoty od-

chylky modulu přenosové funkce, ale i tak je odchylka v absolutní hodnotě lepší, než před

optimalizaci. Hodnoty, které optimalizační nástroj zvolil jako reálně dostupné, jsou pře-

vzaty z tabulky dostupných hodnot. Dá se předpokládat, že mnoho hodnot nebude možné
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vůbec sehnat a pro častější využití optimalizačního nástroje a konkrétně diskrétního al-

goritmu by bylo výhodné vytvořit si vlastní tabulky hodnot, například podle výrobních

řad součástek. Nyní se hodnoty určené optimalizačním nástrojem změní ve schématu a

provede se opět simulace, jejíž výsledek je na obr. 5.3(c).
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(a) Výsledek optimalizace modulu přenosové funkce gramofonového předzesilovače

pomocí náhodného algoritmu

(b) Výsledek optimalizace modulu přenosové funkce gramofonového předzesilovače

pomocí MLSQ algoritmu

(c) Výsledek optimalizace modulu přenosové funkce gramofonového předzesilovače

pomocí diskrétního algoritmu

Obr. 5.6: Optimalizace modulu přenosové funkce gramofonového předzesilovače se zpětnova-

zební kmitočtovou korekcí záznamové charakteristiky (historické gramofonové desky)
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Další rozšířená analýza, která bude použita na gramofonový předzesilovač s korekcí

záznamové charakteristiky je analýza výtěžnosti výroby (Monte Carlo). Při této ana-

lýze se bude určovat závislost velikosti odchylky modulu přenosové funkce gramofonového

předzesilovače v závislosti na výrobních tolerancích součástek. Před zahájením analýzy je

třeba upravit tolerance u kritických prvků. Kritické prvky byly určeny již při citlivostní

analýze a tak se u rezistorů R1, R2, R3, R6 a R7 změní tolerance z globálně nastavených

5% pomocí tabulky VARIABLES na 1%. Tolerance se změní tak, že se dvojklikem na

požadovanou součástku otevře okno s jejími vlastnostmi a změní se hodnota v položce

POSTOL z hodnoty RTOL% na hodnotu 1%. Tento postup se provede u všech výše

zmíněných rezistorů. Tolerance kondenzátorů zůstanou stejné, tedy 10%. Když jsou na-

staveny požadované hodnoty tolerancí, spustí se analýza výtěžnosti výroby z menu PSpice

→ Advanced Analysis → Monte Carlo. Je třeba opět vytvořit měřicí funkci, stejně jako

u předchozích dvou typů analýz a případně pozměnit základní nastavení analýzy. Toto

nastavení je v menu Edit → Profile Settings → Monte Carlo a zde je možné nastavit

počet běhů analýzy a jiné. V tomto případě se nastaví pouze počet běhů programu na 100

(Number of Runs)a počet úseků, na které se rozdělí celý interval, na kterém bude analýza

provedena na 20 úseků (Number of Bins). Nyní je možné spustit analýzu a její výsledky

jsou na obr. 5.7(a) a 5.7(b). Z obr. 5.7(a) je dobře vidět, že nejčastější velikost odchylky

modulu přenosové funkce gramofonového předzesilovače od referenčního průběhu je 550

až 600mdB a to celkem ve 12 bězích analýzy. V okně Statistical Information je ve sloupci

Mean střední hodnota odchylky ze všech běhů programu a ve sloupcích Cursor Min a

Cursor Max jsou minimální a maximální velikosti odchylky.

85



Rozšířené možnosti analýz v prostředí PSpice Lukáš Mraček 2012

(a) Histogram rozložení hustoty pravděpodobnosti odchylky modulu přenosové funkce gramofonového

předzesilovače od referenčního průběhu

(b) Kumulativní distribuční graf odchylky modulu přenosové funkce gramofonového předzesilovače od

referenčního průběhu

Obr. 5.7: Analýza výtěžnosti výroby v závislosti na velikosti odchylky modulu přenosové funkce

gramofonového předzesilovače se zpětnovazební kmitočtovou korekcí záznamové cha-

rakteristiky (historické gramofonové desky) od referenčního průběhu

86



Rozšířené možnosti analýz v prostředí PSpice Lukáš Mraček 2012

Jako další typ analýzy bude provedena šumová analýza. Tato analýza již nepatří do

rozšířených analýz, ale je velice užitečná k získání informací o šumových vlastnostech si-

mulovaného obvodu, konkrétně v tomto případě gramofonového předzesilovače se zpětno-

vazební korekcí záznamové charakteristiky. Na obr. 5.2 je simulační profil pro AC analýzu

i s nastavením pro šumovou analýzu. Pokud je tedy simulační profil nastaven, spustí se

analýza a výsledek šumové analýzy je na obr. 5.8. Výsledkem analýzy jsou celkem 4 křívky.

Graf sqrt(s(ntot(onoise))) je efektivní hodnota šumového napětí na výstupu zesilo-

vače ve zvoleném frekvenčním pásmu. Graf v(onoise) je hustota efektivní hodnoty šumo-

vého napětí na výstupu zesilovače. Graf v(inoise) je hustota efektivní hodnoty šumového

napětí přepočtená na vstup (ekvivalentní vstupní šum). Graf Noise_Figure udává ve-

likost šumového čísla celého zapojení ve zvoleném frekvenčním pásmu a je dán vzorcem

10*log10(S(v(inoise)*v(inoise))/S(1.243181738e-17)). Hodnota 1.24318738e-17

odpovídá velikosti tepelného šumu, kterým šumí rezistor R8 na vstupu zesilovače a je dán

rov. 5.11.

(5.11)
ū2Rn

R
= 4kT∆f = 1, 657 · 10−20 [W ]

Kde:

u2Rn . . . je spektrální hustota šumu rezistoru
[
V 2

Hz

]
R . . . odpor zdroje signálu, v tomto případě 750Ω

k . . . Boltzmannova konstanta 1, 38 · 10−23 J
K

T . . . teplota rezistoru v [K]

∆f . . . šířka pásma, pro kterou byl výpočet proveden, zde 1Hz

Po úpravě rovnice se získá konstanta 1, 243181738 · 10−19.
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           Frequency

30Hz 100Hz 300Hz 1.0KHz 3.0KHz 10KHz20Hz 20KHz
Noise_Figure

5.9875

5.9900

5.9925

5.9950
V(INOISE)

7.000nV

7.025nV

7.050nV
V(ONOISE)

0V

10uV

20uV
sqrt(s(ntot(onoise)))

0

100u

200u

SEL>>

Obr. 5.8: Výsledek šumové analýzy gramofonového předzesilovače se zpětnovazební kmitočto-

vou korekcí záznamové charakteristiky (historické gramofonové desky)
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Vstupní a výstupní impedance gramofonového předzesilovače je dalším ze sledova-

ných parametrů tohoto zapojení. Vstupní impedance se určuje v závislosti na velikosti

zatěžovacího rezistoru a kondenzátoru gramofonové přenosky. Ve schématu jsou tyto za-

těžovací prvky reprezentovány rezistorem R4 a kondenzátorem C3. Hodnoty obou prvků

budou rozmítány jako parametr a jejich velikosti budou odpovídat velikostem povolených

hodnot zatěžovací impedance gramofonové přenosky Ortofon OM78. Pro kondenzátor to

budou hodnoty 170 pF, 270 pF, 370 pF, 470 pF, 570 pF a pro rezistor to budou hodnoty

47 kΩ a 100 kΩ. K nastavení proměnných hodnot prvků by bylo možné použít další modul

z rozšířených analýz a to Parametric Plotter, ale tento jednoduchý příklad nevyžaduje

jeho použití. K nastavení proměnného parametru se použije součástka PARAMETERS,

kam se jako nový řádek přidá název a základní hodnota proměnného parametru, např.

Cw = 170 pF, který bude rozmítán. Poté se název proměnného parametru, který je uve-

den v součástce PARAMETERS, napíše do složených závorek jako hodnota prvku, např.

{Cw}, který bude rozmítán. Je potřeba rozmítání zapnout ještě v nastavení profilu, což se
provede dle obr. 5.9 a poté se spustí samotná AC analýza, která je již od začátku nasta-

vená. Výsledek AC analýzy s rozmítáním zatěžovací kapacity C3 je na obr. 5.10. Kromě

velikosti vstupní impedance gramofonového předzesilovače (v(in)/-i(v3) je v grafu zob-

razena i fáze vstupní impedance p((v(in)/-i(v3))), ze které jasně vyplývá, že se vzrůs-

tající frekvencí se stále více projevuje impedance kondenzátoru C3 a vstupní impedance

mění charakter z čistě reálné impedance na komplexní s kapacitní složkou. Tento výsle-

dek je proveden pro velikost zatěžovacího rezistoru 47 kΩ, pro hodnotu 100 kΩ je výsledek

totožný, jen se dle očekávání zvýší hodnota vstupní impedance ze 47 kΩ na 100 kΩ.

Obr. 5.9: Nastavení rozmítání velikosti kondenzátoru C3

Pro měření výstupní impedance je třeba umístit zdroj signálu V3 a s ním i sériový

rezistor R8 na výstup celého zapojení za rumble filtr, který bude při měření výstupní
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           Frequency

30Hz 100Hz 300Hz 1.0KHz 3.0KHz 10KHz20Hz 20KHz
v(in)/-i(v3)

0

25K

50K
p(v(in)/-i(v3))

-80d

-40d

0d

SEL>>

Obr. 5.10: Velikost vstupní impedance gramofonového předzesilovače se zpětnovazební kmi-

točtovou korekcí záznamové charakteristiky (historické gramofonové desky v závis-

losti na kmitočtu (zelený průběh C3 = 170 pF)

impedance již uvažován. Část schéma zapojení, konkrétně rumble filtr, s připojeným

zdrojem V3 a rezistorem R8 je na obr. 5.11(a) a na obr. 5.11(b) je k výstupu připo-

jen ještě napěťový sledovač jako impedanční konvertor. Nyní je možné spustit simulaci

pouze s připojeným rumble filtrem. Výsledek analýzy výstupní impedance gramofonového

předzesilovače s připojeným rumble filtrem je na obr. 5.12(a). Nyní se provede stejná si-

mulace, jen se mezi rumble filtr napěťový zdroj V3 připojí impedanční konvertor a spustí

se simulace. Výsledek této simulace je na obr. 5.12(b). Z výsledků je jasně patrný vliv im-

pedančního konvertoru. Bez připojeného impedančního konvertoru je výstupní impedance

velice závislá impedanci rumble filtru a pokud by nebyl zařazen impedanční konvertor,

tak připojením impedance by docházelo k přelaďování zlomového kmitočtu rumble filtru,

stejně jako při připojení kabelů, které mají svůj odpor a kapacitu. V grafech jsou opět

vyneseny i fáze výstupní impedance, kde je vidět, že ani výstupní impedance nemá čistě

reálný charakter, ale od vyšších kmitočtů se začíná měnit charakter výstupní impedance

na komplexní.
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0
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1Vac
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impedance s připojeným impe-
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Obr. 5.11: Schémata pro měření výstupní impedance gramofonového předzesilovače se zpět-

novazební kmitočtovou korekcí záznamové charakteristiky (historické gramofonové

desky
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           Frequency

30Hz 100Hz 300Hz 1.0KHz 3.0KHz 10KHz20Hz 20KHz
v(outhp)/-i(v3)

0

4K

8K

12K
p(v(outhp)/-i(v3))

-100d

-80d

-60d

-40d

SEL>>

(a) Průběh výstupní impedance gramofonového předzesilovače bez připojeného impedančního konvertoru

           Frequency

30Hz 100Hz 300Hz 1.0KHz 3.0KHz 10KHz20Hz 20KHz
v(outhp)/-i(v3)

0

40m

80m

120m
p(v(outhp)/-i(v3))

60d

70d

80d

90d

SEL>>

(b) Průběh výstupní impedance gramofonového předzesilovače s připojeným impedančním konvertorem

Obr. 5.12: Závislost velikosti výstupní impedance a fáze gramofonového předzesilovače se zpět-

novazební kmitočtovou korekcí záznamové charakteristiky (historické gramofonové

desky
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Schéma zapojení gramofonového předzesilovače se zpětnovazební kmitočtovou korekcí

záznamové charakteristiky viz obr. 5.1 je možné upravit přidáním tzv. DC serva. Tato

úprava je na obr. 5.13. Obvod se doplní o další operační zesilovač a několik diskrétních

součástek. Účel této úpravy je omezení stejnosměrného offsetu (posuv nulové hodnoty

výstupního průběhu), který vzniká v důsledku klidových proudů tekoucích ze vstupů ope-

račních zesilovačů v klidovém stavu. Tyto klidové proudy jsou operačním zesilovačem

zesilovány a tím se i bez připojeného vstupního napětí objevuje na výstupu operačního

zesilovače, podle typu operačního zesilovače, různě velké napětí vytvářející stejnosměrný

offset. Zapojení DC serva do zpětné vazby převádí stejnosměrné napětí z výstupu operač-

ního zesilovače na jeho vstup v opačném směru, a tím dochází k omezení stejnosměrného

offsetu. Zapojení DC serva z obr. 5.13 slouží pro potlačení stejnosměrného offsetu u nein-

vertujícího zapojení operačního zesilovače. Pro invertující zapojení operačního zesilovače

se použije schéma zapojení dle obr. 5.14. Diody D1 a D2 slouží k zamezení saturace

operačního zesilovače a je možné je vynechat.
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Obr. 5.13: Schéma zapojení gramofonového předzesilovače se zpětnovazební kmitočtovou ko-

rekcí záznamové charakteristiky (historické gramofonové desky) a připojeným DC

servem
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Obr. 5.14: Ukázka zapojení DC serva do obvodu invertujícího zapojení operačního zesilovače

Při stejnosměrné analýze zapojení gramofonového předzesilovače se zpětnovazební

kmitočtovou korekcí záznamové charakteristiky bez DC serva byl na výstupu prvního

stupně předzesilovače stejnosměrný offset -444mV a na výstupu druhého stupně před

rumble filtrem -1,314V. Po připojení DC serva klesl stejnosměrný offset na výstupu prv-

ního stupně na -448,5 nV a na výstupu druhého stupně na 38,64µV. Z výsledků je patrné

výrazné zlepšení stejnosměrných offsetů obou stupňů a použitím DC serva je možné do-

sáhnout výrazného zlepšení vlastností simulovaného obvodu.

Použitím DC serva dojde k mírnému poničení kmitočtové korekce na nízkých kmi-

točtech viz obr. 5.15, ale tato deformace nastává na podakustickém pásmu a nijak tato

deformace kmitočtové korekce neovlivní funkce celého gramofonového předzesilovače.

Přidáním stejnosměrného napětí na vstup gramofonového předzesilovače a spuštění

DC analýzy bylo zjištěno, že DC servo v tomto zapojení účinné do ±15mV vstupního
stejnosměrného napětí viz obr. 5.16. Velikost vstupního stejnosměrného napětí, které je

servo schopné kompenzovat, je velice závislé na typu použitého operačního zesilovače a

velikosti klidových proudů.
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           Frequency

1.0mHz 10mHz 100mHz 1.0Hz 10Hz
db(v(out)) db(v(ref))

0

40

80

Obr. 5.15: Deformace kmitočtové korekční charakteristiky vlivem DC serva

           V_V3

-20mV -10mV 0V 10mV 20mV
V(out)

-4.0V

-2.0V

0V

2.0V

4.0V

Obr. 5.16: Závislost potlačení stejnosměrného offsetu DC servem na velikosti stejnosměrného

napětí na vstupu operačního zesilovače
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DC servo není vždy možné umístit libovolně do obvodu, ale doporučuje se umisťovat

DC servo k operačnímu zesilovači, který má největší zisk.

Místo použití DC serva je možné mezi jednotlivé stupně vložit oddělovací kondenzátor,

který nepropustí stejnosměrnou složku signálu, ale tento způsob oddělení stupňů obvodu

není možné použít vždy, například u operačních zesilovačů FET tranzistory na vstupu.

5.1.2 Gramofonový předzesilovač se zpětnovazební kmitočtovou

korekcí záznamové charakteristiky pro stereo desky

Toto zapojení je totožné se zapojením simulovaným ve výše zmíněném příkladě s rozdílem

v nastavení kmitočtového korekčního článku, které odpovídá časovým konstantám pro

typ stereo gramofonových desek. Z tohoto důvodu bude popis simulace tohoto zapojení

velice zestručněn a budou provedeny jen simulace, u kterých se předpokládá rozdílný

výsledek než v předchozím příkladu. Bude provedena optimalizace modulu přenosové

funkce, analýza výtěžnosti výroby a šumová analýza.

Schéma analyzovaného obvodu je na obr. 5.1. Schéma se liší pouze v hodnotách prvků

korekčního článku, které musely být přepočítány pro jiné časové konstanty záznamové

charakteristiky. Opět se zvolila velikost rezistoru R1 = 75 kΩ a ostatní hodnoty se dopo-

čítaly. Velikost kondenzátoru C2 se určí dle rov. 5.12, velikost rezistoru R2 se určí podle

rov. 5.13 a velikost kondenzátoru C1 se určí podle rov. 5.14.

(5.12)C2R1 =
τ1τ3
τ2

⇒ C2 =
τ1τ3
τ2R1

= 10 · 10−9 F

(5.13)C2R2 =
τ1τ2τ3

(τ1 − τ2)(τ2 − τ3)
⇒ R2 =

τ1τ2τ3
(τ1 − τ2)(τ2 − τ3)C2

= 10905, 34979Ω

(5.14)C1R2 = τ2 ⇒ C1 =
τ2
R2
= 29, 16 · 109 F

Kde:

τ1 . . . je časová konstanta 75µs (2122Hz)

τ2 . . . je časová konstanta 318µs (500Hz)

τ3 . . . je časová konstanta 3180µs (50Hz)

K simulaci se použije totožný simulační profil, a proto když se upraví hodnoty sou-

částek R1, R2, C1 a C2 je možné spustit simulaci. Výsledek simulace je na obr. 5.17(a).

Z výsledku je patrné, že se podařilo dosáhnou téměř požadovaného průběhu. Pro lepší

představu jak přesně je dosaženo požadovaného průběhu modulu přenosové funkce se vy-

kreslí rozdíl obou charakteristik viz obr. 5.17(b). Z toho grafu je vidět velikost odchylky

modulu přenosové funkce od referenčního průběhu, na svislé ose jsou hodnoty odchylky

v [mdB]. Na obr. 5.17(c) je výsledek odchylky modulu přenosové funkce gramofonového

předzesilovače od referenčního průběhu po optimalizaci, která bude popsána dále.
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           Frequency

30Hz 100Hz 300Hz 1.0KHz 3.0KHz 10KHz20Hz 20KHz
db(V(outhp) / V(in)) db(V(refhp)/ V(in))

20

30

40

50

60

70

(a) Modul přenosové funkce gramofonového předzesilovače

           Frequency

30Hz 100Hz 300Hz 1.0KHz 3.0KHz 10KHz20Hz 20KHz
abs(db(V(out))-db(V(ref)))

50m

100m

150m

(b) Odchylka modulu přenosové funkce gramofonového předzesilovače od re-

ferenčního průběhu před optimalizací

           Frequency

30Hz 100Hz 300Hz 1.0KHz 3.0KHz 10KHz20Hz 20KHz
db(V(out))-db(V(ref))

0

100m

200m

300m

400m

500m

600m

(c) Odchylka modulu přenosové funkce gramofonového předzesilovače od refe-

renčního průběhu po optimalizací

Obr. 5.17: Modul přenosové funkce gramofonového předzesilovače se zpětnovazební kmitočto-

vou korekcí záznamové charakteristiky (stereo gramofonové desky)s odchylkou před

a po optimalizaci
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Nyní se spustí citlivostní analýza z menu PSpice → Advanced Analysis → Sensitivity.
Výsledek citlivostní analýzy je na obr. 5.18. Na základě výsledků citlivostní analýzy se

pošlou k optimalizaci prvky R1, R2, R3, R6, R7, C1 a C2, které mají na odchylku modulu

přenosové funkce největší vliv.

Obr. 5.18: Výsledek citlivostní analýzy gramofonového předzesilovače se zpětnovazební kmi-

točtovou korekcí záznamové charakteristiky (stereo gramofonové desky)

Po citlivostní analýze se spustí optimalizace. Opět se vytvoří stejná měřicí funkce

jako v předchozím příkladě a z výsledků získaných při citlivostní analýze, kdy byla ur-

čena největší odchylka modulu přenosové funkce od referenčního průběhu 142,3872mdB

se zvolí cíl optimalizace 100mdB ve sloupci Max v okně Specifications. Pokud je vše při-

pravené, je možné spustit optimalizaci pomocí náhodného algoritmu. Výsledek je na obr.

5.19(a). Dále se spustí optimalizace pomocí MLSQ algoritmu a výsledek této optimali-

zace je na obr. 5.19(b). Z výsledků této optimalizace ve sloupci Current je dobře vidět,

jak dobře se podařilo optimalizovat odchylku modulu přenosové funkce, kdy se odchylka

snížila až na 54,9995mdB v absolutní hodnotě. Následuje spuštění optimalizace pomocí

diskrétního algoritmu, kdy se hodnoty vypočtené v předchozím kroku nahradí reálně do-

stupnými hodnotami součástek. Výsledek optimalizace pomocí diskrétního algoritmu je na

obr. 5.19(c) a je vidět, že nahrazením vypočítaným hodnot součástek reálně dostupnými

hodnotami součástek došlo k relativně výraznému zhoršení odchylky modulu přenosové

funkce gramofonového předzesilovače od referenčního průběhu. Odchylka s reálně dostup-

nými hodnotami součástek má hodnotu 522,0478mdB v absolutní hodnotě, ale i tento

výsledek je možné považovat za uspokojivý.
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(a) Výsledek optimalizace modulu přenosové funkce gramofonového předzesilovače

pomocí náhodného algoritmu

(b) Výsledek optimalizace modulu přenosové funkce gramofonového předzesilovače

pomocí MLSQ algoritmu

(c) Výsledek optimalizace modulu přenosové funkce gramofonového předzesilovače

pomocí diskrétního algoritmu

Obr. 5.19: Optimalizace modulu přenosové funkce gramofonového předzesilovače se zpětnova-

zební kmitočtovou korekcí záznamové charakteristiky (stereo gramofonové desky)
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Další typ analýzy, která je použita při analýze gramofonového předzesilovače je analýza

výtěžnosti výroby. Nastavení je stejné jako v předchozím příkladu. Bude tedy sledována

závislost odchylky modulu přenosové funkce v závislosti na výrobních tolerancí. Opět se

upraví tolerance nejvíce citlivých prvků v obvodu a spustí se analýza. Její výsledky jsou

na obr. 5.20(a) a 5.20(b). Z obr. 5.20(a) je patrné, že nejčastější velikost odchylky modulu

přenosové funkce gramofonového předzesilovače od referenčního průběhu je okolo 500mdB

a to celkem v 19 bězích analýzy. V okně Statistical Information je ve sloupci Mean střední

hodnota odchylky ze všech běhů programu a ve sloupcích Cursor Min a Cursor Max jsou

minimální a maximální velikosti odchylky.
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(a) Histogram rozložení hustoty pravděpodobnosti odchylky modulu přenosové funkce gramofonového

předzesilovače od referenčního průběhu

(b) Kumulativní distribuční graf odchylky modulu přenosové funkce gramofonového předzesilovače od

referenčního průběhu

Obr. 5.20: Analýza výtěžnosti výroby v závislosti na velikosti odchylky modulu přenosové

funkce gramofonového předzesilovače se zpětnovazební kmitočtovou korekcí zázna-

mové charakteristiky (stereo gramofonové desky) od referenčního průběhu
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Jako poslední typ analýzy je provedena šumová analýza. Výsledky této analýzy jsou

na obr. 5.21. Výsledky šumové analýzy jsou téměř totožné s výsledky šumové analýzy

provedená v předchozím příkladě.

           Frequency

30Hz 100Hz 300Hz 1.0KHz 3.0KHz 10KHz20Hz 20KHz
Noise_Figure

6.0000

6.0125

6.0250

5.9800
SEL>>

v(inoise)
7.00nV

7.05nV

7.10nV
v(onoise)

0V

10uV

20uV
sqrt(s(ntot(onoise)))

0

100u

200u

Obr. 5.21: Výsledek šumové analýzy gramofonového předzesilovače se zpětnovazební kmitočto-

vou korekcí záznamové charakteristiky (stereo gramofonové desky)

Další analýzy, které byly provedeny v předchozím příkladu již provedeny nebyly.

5.1.3 Gramofonový předzesilovač s pasivní kmitočtovou korekcí

záznamové charakteristiky pro historické desky

Tento typ gramofonového předzesilovače využívá pasivní kmitočtovou korekci záznamové

charakteristiky. Předzesilovač je osazen kvalitními operačními zesilovači OP-27, které se

velmi často používají v audio technice. Schéma zapojení simulovaného obvodu je na obr.

5.22. Ve schématu je v sérii se zdrojem V3 rezistor R9, který respektuje impedanci pře-

nosky, ale chybí zde ještě sériový indukčnost přenosky 450mH. Indukčnost se negativně

projevovala při výpočtu šumů. Indukčnost je ve skutečnosti součástí zdroje signálu, ale

při simulaci je indukčnost v sérii se zdrojem signálu a rezistorem a použitý algoritmus

jí uvažuje při výpočtu jako součást předzesilovače, nikoliv zdroje. Korekční člen složený

z prvků obvodu R1, R2, C1 a C2 je nastaven na typ historických gramofonových desek.

Záznamová charakteristika historických gramofonových desek je dána rov. 5.1 a korekční

charakteristika určena korekčním článkem je inverzní k záznamové charakteristice a je

popsána rov. 5.2. Ve schématu je ještě tzv. rumble filtr pro potlačení podakustického

pásma. Tento filtr je připojen za druhý stupeň předzesilovače a je určen časovou konstan-

tou 7950µs. Ve schématu je tento filtr představován prvky C4 a R5, ale tento filtr není
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při simulacích uvažován z důvodu snažší optimalizace přenosové funkce a použije se až

při určování impedancí. Ve schématu jsou i dva bloky modelující přenosovou funkci, které

představují referenční křivku určenou jejich přenosem a na tyto bloky navazují obvody

s definovaným ziskem.

Advanced Analysis Properties
Tolerances:
RTOL = 5%
CTOL = 10%
LTOL = 0
VTOL = 0
ITOL = 0

Smoke Limits:
RMAX = 0.25
RSMAX = 0.0125
RTMAX = 200

CMAX = 50
CBMAX = 125
CSMAX = 0.005
CTMAX = 125
CIMAX = 1
LMAX = 5
DSMAX = 300
IMAX = 1
VMAX = 12

User Variables:

RVMAX = 100

ESR = 0.001
CPMAX = 0.1
CVN = 10
LPMAX = 0.25
DC = 0.1
RTH = 1
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Obr. 5.22: Schéma zapojení gramofonového předzesilovače s pasivní kmitočtovou korekcí zá-

znamové charakteristiky (historické gramofonové desky)

Tento gramofonový předzesilovač je navržen pro gramofonovou přenosku Ortofon OM

78. Gramofonová přenoska má výstupní napětí při 1 kHz (rychlost 5 cm/s) 4mV. Poža-

davkem na předzesilovač je takový, aby na jeho výstupu při 1 kHz bylo napětí 1,25V.

Z tohoto požadavku vyplývá požadavek na celkový zisk zapojení, který je dán rov. 5.15.

Tento zisk je rozdělen do dvou stupňů předzesilovače s ohledem na výpočet hodnot sou-

částek korekčního článku. Pro výpočet zisku prvního článku se zvolí hodnota rezistoru

R4 = 100Ω a hodnota druhého rezistoru R3 se také zvolí, R3 = 6,8 kΩ. Zesílení prvního

stupně je dáno rov. 5.16. Potřebného zisku celého zapojení je dosaženo ve druhém stupni

zesilovače, kde je nastaveno potřebné zesílení dle rov. 5.17. Z rov. 5.17 se dopočítá hod-

nota rezistoru R6 při volbě R7 = 100Ω dle rov. 5.18. Vypočítaná hodnota rezistoru R6

bude později při optimalizaci nahrazena existující hodnotou.

(5.15)G =
UOUT

Uin

=
1, 25
0, 004

= 312, 5 [−]

Kde:

UOUT . . . je napětí na výstupu zesilovače [V]

UIN . . . je napětí z přenosky [V]
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(5.16)G1 = 0, 1416

(
1 +

R3
R4

)
= 0, 1416

(
1 +
6800
100

)
= 9, 7704 [−]

Kde:

0.1416 . . . představuje zesílení korekčního článku na 1 kHz

(5.17)G2 =
G

G1
=

(
1 +

R6
R7

)
⇒ R6

R7
= G2 − 1 = 32, 9055− 1 = 31, 9055 [−]

(5.18)R6 = G2 ·R6 = 31, 9055 · 100 = 3190, 55 kΩ

Ve schématu je použita zaokrouhlená hodnota rezistoru R6 = 3,1 kΩ.

Po vypočítání hodnot potřebných, pro dosažení požadovaného zisku celého zapojení je

třeba vypočítat hodnoty korekčního článku. Výpočet se provádí pro historické gramofo-

nové desky a tedy s odpovídajícími časovými konstantami záznamové charakteristiky. Při

výpočtu rezistoru R2 se vychází z rov. 5.19 a zvolí se hodnota kondenzátoru C2 = 470 nF.

Dále se určí velikost kondenzátoru C1, vychází se z rov. 5.20 kam se dosadí vypočtená

hodnota rezistoru R2 z rov. 5.19. Jako poslední se určí velikost rezistoru R1. Vychází se

z rov. 5.21 kam se dosadí vypočítaná hodnota rezistoru R2 z rov. 5.8.

(5.19)C2R2 = τ2 ⇒ R2 =
τ2
C2
= 957, 45Ω

(5.20)C1R2 =
τ1τ2τ3

(τ1 − τ2)(τ2 − τ3)
⇒ C1 =

τ1τ2τ3
(τ1 − τ2)(τ2 − τ3)R2

= 68, 4 · 10−9 F

(5.21)C1R1 =
τ1τ3
τ2

⇒ R1 =
τ1τ3
τ2C1

= 5163Ω

Kde:

τ1 . . . je časová konstanta 50µs (3183Hz)

τ2 . . . je časová konstanta 450µs (354Hz)

τ3 . . . je časová konstanta 3180µs (50Hz)

Pro obvod předzesilovače je nutné ještě navrhnout tzv. rumble filtr, který omezuje

podakustické pásmo, kdy se nepříznivě projevuje hlukové pozadí pohonného mechanismu

gramofonu kolem kmitočtu 8Hz. Toto hlukové pozadí může dosahovat úrovně 15 - 20 dB.

Jedná se o RC filtr typu horní propust s fd = 18 − 25Hz. Hodnoty součástek filtru

se vypočítají podle rov. 5.22, kdy se opět jeden z prvků filtru volí a druhý se dopočítá.

V tomto případě byl zvolen kondenzátor C4 = 680 nF. Při použití tohoto filtru je nezbytné

použít na výstupu předzesilovače impedanční konvertor v podobě napěťového sledovače

z důvodu velkého ovlivnění výstupní impedance rumble filtrem.

(5.22)τ4 = C4R8 ⇒ R8 =
τ4
C4
= 11692Ω

Kde:
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τ4 . . . je časová konstanta rumble filtru 7950µs (20Hz)

Když je obvod připravený, je možné začít gramofonový předzesilovač analyzovat. Je

třeba vytvořit simulační profil viz obr. 5.23, kde se rovnou nastaví i hodnoty pro šumovou

analýzu. Nastavení pro šumovou analýzu se provede zaškrtnutím políčka Enable v části

okna pro nastavení simulačního profilu Noise Analysis a vyplněním dle obr. 5.23. Nyní

se spustí analýza a výsledek této analýzy je na obr. 5.24(a). Z výsledku je patrné, že

se podařilo dosáhnou téměř požadovaného průběhu. Pro lepší představu jak přesně je

dosaženo požadovaného průběhu modulu přenosové funkce se vykreslí rozdíl obou cha-

rakteristik viz obr. 5.24(b). Z toho grafu je vidět velikost odchylky modulu přenosové

funkce od referenčního průběhu, na svislé ose jsou hodnoty odchylky v [mdB]. Na obr.

5.24(c) je výsledek odchylky modulu přenosové funkce gramofonového předzesilovače od

referenčního průběhu po optimalizaci, která bude popsána dále.

Obr. 5.23: AC simulační profil pro gramofonový předzesilovač s pasivní kmitočtovou korekcí

záznamové charakteristiky (historické gramofonové desky)
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           Frequency

30Hz 100Hz 300Hz 1.0KHz 3.0KHz 10KHz20Hz 20KHz
db(v(out)) db(v(ref))

30
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70

(a) Modul přenosové funkce gramofonového předzesilovače

           Frequency

30Hz 100Hz 300Hz 1.0KHz 3.0KHz 10KHz20Hz 20KHz
db(v(out))-db(v(ref))

-160m

-120m

-80m

-40m

0

40m

(b) Odchylka modulu přenosové funkce gramofonového předzesilovače od re-

ferenčního průběhu před optimalizací

           Frequency

30Hz 100Hz 300Hz 1.0KHz 3.0KHz 10KHz20Hz 20KHz
db(v(out))-db(v(ref))

-50m

0

50m

100m

(c) Odchylka modulu přenosové funkce gramofonového předzesilovače od refe-

renčního průběhu po optimalizací

Obr. 5.24: Modul přenosové funkce gramofonového předzesilovače s pasivní kmitočtovou ko-

rekcí záznamové charakteristiky (historické gramofonové desky) s odchylkou před a

po optimalizaci
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Odsimulovaný obvod gramofonového předzesilovače pomocí základního typu analýzy

se nyní začne simulovat pomocí rozšířených analýz. Jako první bude použita citlivostní

analýza, kde se určí, které z prvků mají největší vliv na odchylku modulu přenosové funkce

a tyto prvky budou dále předány optimalizačnímu nástroji. Spustí se tedy citlivostní

analýza z menu PSpice → Advanced Analysis → Sensitivity. Je třeba definovat měřicí

funkci, na kterou se bude zjišťovat citlivost prvků v obvodě. Funkce se definuje tak, že

libovolně v okně Specification se klikne pravým tlačítkem myši a zvolí se položka Create

New Measurement. Zobrazí se okno viz obr. 5.25 a zde se do políčka Measurement vepíše

měřicí funkce max(abs(db(v(out))-db(v(ref)))). Tato měřicí funkce hledá maximální

hodnotu odchylky modulu přenosové funkce gramofonového předzesilovače od referenční

křivky. Absolutní hodnota zajistí, že se maximální hodnota hledá i pro zápornou hodnotu

odchylky. Výsledek citlivostní analýzy je na obr. 5.26. Ve sloupcích MIN a MAX jsou

hodnoty pro tzv. nejhorší případ kombinací hodnot prvků v rámci jejich tolerancí, které

jsou nastaveny ve schématu pomocí tabulky VARIABLES, pro rezistory je RTOL% 5%

a pro kondenzátory je CTOL% 10%. Těmito tolerancemi se udává rozsah povolených

hodnot pro citlivostní analýzu. Hodnoty v těchto sloupcích jsou vzhledem k výsledku ve

sloupci Original, který udává výsledek měřicí funkce pro jmenovité hodnoty bez uvažování

tolerancí, velice zavádějící a je nejlepší v tomto případě brát s velkou rezervou. Z výsledků

je ihned patrné, na které prvky je definovaná měřicí funkce nejvíce citlivá. K optimalizaci

budou tedy předány prvky R1, R2, R3, R4, R6, R7, C1 a C2. Jedná se tedy pouze o prvky,

které jsou buď součástí korekčního článku nebo se podílejí na zesílení signálu. Tyto prvky

se vyberou Držením klávesy ctrl a postupným klikáním levým tlačítkem myši na vybrané

prvky. Poté se klikne libovolně v okně Parameters pravým tlačítkem myši a zvolí se

položka Send to Optimizer, čímž se zároveň otevře optimalizační nástroj.

Obr. 5.25: Okno pro definování požadované měřicí funkce

Při optimalizaci gramofonového předzesilovače bude použita metoda optimalizace po-

mocí cílů a omezení, neboť se podařilo velice přesně spočítat prvky korekčního článku a
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Obr. 5.26: Výsledek citlivostní analýzy gramofonového předzesilovače s pasivní kmitočtovou

korekcí záznamové charakteristiky (historické gramofonové desky)

není potřeba používat metodu optimalizace pomocí zachycení na křivku. Ale pokud by

tomu taky nebylo, byla by metoda optimalizace zachycením na křivku velice výhodná.

Jako první bude provedena optimalizace pomocí náhodného algoritmu (Random En-

gine), který určí počáteční nastavení hodnot pro další použitý algoritmus. Náhodný al-

goritmus se volí v horní části okna optimalizace. Před spuštěním optimalizace se definuje

stejná měřicí funkce jako u citlivostní analýzy, funkce max(abs(db(v(out))-db(v(ref))))

a do sloupce Max se napíše hodnota maximální povolené odchylky modulu přenosové

funkce gramofonového předzesilovače od referenčního průběhu. Při citlivostní analýze byla

maximální hodnota odchylky 154,8294mdB v absolutní hodnotě a při optimalizaci bude

snahou tuto odchylku ještě snížit a konkrétně alespoň na 100mdB v absolutní hodnotě,

tato hodnota se napíše do sloupce Max. Nyní je možné spustit optimalizaci. Výsledek op-

timalizace je na obr. 5.27(a). Nyní se zvolí MLSQ algoritmus a opět se spustí optimalizace

jejíž výsledek je na obr. 5.27(b). Je vidět, že se pomocí tohoto algoritmu podařilo najít

takové hodnoty součástek, kdy odchylka modulu přenosové funkce gramofonového před-

zesilovače vyšla v absolutní hodnotě 82,4203mdB. Jako poslední bude použit diskrétní al-

goritmus pro přiřazení reálně dostupných hodnot optimalizovaným prvkům obvodu. Zvolí

se tedy diskrétní algoritmus a ve sloupci Discrete Table v okně Parameters se přidělí

součástkám tabulky, ze kterých budou voleny dostupné hodnoty součástek. Pro rezistory

bude použita tabulka s 1% rezistory a pro kondenzátory jediná dostupná tabulka. Poté je

možné spustit optimalizaci pomocí diskrétního algoritmu a její výsledek je na obr. 5.27(c).

Z výsledku je patrné, že použitím dostupných hodnot se podařilo dosáhnout ještě hodnoty

odchylky modulu přenosové funkce než byl požadavek, přesně 97,5456mdB v absolutní

hodnotě. Hodnoty, které optimalizační nástroj zvolil jako reálně dostupné jsou převzaty

z tabulky dostupných hodnot. Dá se předpokládat, že mnoho hodnot nebude možné vůbec
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sehnat a pro častější využití optimalizačního nástroje a konkrétně diskrétního algoritmu

by bylo výhodné vytvořit si vlastní tabulky hodnot, například podle výrobních řad sou-

částek. Nyní se hodnoty určené optimalizačním nástrojem změní ve schématu a provede

se opět simulace, jejíž výsledek je na obr. 5.24(c).
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(a) Výsledek optimalizace modulu přenosové funkce gramofonového předzesilovače

pomocí náhodného algoritmu

(b) Výsledek optimalizace modulu přenosové funkce gramofonového předzesilovače

pomocí MLSQ algoritmu

(c) Výsledek optimalizace modulu přenosové funkce gramofonového předzesilovače

pomocí diskrétního algoritmu

Obr. 5.27: Optimalizace modulu přenosové funkce gramofonového předzesilovače s pasivní kmi-

točtovou korekcí záznamové charakteristiky (historické gramofonové desky)
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Další rozšířená analýza, která bude použita na gramofonový předzesilovač s kmitočto-

vou korekcí záznamové charakteristiky je analýza výtěžnosti výroby (Monte Carlo). Při

této analýze se bude určovat závislost velikosti odchylky modulu přenosové funkce gramo-

fonového předzesilovače v závislosti na výrobních tolerancích součástek. Před zahájením

analýzy je třeba upravit tolerance u kritických prvků. Kritické prvky byly určeny již při

citlivostní analýze a tak se u rezistorů R1, R2, R3, R4, R6 a R7 změní tolerance z glo-

bálně nastavených 5% pomocí tabulky VARIABLES na 1%. Tolerance se změní tak, že

se dvojklikem na požadovanou součástku otevře okno s jejími vlastnostmi a změní se

hodnota v položce POSTOL z hodnoty RTOL% na hodnotu 1%. Tento postup se pro-

vede u všech výše zmíněných rezistorů. Tolerance kondenzátorů zůstanou stejné, tedy

10%. Když jsou nastaveny požadované hodnoty tolerancí, spustí se analýza výtěžnosti

výroby z menu PSpice → Advanced Analysis → Monte Carlo. Je třeba opět vytvořit

měřicí funkci, stejně jako u předchozích dvou typů analýz a případně pozměnit základní

nastavení analýzy. Toto nastavení je v menu Edit → Profile Settings → Monte Carlo a

zde je možné nastavit počet běhů analýzy a jiné. V tomto případě se nastaví pouze počet

běhů programu na 100 (Number of Runs) a počet úseků, na které se rozdělí celý interval,

na kterém bude analýza provedena na 20 úseků (Number of Bins). Nyní je možné spustit

analýzu a její výsledky jsou na obr. 5.28(a) a 5.28(b). Z obr. 5.28(a) je dobře vidět, že

nejčastější velikost odchylky modulu přenosové funkce gramofonového předzesilovače od

referenčního průběhu je 300 až 370mdB a to celkem ve 12 bězích analýzy. V okně Statis-

tical Information je ve sloupci Mean střední hodnota odchylky ze všech běhů programu

a ve sloupcích Cursor Min a Cursor Max jsou minimální a maximální velikosti odchylky.
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(a) Histogram rozložení hustoty pravděpodobnosti odchylky modulu přenosové funkce gramofonového

předzesilovače od referenčního průběhu

(b) Kumulativní distribuční graf odchylky modulu přenosové funkce gramofonového předzesilovače od

referenčního průběhu

Obr. 5.28: Analýza výtěžnosti výroby v závislosti na velikosti odchylky modulu přenosové

funkce gramofonového předzesilovače s pasivní kmitočtovou korekcí záznamové cha-

rakteristiky (historické gramofonové desky) od referenčního průběhu
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Jako další typ analýzy bude provedena šumová analýza. Tato analýza již nepatří do

rozšířených analýz, ale je velice užitečná pro získání informací o šumových vlastnostech

simulovaného obvodu. Konkrétně v tomto případě gramofonového předzesilovače se zpět-

novazební kmitočtovou korekcí záznamové charakteristiky. Na obr. 5.23 je simulační profil

pro AC analýzu i s nastavením pro šumovou analýzu. Pokud je tedy simulační profil na-

staven, spustí se analýza a výsledek šumové analýzy je na obr. 5.29. Výsledkem analýzy

jsou celkem 4 křivky. Graf sqrt(s(ntot(onoise))) je efektivní hodnota šumového napětí

na výstupu zesilovače ve zvoleném frekvenčním pásmu. Graf v(onoise) je hustota efek-

tivní hodnoty šumového napětí na výstupu zesilovače. Graf v(inoise) je hustota efek-

tivní hodnoty šumového napětí přepočtená na vstup (ekvivalentní vstupní šum). Graf

Noise_Figure udává velikost šumového čísla celého zapojení ve zvoleném frekvenčním

pásmu a je dána vzorcem 10*log10(S(v(inoise)*v(inoise))/S(1.243181738e-17)).

Hodnota 1.24318738e-17 odpovídá velikosti tepelného šumu, kterým šumí rezistor R9

na vstupu zesilovače a je dán rov. 5.23.

(5.23)
ū2Rn

R
= 4kT∆f = 1, 657 · 10−20 [W ]

Kde:

u2Rn . . . je spektrální hustota šumu rezistoru
[
V 2

Hz

]
R . . . odpor zdroje signálu, v tomto případě 750Ω

k . . . Boltzmannova konstanta 1, 38 · 10−23 J
K

T . . . teplota rezistoru v [K]

∆f . . . šířka pásma, pro kterou byl výpočet proveden, zde 1Hz

Pokud se R převede na druhou stranu rovnice, vyjde ona konstanta 1, 243181738·10−19.
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Obr. 5.29: Výsledek šumové analýzy gramofonového předzesilovače s pasivní kmitočtovou ko-

rekcí záznamové charakteristiky (historické gramofonové desky)
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Vstupní a výstupní impedance gramofonového předzesilovače je dalším ze sledovaných

parametrů tohoto zapojení. Vstupní impedance se určuje v závislosti na velikosti zatěžo-

vacího rezistoru a kondenzátoru gramofonové přenosky. Ve schématu jsou tyto zatěžovací

prvky reprezentovány rezistorem R5 a kondenzátorem C3. Hodnoty obou prvků budou

rozmítány jako parametr a jejich velikosti budou odpovídat velikostem povolených hodnot

zatěžovací impedance gramofonové přenosky Ortofon OM78. Pro kondenzátor to budou

hodnoty 170 pF, 270 pF, 370 pF, 470 pF, 570 pF a pro rezistor to budou hodnoty 47 kΩ a

100 kΩ. K nastavení proměnných hodnot prvků by bylo možné použít další modul z rozšíře-

ných analýz a to Parametric Plotter, ale tento jednoduchý příklad nevyžaduje jeho použití.

K nastavení proměnného parametru se použije součástka PARAMETERS, kam se jako

nový řádek přidá název a základní hodnota proměnného parametru, např. Cw = 170 pF,

který bude rozmítán. Poté se název proměnného parametru, který je uveden v součástce

PARAMETERS, napíše do složených závorek jako hodnota prvku, např. {Cw}, který
bude rozmítán. Je potřeba rozmítání zapnout ještě v nastavení profilu, což se provede dle

obr. 5.30 a poté se spustí samotná AC analýza, která je již od začátku nastavená. Vý-

sledek AC analýzy s rozmítáním zatěžovací kapacity C3 je na obr. 5.31. Kromě velikosti

vstupní impedance gramofonového předzesilovače (v(in)/-i(v3) je v grafu zobrazena

i fáze vstupní impedance p((v(in)/-i(v3))), ze které jasně vyplývá, že se vzrůstající

frekvencí se stále více projevuje impedance kondenzátoru C3 a vstupní impedance mění

charakter z čistě reálné impedance na komplexní s kapacitní složkou. Tento výsledek je

proveden pro velikost zatěžovacího rezistoru R9 = 47 kΩ, pro hodnotu 100 kΩ je výsledek

totožný, jen se dle očekávání zvýší hodnota vstupní impedance ze 47 kΩ na 100 kΩ.

Obr. 5.30: Nastavení rozmítání velikosti kondenzátoru C3
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           Frequency

30Hz 100Hz 300Hz 1.0KHz 3.0KHz 10KHz20Hz 20KHz
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Obr. 5.31: Velikost vstupní impedance gramofonového předzesilovače s pasivní kmitočtovou

korekcí záznamové charakteristiky (historické gramofonové desky) v závislosti na

kmitočtu (zelený průběh C3 = 170 pF)
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Pro měření výstupní impedance je třeba umístit zdroj signálu V3 a s ním i sériový

rezistor R9 na výstup celého zapojení za rumble filtr, který bude při měření výstupní im-

pedance již uvažován. Část schéma zapojení, konkrétně rumble filtr, s připojeným zdrojem

V3 a rezistorem R9 je na obr. 5.32(a) a na obr. 5.32(b) je k výstupu připojen ještě napěťový

sledovač jako impedanční konvertor. Nyní je možné spustit simulaci pouze s připojeným

rumble filtrem. Výsledek analýzy výstupní impedance gramofonového předzesilovače s při-

pojeným rumble filtrem je na obr. 5.33(a). Nyní se provede stejná simulace, jen se mezi

rumble filtr a napěťový zdroj připojí impedanční konvertor a spustí se simulace, výsledek

simulace je na obr. 5.33(b). Z výsledků je jasně patrný vliv impedančního konvertoru.

Bez připojeného impedančního konvertoru je výstupní impedance závislá na impedanci

rumble filtru a pokud by nebyl zařazen impedanční konvertor, byl by nadměrně výkonově

zatěžován celý gramofonový předzesilovač. V grafech jsou opět vyneseny i fáze výstupní

impedance, kde je vidět, že ani výstupní impedance nemá čistě reálný charakter, ale od

vyšších kmitočtů se začíná měnit charakter výstupní impedance na komplexní.
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(b) Schéma pro měření výstupní

impedance s připojeným impe-

dančním konvertorem

Obr. 5.32: Schémata pro měření výstupní impedance gramofonového předzesilovače s pasivní

kmitočtovou korekcí záznamové charakteristiky (historické gramofonové desky)
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           Frequency
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(a) Průběh výstupní impedance gramofonového předzesilovače bez připojeného impedančního konvertoru

           Frequency
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(b) Průběh výstupní impedance gramofonového předzesilovače s připojeným impedančním konvertorem

Obr. 5.33: Závislost velikosti výstupní impedance a fáze gramofonového předzesilovače s pa-

sivní kmitočtovou korekcí záznamové charakteristiky (historické gramofonové desky)
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Zapojení gramofonového předzesilovače s pasivní korekcí záznamové charakteristiky je

možné také upravit použitím DC serva a zlepšit tím stejnosměrné offsety, ale v rámci této

práce tak učiněno nebylo. V tomto zapojení by se DC servo umístilo až k druhému stupni

předzesilovače, neboť druhý stupeň má větší zisk a dá se tedy předpokládat i větší zesílení

klidových proudů a tím pádem větší stejnosměrný offset na výstupu druhého stupně.

5.1.4 Gramofonový předzesilovač s pasivní kmitočtovou korekcí

záznamové charakteristiky pro stereo gramofonové desky

Toto zapojení je totožné se zapojením simulovaným ve výše zmíněném příkladě s rozdílem

v nastavení korekčního článku, který bude nastaven na jiný typ gramofonových desek,

tedy pro stereo gramofonové desky. Z tohoto důvodu bude popis simulace tohoto zapojení

velice zestručněn a budou provedeny jen simulace, u kterých se předpokládá rozdílný

výsledek než v předchozím příkladu. Bude provedena optimalizace modulu přenosové

funkce, analýza výtěžnosti výroby a šumová analýza.

Schéma analyzovaného obvodu je na obr. 5.22. Schéma se liší pouze v hodnotách prvků

korekčního článku, které musely být přepočítány pro jiné časové konstanty záznamové

charakteristiky. Opět se zvolila velikost kondenzátoru C2 = 68 nF a ostatní hodnoty se

dopočítaly. Velikost rezistoru R2 se určí dle rov. 5.24, velikost kondenzátoru C1 se určí

podle rov. 5.25 a velikost rezistoru R1 se určí podle rov. 5.26.

(5.24)C2R2 = τ2 ⇒ R2 =
τ2
C2
= 1603, 6765Ω

(5.25)C1R2 =
τ1τ2τ3

(τ1 − τ2)(τ2 − τ3)
⇒ C1 =

τ1τ2τ3
(τ1 − τ2)(τ2 − τ3)R2

= 198, 29 · 10−9 F

(5.26)C1R1 =
τ1τ3
τ2

⇒ R1 =
τ1τ3
τ2C1

= 11029, 412Ω

Kde:

τ1 . . . je časová konstanta 75µs (2122Hz)

τ2 . . . je časová konstanta 318µs (500Hz)

τ3 . . . je časová konstanta 3180µs (50Hz)

K simulaci se použije totožný simulační profil a proto když se upraví hodnoty sou-

částek R1, R2, C1 a C2 je možné spustit simulaci. Výsledek simulace je na obr. 5.34(a).

Z výsledku je patrné, že se podařilo dosáhnou téměř požadovaného průběhu. Pro lepší

představu jak přesně je dosaženo požadovaného průběhu modulu přenosové funkce se vy-

kreslí rozdíl obou charakteristik viz obr. 5.34(b). Z tohoto grafu je vidět velikost odchylky

modulu přenosové funkce od referenčního průběhu, na svislé ose jsou hodnoty odchylky

v [mdB]. Na obr. 5.34(c) je výsledek odchylky modulu přenosové funkce gramofonového

předzesilovače od referenčního průběhu po optimalizaci, která bude popsána dále.
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           Frequency
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(a) Modul přenosové funkce gramofonového předzesilovače

           Frequency
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(b) Odchylka modulu přenosové funkce gramofonového předzesilovače od

referenčního průběhu před optimalizací

           Frequency
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(c) Odchylka modulu přenosové funkce gramofonového předzesilovače od re-

ferenčního průběhu po optimalizací

Obr. 5.34: Modul přenosové funkce gramofonového předzesilovače s pasivní kmitočtovou ko-

rekcí záznamové charakteristiky (stereo gramofonové desky) s odchylkou před a po

optimalizaci
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Nyní se spustí citlivostní analýza z menu PSpice → Advanced Analysis → Sensitivity.
Výsledek citlivostní analýzy je na obr. 5.35. Na základě výsledků citlivostní analýzy se

pošlou k optimalizaci prvky R1, R2, R3, R4, R6, R7, C1 a C2, které mají na odchylku

modulu přenosové funkce největší vliv.

Obr. 5.35: Výsledek citlivostní analýzy gramofonového předzesilovače s pasivní kmitočtovou

korekcí záznamové charakteristiky (stereo gramofonové desky)

Po citlivostní analýze se spustí optimalizace. Opět se vytvoří stejná měřicí funkce jako

v předchozím příkladě a z výsledků získaných při citlivostní analýze, kdy byla určena nej-

větší odchylka modulu přenosové funkce od referenčního průběhu 154,6903mdB se zvolí

cíl optimalizace 100mdB ve sloupci Max v okně Specifications. Pokud je vše připravené,

je možné spustit optimalizaci pomocí náhodného algoritmu. Výsledek je na obr. 5.36(a).

Dále se spustí optimalizace pomocí MLSQ algoritmu a výsledek této optimalizace je na

obr. 5.36(b). Z výsledků této optimalizace ve sloupci Current je dobře vidět, jak dobře

se podařilo optimalizovat odchylku modulu přenosové funkce, kdy se odchylka snížila až

na 90,0041mdB v absolutní hodnotě. Následuje spuštění optimalizace pomocí diskrétního

algoritmu, kdy se hodnoty vypočtené v předchozím kroku nahradí reálně dostupnými hod-

notami součástek. Výsledek optimalizace pomocí diskrétního algoritmu je na obr. 5.19(c)

a je vidět, že nahrazením vypočítaných hodnot součástek reálně dostupnými hodnotami

součástek došlo k relativně výraznému zhoršení odchylky modulu přenosové funkce gra-

mofonového předzesilovače od referenčního průběhu. Odchylka s reálně dostupnými hod-

notami součástek má hodnotu 525,5377mdB v absolutní hodnotě, ale i tento výsledek je

možné považovat za uspokojivý.
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(a) Výsledek optimalizace modulu přenosové funkce gramofonového předzesilovače

pomocí náhodného algoritmu

(b) Výsledek optimalizace modulu přenosové funkce gramofonového předzesilovače

pomocí MLSQ algoritmu

(c) Výsledek optimalizace modulu přenosové funkce gramofonového předzesilovače

pomocí diskrétního algoritmu

Obr. 5.36: Optimalizace modulu přenosové funkce gramofonového předzesilovače s pasivní kmi-

točtovou korekcí záznamové charakteristiky (stereo gramofonové desky)
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Další typ analýzy, která je použita při analýze gramofonového předzesilovače je analýza

výtěžnosti výroby. Nastavení je stejné jako v předchozím příkladu. Bude tedy sledována

závislost odchylky modulu přenosové funkce v závislosti na výrobních tolerancích. Opět se

upraví tolerance nejvíce citlivých prvků v obvodu a spustí se analýza a její výsledky jsou

na obr. 5.37(a) a 5.37(b). Z obr. 5.37(a) je dobře vidět, že nejčastější velikost odchylky

modulu přenosové funkce gramofonového předzesilovače od referenčního průběhu je okolo

500mdB a to celkem ve 28 bězích analýzy. V okně Statistical Information je ve sloupci

Mean střední hodnota odchylky ze všech běhů programu a ve sloupcích Cursor Min a

Cursor Max jsou minimální a maximální velikosti odchylky.
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(a) Histogram rozložení hustoty pravděpodobnosti odchylky modulu přenosové funkce gramofonového

předzesilovače od referenčního průběhu

(b) Kumulativní distribuční graf odchylky modulu přenosové funkce gramofonového předzesilovače od

referenčního průběhu

Obr. 5.37: Analýza výtěžnosti výroby v závislosti na velikosti odchylky modulu přenosové

funkce gramofonového předzesilovače s pasivní kmitočtovou korekcí záznamové cha-

rakteristiky (stereo gramofonové desky) od referenčního průběhu
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Jako poslední typ analýzy je provedena šumová analýza. Výsledky této analýzy jsou

na obr. 5.38. Výsledky šumové analýzy jsou téměř totožné s výsledky šumové analýzy

provedené v předchozím příkladě.
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Obr. 5.38: Výsledek šumové analýzy gramofonového předzesilovače s pasivní kmitočtovou ko-

rekcí záznamové charakteristiky (stereo gramofonové desky)

Další analýzy, které byly provedeny v předchozím příkladu již provedeny nebyly.

5.1.5 Výkonový zesilovač pro sluchátka

Na zapojení výkonového zesilovače pro sluchátka viz obr. 5.39 bude demonstrováno po-

užití analýzy k určení namáhání součástek a bude použit nástroj k určení harmonického

zkreslení.

Konfigurace tohoto zesilovače je navržena pro zátěže do maximálně 150Ω a výstupní

výkon 300mW při výstupním napětí ±10V a maximálním výstupním proudu 100mA,
který je omezený diodami D2 a D3. Zisk tohoto zesilovače je dán rov. 5.27. Při simulaci

tohoto zapojení bude použita analýza namáhání součástek patřící mezi rozšířené typy

analýz. Bude zkoumáno namáhání prvků obvodu v závislosti na velikosti budícího na-

pětí a velikosti zátěže. Při analýze namáhání součástek bude použit nástroj, pro určení

harmonického zkreslení, který je standardně obsažen v programu OrCAD PSpice.

(5.27)G =
UOUT

UIN

=
10
0, 430

= 23 [−]

Kde:

UOUT . . . je napětí na výstupu zesilovače [V]
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LEVEL = 3
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PARAMETERS:
P = 0.5

0

V4
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VAMPL = 300m
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AC =

0

Obr. 5.39: Schéma zapojení výkonového zesilovače pro sluchátka |Převzato z [22]|

UIN . . . je napětí na vstupu zesilovače [V]

K simulaci je nutné vytvořit transientní simulační profil pro provedení analýzy namá-

hání součástek viz obr. 5.40(a). Velikost maximálního kroku transientní analýzy (Maxim

step size)je třeba volit s rozvahou, neboť příliš malý krok vede k velké výpočetní náročnosti

a příliš velký krok vede na velkou nepřesnost analýzy. K provedení analýzy harmonického

zkreslení je nutné provést nastavení v simulačním profilu nastavení. V okně simulačního

profilu se klikne na tlačítko Output File Options a zobrazí se okno viz obr. 5.40(b), kde

je nutné nastavit centrální kmitočet (Center Frequency). Ten musí odpovídat kmitočtu

zdroje signálu. Dále se nastaví počet harmonických složek (Number of Harmonics), které

budou uvažovány při výpočtu celkového harmonického zkreslení. Jako poslední se určí

napětí v místě obvodu, kde má být harmonické zkreslení určeno (Output Variables).
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(a) AC simulační profil

(b) Nastavení simulačního profilu pro určení harmonického zkreslení

Obr. 5.40: Nastavení simulačního profilu pro výkonový zesilovač pro sluchátka
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Obvod, který bude simulován v prvním kroku je nastaven dle obr. 5.39. Tedy vstupní

napětí 300mV, kmitočet vstupního napětí 10 kHz, potenciometr ve střední poloze, tedy

0,5 a zátěž o velikosti 100Ω. Výsledek AC analýzy je na obr. 5.41(a). Na výstupu zesi-

lovače je napětí ±3,43V a průběh má nezkreslený sinusový tvar. K určení, jak moc je
průběh výstupního napětí zkreslený bude použita analýza harmonického zkreslení. Nej-

prve je možné provést rychlou Fourierovu transformaci, dále jen FFT, v okně s grafickým

výstupem analýzy. FFT se spustí z menu Trace → Fourier a zobrazí se výsledek FFT

přímo v grafu viz obr. 5.41(b). V grafu FFT je zapnuté zobrazení osy Y v logaritmickém

měřítku. Z výsledků FFT je patrné, že nedochází k žádnému harmonickému zkreslení. Vý-

sledek harmonického zkreslení se nezobrazuje v grafické podobě, ale v tzv. Output File, kde

jsou veškeré výsledky analýzy zobrazeny v textové podobě. Output File je možné otevřít

z menu View → Output File. Výsledek analýzy harmonického zkreslení je na obr. 5.41(c).
Z výsledků je možné vyčíst několik informací, například velikost stejnosměrné složky (DC

COMPONENT ), kmitočty jednotlivých harmonických složek (FREQUENCY ) a další.

Ale hlavní informací je velikost celkového harmonického zkreslení (TOTAL HARMONIC

DISTORTION ), které má pro toto měření velikost 1, 159 · 10−3%.
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           Time

0s 0.5ms 1.0ms 1.5ms 2.0ms
V(out)

-4.0V

0V

4.0V

(a) Výsledek transientní analýzy výkonového zesilovače pro sluchátka

           Frequency

0Hz 10KHz 20KHz 30KHz 40KHz 50KHz
V(out)

1.0mV

1.0V

10uV

10V

(b) FFT výstupního napětí výkonového zesilovače pro sluchátka

(c) Výsledek určení celkového harmonického zkreslení výkonového zesilovače pro

sluchátka

Obr. 5.41: Výsledky analýzy harmonického zkreslení výkonového zesilovače pro sluchátka
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Následuje provedení analýzy namáhání součástek. Před spuštěním analýzy je třeba

nastavit větší povolený výkon rezistorů, neboť standardní výkonová ztráta rezistorů je

250mW, ale pro tento případ byla povolená výkonová ztráta zvýšena na 1W. Toto se

provede pro rezistory R5, R6, R7 a Rload. Změna výkonové ztráty se provede dvojklikem

na požadovanou součástku a do položky POWER se napíše požadovaná hodnota bez

jednotky. Toto nastavení by bylo možné provést i pomocí zatěžovacího faktoru v nastavení

analýzy namáhání součástek, ale pro tento případ bylo jednodušší upravit hodnotu přímo

u součástek. Analýzy se spustí z menu PSpice → Advanced Analysis → Smoke. Výsledek
analýzy je na obr. 5.42. Z výsledků je patrné, že nejvíce namáhanými prvky v obvodu jsou

výstupní tranzistory Q1 a Q2, ale v této konfiguraci a nastavení hodnot v obvodu pracuje

zapojení v bezpečných podmínkách pro všechny obvodové prvky. Význam jednotlivých

parametrů, které jsou při analýzy pro jednotlivé prvku určovány je v příloze A.2.

Obr. 5.42: Výsledek analýzy namáhání součástek pro výkonový zesilovače pro sluchátka při

standardním provozu

K tomu, aby bylo názorně demonstrováno využití analýzy namáhání součástek a ur-

čení harmonického zkreslení bude obvod uveden do nestandardních pracovních podmínek.

Vstupní napětí se zvýší na 600mV, kmitočet vstupního napětí zůstane zachován 10 kHz,

potenciometr bude nastaven na 0,1, maximální výstupní napětí a jako zátěž bude připojen

rezistor o velikosti 500Ω, . Za takto nastavených podmínek se spustí analýza. Výsledek

analýzy je na obr. 5.43(a) a je možné vidět, že výstupní napětí je již omezené v kladných

půlvlnách a je možné očekávat, že harmonické zkreslení bude již mnohem větší než při

předchozím nastavení obvodu. Opět se zapne FFT a výsledek je na obr. 5.43(b), kde je

velmi dobře patrné, že se ve výstupním signálu neobjevuje již jen základní harmonické, ale

i další nežádoucí kmitočty, které značně ovlivňují velikost celkového harmonického zkres-

lení. Výsledek celkového harmonického zkreslení je na obr. 5.43(c). Celkové harmonické

zkreslení je v tomto případě 4,45%.
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           Time

0s 0.5ms 1.0ms 1.5ms 2.0ms
V(out)

-10V

0V

10V

(a) Výsledek transientní analýzy výkonového zesilovače pro sluchátka

           Frequency

0Hz 10KHz 20KHz 30KHz 40KHz 50KHz 60KHz
V(out)

1.0mV

1.0V

100uV

15V

(b) FFT výstupního napětí výkonového zesilovače pro sluchátka

(c) Výsledek určení celkového harmonického zkreslení výkonového zesilovače pro

sluchátka

Obr. 5.43: Výsledky analýzy harmonického zkreslení výkonového zesilovače pro sluchátka
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Nyní se spustí analýza namáhání součástek pro nově nastavené pracovní podmínky

výkonového zesilovače pro sluchátka. Výsledek analýzy je na obr. 5.44. Z výsledku je

patrné, že pro tyto pracovní podmínky by došlo ke zničení obou výstupních tranzistorů

Q1 a Q2 důsledkem zvýšení teploty přechodu nad bezpečnou hodnotu.

Obr. 5.44: Výsledek analýzy namáhání součástek výkonového zesilovače pro sluchátka při ne-

standardním provozu

5.1.6 Určení stability operačního zesilovače

V tomto příkladu bude na jednoduchém zapojení operačního zesilovače OPA452 viz obr.

5.45 ukázáno, jak je možné s využitím programu OrCAD PSpice určit stabilitu obvodu.

Tento operační zesilovač je napájen ±40V. Zapojení je převzato ze stránek výrobce
(Texas Instruments) a bylo upraveno pro určení stability.

VOUT

0

VSS
40

VDD

40

0

0

0

R1

100k

R2

100k

VFB

0

R3
40k

0

++

-

OPA452U1

L1

1t

C1
1t

V1
1Vac
0Vdc

VIN

C2
1u

Obr. 5.45: Schéma zapojení pro určení stability operačního zesilovače OPA452
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Obvod se stává nestabilním, když se záporná zpětná vazba změní na kladnou a fáze

signálu má větší fázový posun než 180◦. K určení, zda je obvod stabilní, je třeba rozpojit

zpětnovazební smyčku. K rozpojení zpětnovazební smyčky analyzovaného obvodu slouží

indukčnost L1 a kapacita C1, součástky mají hodnoty 1TH a 1TF, aby došlo k rozpojení

zpětnovazební smyčky. Pro navržený obvod se vytvoří AC simulační profil viz obr. 5.46 a

spustí se simulace.

Obr. 5.46: AC simulační profil pro určení stability operačního zesilovače OPA452

Stabilita u tohoto zapojení je určována pro dva typy zátěže, jedním typem je odporová

zátěž, která je nastavována jako parametr. Druhým typem zátěže je kapacitní zátěž rovněž

jako parametr, která může představovat například připojený kabel různé délky s druhým

rozpojeným koncem. Ve schématu na obr. 5.45 je naznačena pouze kapacitní zátěž v po-

době kondenzátoru C2, při ověřování stability pro odporovou zátěž se kondenzátor C2

zamění za rezistor.

Výsledek simulace pro určení stability zapojení dle obr. 5.45 pro případ odporové

zátěže je na obr. 5.47. Z výsledku je patrné, že pokud operační zesilovač OPA452 pracuje

v konfiguraci, dle obr. 5.45, je pro odporové zátěže o velikosti 10Ω, 100Ω, 1 kΩ, 5 kΩ,

100 kΩ a 1MΩ stabilní v celém sledovaném kmitočtovém pásmu 1HZ až 10MHz.

Ve druhém případě se určuje stabilita operačního zesilovače OPA452 v konfiguraci

dle obr. 5.45 pro případ, kdy je k výstupu připojena kapacitní zátěž různé velikosti.

Výsledek analýzy je na obr. 5.48(a). Na obr. 5.48(b) je detail oblasti, kde křivka zisku

protíná nulovou osu a fázový posun začíná být větší než 180◦. Velikosti kapacitní zátěže
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           Frequency

1.0Hz 100Hz 10KHz 1.0MHz 10MHz
DB(V(VOUT)/V(VIN))

-200

0

200
P(V(VOUT)/V(VIN))

0d

-200d

180d

SEL>>

Obr. 5.47: Výsledek analýzy stability operačního zesilovače OPA452 pro odporovou zátěž

byly 10 pF, 100 pF, 10 nF, 100 nF, 1µF a 10µF. Z výsledků analýzy je možné určit, že

pro hodnoty zátěže 10 pF a 100 pF je obvod ve sledovaném kmitočtovém pásmu stabilní.

Pro hodnotu zátěže 10 pF je fázový posuv na kmitočtu 2,14MHz stále kladný, přesně

37◦. Pro hodnotu zátěže 100 pF je fázový posuv na kmitočtu 2,14MHz také stále kladný,

přesně 35◦. Pro hodnoty zátěže 10 nF, 100 nF, 1µF a 10µF se obvod stal již nestabilním.

Pro zátěž 10 nF nastala nestabilita na kmitočtu 1,1MHz (fázový posun -2,07◦), pro zátěž

100 nF nastala nestabilita na kmitočtu 1,1MHz (fázový posun -1,75◦), pro zátěž 1µF

nastala nestabilita na kmitočtu 121,3 kHz (fázový posun -0,6◦) a pro zátěž 10µF nastala

nestabilita na kmitočtu 38,6 kHz (fázový posun -0,2◦).

Z výsledků je patrné, že nestabilita obvodu při rozpojení zpětnovazební smyčky na-

stává až od určité hodnoty kapacitní zátěže. V tomto případě nastala nestabilita až od

zátěže o velikosti 10 nF.
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           Frequency

1.0Hz 100Hz 10KHz 1.0MHz 10MHz
DB(V(VOUT)/V(VIN))

-200

0

200
P(V(VOUT)/V(VIN))

0d

-200d

180d

SEL>>

(a) Výsledek analýzy stability

           Frequency

10KHz 100KHz 1.0MHz
DB(V(VOUT)/V(VIN))

0

-100

100
P(V(VOUT)/V(VIN))

0d

-20d

20d

SEL>>

(b) Výsledek analýzy stability v detailu

Obr. 5.48: Výsledek analýzy stability operačního zesilovače OPA452 pro kapacitní zátěž
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5.1.7 Vliv délky vedení na frekvenční charakteristiku

Při provozu zařízení je v některých případech velice nezbytné brát ohledy i na délku

propojovacích kabelů. Žádný propojovací kabel není dokonalým vodičem a má parazitní

vlastnosti. Mezi parazitní vlastnosti běžných kabelů patří odpor, indukčnost, kapacita

a svod. Tyto parazitní vlastnosti se u kabelů uvádějí na jeden metr délky, v některých

případech na kilometr délky. Element běžného kabelu si lze představit jako obvod dle obr.

??.

R
L

C
G

Obr. 5.49: Náhradní schéma elementu kabelu

Kabel si je možné tedy představit jako RC článek (dolní propust), a proto vlivem jeho

délky narůstá jeho kapacita i odpor a tím se ladí níže horní mezní kmitočet. V důsledku

toho je možné, například při přenosu hudby pomocí kabelu na větší vzdálenost, přijít

o vyšší kmitočty v signálu. Proti tomu je možné samozřejmě do určité míry bojovat, ale

většinou za cenu ztráty, například velikosti úrovně přenášeného signálu.

Pro demonstraci vlivu délky propojovacího vedení je použit jednoduchý příklad viz

obr. 5.50. Kde je jako vedení použit jen RC člen složený z prvků R8 a C2, které mají

velikost závislou na délce. Velikost kapacity vedení je 125 pF/m a velikost odporu vedení

je 7,5Ω/m. Hodnoty pro RC jsou typickými hodnotami, nejedná se o hodnoty konkrétního

kabelu. Rezistor R3 představuje impedanci zdroje. Kondenzátor C1 a rezistor R4 před-

stavují CR článek (horní propust) naladěný na kmitočet 20Hz. Rezistor R7 představuje

zátěž na konci vedení a rezistor R9 je pomocný rezistor, kterým se v případě potřeby

rozšiřuje šířka pásma.

Konfigurace obvodu dle obr. 5.50 představuje v podstatě pásmovou propust, která

se ladí v závislosti na délce propojovacího vedení a velikosti připojených impedancí. Na

obr. 5.51 je výsledek AC analýzy při rozmítání délky vedení od 5 do 95 metrů, přičemž

nejkratší délka vedení je vyjádřena zeleným průběhem. Rezistory R3 a R7 mají nastavenou

velikost 600Ω, rezistor R9 není připojený. Z výsledků je jasně patrný vliv délky vedení na

tvar frekvenční charakteristiky. Dochází ke snižování výstupní úrovně signálu v důsledku

zvyšujícího se útlumu a zužuje se kmitočtové pásmo na výstupu řetězce vlivem změny

mezního kmitočtu dolní propusti představované vedením různé délky.

Pro stejnou konfiguraci prvků obvodu bude provedena analýza ještě jednou, nyní se

však pro zlepšení šířky přenášených kmitočtů již uplatní rezistor R9, jehož velikost bude

rozmítána od 10Ω do 600Ω. Při simulaci bude použita ještě hodnota rezistoru R9 10MΩ,

aby byl v grafu vykreslen i průběh pro situaci bez rezistoru R9. Simulace je provedena
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Obr. 5.50: Schéma zapojení pro demonstraci vlivu délky vedení na deformaci frekvenční cha-

rakteristiky

pro délku vedení 95 metrů. Z výsledků simulace je patrné, že se podařilo rozšířit pásmo

přenášených kmitočtů, ale za cenu snížení úrovně přenášeného signálu. V reálné situaci

to bude znamenat, že přenášený signál bude obsahovat všechny slyšitelné složky, ale sníží

se například hlasitost.

           Frequency

100Hz 1.0KHz 10KHz 100KHz20Hz
db(V(out_end))

-10

0

10

-15

Obr. 5.51: Výsledek AC analýzy simulovaného obvodu pro různé délky vedení
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           Frequency

100Hz 1.0KHz 10KHz 100KHz20Hz
db(V(out_end))

-50

-25

0

10

Obr. 5.52: Výsledek AC analýzy simulovaného obvodu s úpravou pro rozšíření pásma přenáše-

ných kmitočtů
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5.1.8 Činitel potlačení souhlasného rušení – CMRR

CMRR je logaritmický poměr diferenciálního zesílení k zesílení pro souhlasné signály a

je velice kmitočtově závislý. Souhlasné rušení vzniká, pokud je k jednomu z diferenci-

álních vstupů zařízení, například operačního zesilovače, připojena větší impedance, než

k druhému. To může nastat například při propojení zdroje signálu a diferenciálního zesilo-

vače kabelem určité délky. V takovém případě dojde k rozvážení a potlačení souhlasného

rušení klesne. Ukázkový příklad zapojení je na obr. 5.53(a) a (b). Na obr. 5.53(a) je

impedanční můstek, který je vyvážený pokud jsou hodnoty všech impedancí stejné, po-

kud dojde k rozvážení můstku, objeví se v příčné větvi souhlasný rušivý signál. Aktivní

řešení s operačními zesilovači mohou mít velikost RCM ≈ 5 ∼ 50 kΩ. Pro případ, kdy
RCM = 5 kΩ a došlo by na straně vysílače (Driver) k rozvážení jedné větve o 1Ω dojde

ke zhoršení CMRR o 50 dB. Pro zařízení, která mají obrovské hodnoty RCM ≈ 50MΩ
je rozvážení o 1Ω prakticky neměřitelné. Taková zapojení obsahují vstupní transformá-

tor. Ovšem i řešení s operačními zesilovači je možné pomocí tzv. bootstrappingu upravit.

Bootstrapping znamená zavedení kladné zpětné vazby, která zvýší vstupní impedanci za-

řízení a tedy dojde ke zvýšení RCM . Zapojení přístrojového zesilovače se zvýšeným RCM

pomocí bootstrappingu je na obr. 5.54.

(a) Impedanční můstek pro sou-

hlasný signál

(b) Model spoje

Obr. 5.53: Impedanční model signálového spoje zahrnující impedanční můstek

V této části textu bude ukázáno na konkrétním zapojení jak je možné pomocí pro-

gramu OrCAD PSpice určit CMRR. Měření CMRR bude vycházet z normy (ČSN) EN

60268-3. Schéma zapojení pro měření CMRR z této normy se na obr. 5.55. Měření pro-

bíhá tak, že se provede první měření bez rozvažovacího 10Ω rezistoru a změří se hodnoty

napětí U1 a U2, poté se postupně do obou větví připojí rozvažovací 10Ω rezistor a změří se

vždy hodnoty U ,
1 a U

,
2. Změřené hodnoty se dosadí do rov. 5.28. A bere se horší výsledek

z obou měření při připojené rozvažovací impedanci.
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Obr. 5.54: Schéma zapojení přístrojového zesilovače s uměle zvýšenou vstupní impedancí po-

mocí tzv. bootstrappingu

Obr. 5.55: Schéma zapojení pro měření CMRR dle normy (ČSN) EN 60268-3 |Převzato z [23]|

(5.28)CMRR = 20log

(
U ,
1

U ,
2

)
+ 20log

(
U2
U1

)
Kde:

U1 . . . napětí mezi diferenciálními vstupy zesilovače bez rozvažovací impedance

U2 . . . napětí na výstupu diferenciálního zesilovače bez rozvažovací impedance

U ,
1 . . . napětí mezi diferenciálními vstupy zesilovače s rozvažovací impedancí

U ,
2 . . . napětí na výstupu diferenciálního zesilovače s rozvažovací impedance

Pro určení CMRR v programu OrCAD PSpice je zvoleno jednoduché zapojení viz

obr. 5.56. Schéma obsahuje dva téměř totožné obvody, toto řešení bylo zvoleno z toho

důvodu, aby nebylo nutné řešit přepínání rozvažovací impedance. Měření CMRR bude

provedeno celkem třikrát. První měření bude provedeno bez rozvažovací impedance R16

a parazitních kapacit C8 a C9, které představují parazitní kapacitu vodičů, například cest

na desce plošných spojů. Další měření bude provedeno s rozvažovací impedancí R16 ale

bez parazitních kapacit C8 a C9 a poslední měření bude provedeno s dle konfigurace na

obr. 5.56.
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Obr. 5.56: Schéma zapojení pro měření CMRR v programu OrCAD PSpice

Simulace bude provedena pomocí statistické analýzy výtěžnosti výroby, ale tentokrát

nikoliv z rozšířených analýz, ale pouze s využitím běžných analýz. Nastavení simulač-

ního profilu pro analýzu výtěžnosti výroby je na obr. 5.57. Je nutné nastavit výstupní

uzel (Output variable) rozvažovaného obvodu, počet běhů analýzy (Number of runs) a

typ distribuční funkce (Use distribution) může zůstat rovnoměrné (UNIFORM ). Pro tuto

analýzu je nutné všem prvkům obvodu, které budou uvažovány při analýze přiřadit veli-

kost tolerance. Pro rezistory R17, R18, R19 a R20 je tolerance 1% a pro kondenzátory

C8 a C9 je tolerance 50%.

Obr. 5.57: Simulační profil s nastavení analýzy výtěžnosti výroby

Výsledky analýzy výtěžnosti výroby jsou na obr. 5.58, 5.59 a 5.60. Pro vytvoření his-

togramu rozložení minimální hodnoty CMRR je použita funkce min(20*LOG10(V(in_cm)

/V(out_cm))+20*LOG10(V(out_diff)/V(V4:+,V4:-))), která hledá minimální hodnotu

CMRR v závislosti na kmitočtu a aktuální kombinaci hodnot obvodových prvků určených

povolenými tolerancemi
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(a) Histogram rozložení minimální hodnoty CMRR v závislosti na toleranci prvků
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(b) Průběh CMRR v závislosti na kmitočtu

Obr. 5.58: Výsledek analýzy výtěžnosti výroby v závislosti na tolerancích hodnot rezistorů

R17, R18, R19 a R20
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(a) Histogram rozložení minimální hodnoty CMRR v závislosti na toleranci prvků
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(b) Průběh CMRR v závislosti na kmitočtu

Obr. 5.59: Výsledek analýzy výtěžnosti výroby v závislosti na tolerancích hodnot rezistorů

R17, R18, R19 a R20 s rozvažovací impedancí R16
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(a) Histogram rozložení minimální hodnoty CMRR v závislosti na toleranci prvků
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(b) Průběh CMRR v závislosti na kmitočtu

Obr. 5.60: Výsledek analýzy výtěžnosti výroby v závislosti na tolerancích hodnot rezistorů

R17, R18, R19, R20, C8 a C9 s rozvažovací impedancí R16
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6

Závěr

Cílem této práce bylo seznámení se s možnostmi analýz elektronických obvodů v prostředí

PSpice se zaměřením na rozšířené typy analýz. Rozšířenými typy analýz se rozumí analýzy

obsažené v modulu rozšířených analýz do programu OrCAD PSpice. Mezi tyto analýzy

patří citlivostní analýza, optimalizace chování obvodu, analýza namáhání součástek, sta-

tistická analýza výtěžnosti výroby a nástroj umožňující rozmítání obvodových veličin.

Kromě modulu rozšířených analýz bylo cílem propojení programu OrCAD PSpice a pro-

gramem Matlab/Simulink pomocí modulu SLPS, který umožňuje využití matematických

modelů součástek z PSpice v programu Matlab/Simulink.

Jedním z cílů bylo ověření možností jednotlivých typů analýz na příkladech vhodných

elektronických obvodů z aplikační oblasti, např. nf a nf měřicí techniky.

Jako posledním cílem bylo vytvoření demonstračních úloh zaměřených do oblasti po-

kročilé analýzy nf zařízení využívajících možností rozšířených analýz.

První část, obsahující seznámení se s modulem rozšířených analýz v programu OrCAD

PSpice, je možné využít jako příručku k používání modulu rozšířených analýz. Každý typ

popisované rozšířené analýzy je vždy vysvětlen a demonstrován na jednoduchém příkladu.

V práci je nad rámec zadání ve stručnosti popsána práce s modely součástek. Vytvoření

jednoduchého modelu součástky, import nové součástky a editace stávající součástky.

Především část popisující import modelu součástky by měla být velice užitečná, neboť

výrobci součástek často uvolňují na svých webových stránkách modely součástek, která

v knihovnách programu OrCAD PSpice chybí. Nicméně pro práci s modely součástek,

především jejich editaci a vytváření vlastních modelů, je nutná hlubší znalost jazyka

SPICE, ve kterém se modely součástek vytvářejí.

Při popisu spolupráce programů OrCAD PSpice a Matlab/Simulink se vyskytla chyba,

která znemožnila využití této spolupráce na vlastním zapojení. V práci je tedy pouze

seznámení se s modulem SLPS, ukázka jeho nastavení a práce na zapojení, které je v ma-

nuálu, ale není prakticky použit.

Poslední kapitola je věnována praktickému využití modulu rozšířených analýz na vhod-

ných elektronických obvodech. V kapitole nejsou však využity pouze analýzy z modulu

rozšířených analýz, ale jsou využity i další analýzy. Byla použita například analýza pro
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určení harmonického zkreslení. Obvody simulované v této kapitole, stejně jako text k nim

je možné využít jako demonstrační úlohy zaměřující se do oblasti pokročilé syntézy a

analýzy.

Modul rozšířených analýz je velice užitečný nástroj, který v mnoha ohledech rozšiřuje

použití programu OrCAD PSpice. Všechny rozšiřující typy analýz při správném použití

mohou velice usnadnit návrh a simulaci navrhovaného obvodu, stejně jako ušetřit poz-

dější náklady spojené například s výměnou součástek nevyhovujících hodnot či dokonce

součástek zničených z důvodu vysokého namáhání.

V práci chybí porovnání výsledků simulací z PSpice s výsledky získanými praktic-

kým měřením zrealizovaných elektronických obvodů. Praktické využití modulu SLPS

chybí také, neboť se nepodařilo mezi sebou propojit oba programy OrCAD PSpice a

Matlab/Simulink.

Na výsledky získané při zpracovávání této práce by se dalo navázat využitím mo-

dulu rozšířených analýz i do jiné aplikační oblasti, např. vf. Dala by se rozšířit kapitola

obsahující praktické využití modulu rozšířených analýz o další příklady. A vzhledem k ne-

funkčnosti modulu SLPS by i tento modul měl být dále zkoumán, neboť nabízí opravdu

rozsáhlé možnosti využití.
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Příloha A

Rozšířené analýzy

A.1 Parametry součástek potřebné k rozšířeným ana-

lýzám

Tabulka proměnných parametrů obr. A.1 slouží k nastavení globálních parametrů. Zna-

mená to, že není třeba nastavovat parametr u každého prvku obvodu, ale nastaví se

globálně pro všechny prvky. Pokud by byl požadavek na unikátní nastavení parametrů

u některého z prvků, je možné parametry nastavit přímo u konkrétního prvku viz obr.

A.2.

Význam globálních parametrů tabulky VARIABLES viz obr. A.1

Toleranční parametry

• RTOL tolerance jmenovité hodnoty rezistoru [%] (POSTOL=NEGTOL)

• CTOL tolerance jmenovité hodnoty kondenzátoru [%] (POSTOL=NEGTOL)

• LTOL tolerance jmenovité hodnoty cívky [%] (POSTOL=NEGTOL)

• VTOL tolerance jmenovité hodnoty napěťového zdroje [%] (POSTOL=NEGTOL)

• ITOL tolerance jmenovité hodnoty proudového zdroje [%] (POSTOL=NEGTOL)

Smoke parametry

• RMAX maximální výkonová ztráta rezistoru [W]

• RSMAS závislost výkonové ztráty rezistoru na teplotě [W/ ◦C]

• RTMAX maximální teplota, jakou rezistor vydrží [ ◦C]

• RVMAX jmenovité napětí rezistoru [V]

• CMAX jmenovité napětí kondenzátoru [V]

• CBMAX hodnota tepelného průrazu [ ◦C]
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• CSMAX strmost poklesu napětí v závislosti na teplotě [V/ ◦C]

• CTMAX maximální teplota [ ◦C]

• CIMAX maximální zvlnění proudu kondenzátoru [A]

• LMAX jmenovitý proud cívky [A]

• DSMAX dielektrická pevnost [V]

• IMAX maximální proud, jaký napěťový zdroj vydrží [A]

• VMAX maximální napětí, jaké proudový zdroj vydrží [V]

• ESR ekvivalentní sériový odpor kondenzátoru [Ω]

• CPMAX maximální výkon na kondenzátoru [W]

• LPMAX maximální výkon na indukčnosti [W]

• RTH tepelný odpor [K]

Advanced Analysis Properties
Tolerances:
RTOL = 0
CTOL = 0
LTOL = 0
VTOL = 0
ITOL = 0

Smoke Limits:
RMAX = 0.25
RSMAX = 0.0125
RTMAX = 200

CMAX = 50
CBMAX = 125
CSMAX = 0.005
CTMAX = 125
CIMAX = 1
LMAX = 5
DSMAX = 300
IMAX = 1
VMAX = 12

RVMAX = 100

ESR = 0.001
CPMAX = 0.1
CVN = 10
LPMAX = 0.25
DC = 0.1
RTH = 1

Obr. A.1: Tabulka proměnných parametrů VARIABLES
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Význam parametrů nejčastěji používaných prvků z obr. A.2

Rezistor

• DIST typ distribuční funkce

• MAX TEMP maximální teplota [ ◦C]

• NEGTOL hodnota záporné tolerance [%]

• POSTOL hodnota kladné tolerance [%]

• POWER maximální výkon [W]

• SLOPE závislost výkonové ztráty rezistoru na teplotě [W/ ◦C]

• TC1 spojené s neznámým parametrem

• TC2 spojené s neznámým parametrem

• TOL ON OFF použití tolerance

• VOLTAGE jmenovité napětí [V]

Kondenzátor

• CURRENT maximální zvlnění proudu [A]

• DIST typ distribuční funkce

• IC počáteční podmínky [V]

• KNEE hodnota tepelného průrazu [ ◦C]

• MAX TEMP maximální teplota [ ◦C]

• NEGTOL hodnota záporné tolerance [%]

• POSTOL hodnota kladné tolerance [%]

• SLOPE strmost poklesu napětí v závislosti na teplotě [V/ ◦C]

• TOL ON OFF použití tolerance

• VOLTAGE jmenovité napětí [V]

Cívka

• CURRENT jmenovitý proud [A]

• DIELECTRIC dielektrická pevnost [V]

• DIST typ distribuční funkce
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• IC počáteční podmínky [A]

• NEGTOL hodnota záporné tolerance [%]

• POSTOL hodnota kladné tolerance [%]

• TOL ON OFF použití tolerance

Bipolární tranzistor

• IC VBE maximální proud kolektoru při napětí báze-emitor [A]

• IC VCE maximální proud kolektoru při napětí kolektor-emitor [A]

• RCA tepelný odpor závislý na okolní teplotě [ ◦C/W]

• TEMP maximální teplota [ ◦C]

• TOL ON OFF použití tolerance

Operační zesilovač

• TOL ON OFF použití tolerance

Dioda

• IC počáteční podmínky [V]

• RCA tepelný odpor závislý na okolní teplotě [ ◦C/W]

• TOL ON OFF použití tolerance

151



Rozšířené možnosti analýz v prostředí PSpice Lukáš Mraček 2012

(a) Přehled parametrů rezistoru (b) Přehled parametrů kondenzátoru

(c) Přehled parametrů cívky (d) Přehled parametrů tranzistoru

(e) Přehled parametrů operačního zesilovače (f) Přehled parametrů diody

Obr. A.2: Přehled parametrů nejčastěji používaných prvků
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A.2 Význam měřených parametrů při analýze namá-

hání součástek

Význam všech parametrů, které jsou měřeny při analýze namáhání součástek. Význam

parametrů byl převzat z [18].

Obr. A.3: Význam parametrů pasivních součástek |Převzato z [18]|
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Obr. A.4: Význam parametrů polovodičových součástek (1. část) |Převzato z [18]|
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Obr. A.5: Význam parametrů polovodičových součástek (2. část) |Převzato z [18]|

155



Rozšířené možnosti analýz v prostředí PSpice Lukáš Mraček 2012

Obr. A.6: Význam parametrů polovodičových součástek (3. část) |Převzato z [18]|
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Obr. A.7: Význam parametrů operačních zesilovačů |Převzato z [18]|
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